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New Features in Version 4.00 
Samplitude supports now the new ARC44 sound card - a 4 channel IO high quality analog 
sound board.
Samplitude with the ARC44 lets you record up to 4 signals at the same time and playback 
can be routed to all 4 outputs using modern mixing concepts.
Also all other multi channel sound cards are supported as long as they install per stereo IO 
channel a standard wave driver. This is the case with ARC88 (8 channel analog IO + SPDIF), 
DARC88 (8 channel ADAT digital + SPDIF), DAL V8, Antex Studiocard, Frontier Wavecenter...

Features of the actual Studio version V4.0:
- Native 32 bit code for use under Windows 95 and Windows NT
- Support of ARC44 4 channel IO card incl. AUX sends
- Support of multiple standard Windows sound cards for playback and recording 
(unlimited
device number), device selection in the track info dialog, switching between single and 
multi-
card mode in the project properties menu
- Multiple Input Record function without the need of the record dialog - perfect for the 
new
Digital ARC 88 ADAT interface card
- Unlimited track number in VIPs, New VIP dialog lets you select any number of Mono or
Stereo tracks
- Fast PCs (Pentium/PentiumPro 200, SCSI AVI drives, Windows NT) play 16 Stereo tracks
or more!
- Functions for Cut, Copy and Paste complete virtual Tracks in the Edit menu
- Cut/Copy/Paste/Delete/Clear/Overwrite functions for VIPs are now track sensitive and allow
auto crossfade - very comfortable for editing large projects!
- On screen mixer with volume, panorama, 3 band full parametric EQ, dynamics
compressor/distortion, echo/delay on each channel - all effects are calculated in realtime!
- Mixer scrolls through projects with more than 8 tracks - so realtime effects can be used 
on
all virtual tracks
- Mix Automation for volume and panorama faders - realtime recording and playback
- Track Bouncing feature for converting any number of tracks with all realtime mixer 
effects into wave files, thats why no track limitations also on slower machines.
- Master section of the mixer with stereo wizard, parametric EQ, dynamics and phase
correlation display (typical Pentium 133 performs 16 EQ bands and 8 compression bands)
- Completely new developed room simulation for creating natural sounding reverb based 
on
natural impuls responses
- Draw Filter / Analyzer: High quality FFT filter / analyzer with freehand filter drawing tool 
and
realtime preview. 
- Noise Reduction tool for eliminating noise / hum etc...- with realtime preview
- Declipping function for repairing overmodulated recordings
- New smooth Timestretching algorithm, useful for large scaling factors
- Audio CD data copy function for most SCSI CD ROM drives under Windows 95
- MPEG audio file import and export (export limited to 1:10 compression, upgrade to iMedia
audio full version available)
- Smart AVI integration, display of video thumbnails in the VIP timeline, import and export
of
audio data from/to AVI files, perfect for audio to video production for all AVI formats
- Audio CD TOC generation, ready for burning CDs using Point CDAudio or CDAudio+



- Mono objects can be used in Stereo VIPs
- Pan Curve in Stereo VIPs
- Record Dialog with LED peakmeters for exact level display
- Cut test features on new toolbar
- Support of Microsoft Intellimouse wheel for zooming and scrolling
- Background bitmap and nice mixer knobs when using 16 bit color display (>32000 colors)
- New manual with large tutorial chapter
- ...

New Features in Version 2.52
The version V2.52 contains the following new features:

New Studio Dynamics: The dialog Compressor/Expander/Limiter/Gate was completely 
rewritten, it uses now studio like compression algorithms and a graphics display for all 
parameters.

New Mouse Handling: Samplitude is now more friendly regarding mouse movement. So 
you can drag a scroll bar or mark a range also outside of the window borders.    

Master Synchronization without Chase Lock: Some sound cards (Turtle Beach, DAL 
CardD+...) have problems to run with chase lock sync because their drivers deliver a wrong 
sample position to Samplitude. These cards can be used now without chase lock also in 
master sync mode!
Please read chapter Problems and Solutions - FX factor if you get delays when synchronizing 
large samples without chase lock!

RWP and Sync with DAL CardD+ : There is a special bug fix for the DAL CardD+, so it is 
now possible to run simultaneous recording and playback under master and slave sync 
mode.

New Features in Version 2.50
The new version 2.50 contains more than 40 new features, bug fixes, better sync functions, 
scrubbing, varipitch, freehand waveform drawing and much more!

More stabile master sync
Samplitude supports sync output (MIDI Clock and MIDI Time Code).
The sync output is now directly coupled to the Wave output of the sound card, so there 
should be no
delays between Wave playback and the synchronized device.
The new sync is especially designed for using with a MIDI sequencer, which runs in 
multitasking on
the same machine as Samplitude, e.g. Cakewalk or Q-Trax.
Use a virtual MIDI driver like Hubis MIDI Loopback from the Samplitude CD-ROM for the 
internal link between Samplitude and the MIDI sequencer!
When ever possible use MTC sync with e.g. 25 frames per second, so you need not to care 
about the
tempo of the sequencer!
When using the master sync features, please set the FX factor to 1.0.
For best performance of the audio/MIDI sync switch off the virtual memory!

Slave Sync with chase lock option



Samplitude supports now real chase lock sync (MIDI Clock and MIDI Time Code/SMPTE).
This means, that the internal sample rate of Samplitudes playback or recording is variied in 
small
steps, so that Samplitude can follow little timing changes of the sync master.
This is very useful when using sync between a tape or video recorder (master) and 
Samplitude (slave),
because most tape machines always produce small pitch changes, which results in delays 
between
the tape and Samplitude, when not using chase lock sync. If the timing changes are too big,
Samplitude produces heavy pitch changes, which may be reduced by entering smaller 
values for the
Sync Velocity in the sync dialog. Try values of 200 or more, when you need fast pitch 
changes in sync
mode! In the lower right status bar you can read the actual/maximal pitch change in cents 
( 1 cent =
1/100 halftone).
Please know, that the chase lock sync performes a real time resampling, which needs a 
certain
processing power, so be carefully on slow machines!
When receiving SMPTE/MTC you can start and stop playback with the space key - Samplitude
will
always be in sync!

Scrubbing
While pressing the Insert key and moving the mouse you can perform scrubbing. Samplitude
starts
playback at a very low speed, the mouse position relative to the start cursor controls the 
speed.
There are two scrubbing modes (in playback parameter window - key p):
Relative: The distance between the playback cursor and the mouse sets the playback 
speed.
Absolute: The position of the mouse in the window sets the playback speed - at the left 
border
playback speed is 200% backward, at the right border speed is 200 % forward, in the middle
of the
window the speed is 0.
There is a real time resampling performed for changing the playback rate without changing 
the sample
rate of the sound card. For best performance use small play buffer sizes and a fast processor
(Pentium recommended) !

Varipitch
Samplitude supports smooth changes of the pitch while playback, even in multi track 
projects (vertical
slider in playback parameter window - key p).
Activate the Varispeed mode with the "active" button, then you can change the playback 
speed in
various kinds:
Vertical slider - Changes the playback speed from -200% to +200%
Pitch Factor - Lets you specify a certain pitch factor manually
Halftones    - Lets you specify a value of halftones. The playback will be transposed the 
number of
halftones.
Internal Rate - Here you can set a sample rate for the varipitch calculation. If you want to 
play a wave



file with a sample rate of 48 KHz but your sound card can only play rates up to 44.1 KHz 
simply set the
internal rate to 48 and activate varispeed. You listen the same result as playing with real 48 
KHz!
This function is also very useful for digital playback to DAT with 44.1 KHz samples and and 
vice versa!
BPM - Here you can type in the original bpm value of your material and a destination bpm 
value, which
is reached using the varipitch.
Important: Varipitch works also while recording! So you can set the pitch to -2 halftones, 
sing a song
into the computer, then switch off the varipitch - your track is transposed two halftones 
higher!
There is a real time resampling performed for changing the playback rate without changing 
the sample
rate of the sound card. For best performance use small play buffer sizes and a fast processor
(Pentium recommended) !

Freehand Drawing
In virtual projects you can open a pop-up menu with the right mouse button, when clicking
beside the
volume sliders. Select "Draw Volume" to test the draw function. Select the "V" button before 
to activate
the volume rubberbands, then draw your own fade curve!
In physical projects you can also activate freehand drawing functions with the menu 
"Setup >
HDP/RAP mouse mode". Select here "Draw Wave" for freehand editing your samples. Select 
a zoom
level of 1:1 or larger for exact manipulation of your material. This is very powerful to correct 
small
distortions, pops etc...
If you select "Draw Volume" you can draw the volume of your material, this is useful for 
creating
special envelopes etc...
The bottom edge means volume factor 0 (silence), the upper edge means factor 2.

Transport Control Window
Samplitude now contains an easy to use transport control window, which lets you activate all
the play,
stop, record and position commands!
Open the transport window with the menu "Window > Transport Control"

Time Display Window
There also exists a new time display window, which informs you about the actual position 
while
playback or editing functions!
You can zoom the time display to any size and position it where you want- so you can read it 
even
from a large distance.
Open the time display window with the menu "Window > Time Display"

Playback Control in Windows menu
The playback parameter window (key p) is now located in the Windows menu.

Vertical Zoom function in virtual projects



With the vertical cursor keys you can zoom the waveform display in virtual projects 
vertically. This
makes it easy to arrange audio data with a low volume visually.

Soft Scroll Mode
The Play Parameter window (key p)    contains a modified auto scroll mode (soft), which lets 
the
playback cursor stay in the centre of the screen and the waveform display scrolls from right 
to the left.
Using a fast graphics board and small buffer sizes this mode produces a very smooth 
display!
When using the grid you get a slower screen refresh.
Choose the page mode or switch autoscroll off if the refresh is too slow and produces errors 
while
playback.

8 Setup buttons in VIPs
The 8 lower left buttons in a VIP store 4 setups (S1...S4 incl. zoom level, position and display 
mode)
and 4 zoom levels (Z1...Z4). So you can quickly switch f.e. between a full size display, a 10 
seconds
zoom range and a sample exact zooom level for perfect editing!

4 default Zoom Levels
In the bottom toolbar you find 4 buttons which set the zoom level to 0.1, 1, 10 and 60 
seconds.�

Zoom In/Out by dragging the scroller
There is a new way of zooming in and out: Simply drag the left or right border of the 
scrollbar button
with the mouse. If the "change mouse" mode is activated in Shift-Tab dialog, the mouse 
pointer
becomes an left-right-arrow, if you are above the position for the zoom function!

LED level meters
Each track in a VIP has its own exact LED level meter. Switch this function on or off with the 
menu
"Setup > VIP Display Preferences" or with the Shift + Tab key.
The level meters work both while recording and playback and store the maximum level 
(peak hold
function).
Important: Because drawing of    all the LEDs in a multi track VIP needs some processing 
time, switch
them off, when your machine is too slow!

New volume settings in VIPs
New virtual projects now get the following bit shifts (1 bit less than former versions):
1,2,and 4 tracks mono and 1 and 2 tracks stereo: 0 dB
8 tracks mono and 4 tracks stereo: -6 dB (1 Bit)
16 tracks Mono and 8 tracks stereo: -12 dB (2 Bits)
The default volume silder position is -6 dB for each track.
Please know, that this setting has no safe volume reserve, if you increase the volume level 
with the sliders you may produce clipping, if the material has maximum level on all tracks.
You can change the volume settings in the dialog Project > Project Information or with the i 
key!



Remove DC offset
This function in menu "Effects" removes a DC offset in the marked range of a physical 
project (RAP or
HDP). Some sound cards produce such a DC offset while recording, so it is useful, if you can 
remove
it!

Parametric EQ with +/- 20 dB per band
The parametric EQ can now perform an amplification of +/- 20 dB per band. This makes it 
more
powerful for editing the sound of your material!

Move all objects and volume points behind actual position (key k)
While pressing the m-key you can move all objects and volume rubber points behind the 
actual cursor
position with the right mousebutton. This makes it easy to create free space in a VIP or re-
arrange
large projects without the need of grouping objects!

Move objects vertically with Shift + right mouse button
Using the shift key while moving objects with the right mousebutton you can only move the 
objects vertically. This makes it easy to move objects to another track without to change the 
timing position.

Change Mouse Cursor
This option in menu "Setup > VIP Display Preferences" or Shift + Tab key lets the mouse 
cursor
change to arrows, if you use the object mode in VIPs. It changes to a pencil if you activate 
the draw
mode for volume curves.

New Object Mode
This option in menu "Setup > VIP Display Preferences" or Shift + Tab key changes the way 
Samplitude
handles objects in a VIP: In the new mode the first right click only activates objects without 
the
"danger" of moving them. The next click can be used for move or drag objects or their 
handles!

Copy As function
The Copy As function in menu "Cut" lets you copy a marked range in a physical project into a
new file,
without the need of renaming the clipboard.

Save Complete VIP
This function in menu "Project" allows saving a VIP with all needed projects (HDPs, RAPs) into
a
specified directory. This makes it easy to copy all files of a VIP to a backup disk etc...

Save Session saves all projects
The Save Session command in menu "Project" now also saves all included projects. So you 
get after
recalling the session the actual versions of all projects!



Move Objects
The move objects function lets you quickly move an object in a VIP to a specified position.

Object Editor
The object editor lets you select the curve types of the object fades (fade in and fade out). 
So you can
give the fades any curve type from logarithmic to exponential.
Activate the object editor with the menu "Object > Object Editor" or with a right + left 
mouse click on
the object!

Cursors on Silence
This function automatically sets cursors on silent positions in the waveform. You can specify 
the
minimal length of the pause and a threshold level.

Moving Range Borders with the / * - + keys
The / * - + keys of the numeric block control the borders of a marked range. With these keys 
it is very
easy to move the range borders in small steps to all directions. The steps of the movement 
depend on
the zoom depth!

Cursors on Range Borders
This function sets two cursors called S and E on the borders of a marked range.

Zero Crossing 0 -> Range <- 0
This function in menu "Range" sets the borders of a marked range to the next zero crossings
inside
the range (useful for loop finding). Shortcut: key 5 in numeric block

Get Range Length
By selecting this option with Ctrl + F1...10 you can set the length of one of the defined 
ranges as the
current range length.

External Program 1 and 2
This menu item in menu "Special" runs an external program with the actual project as 
parameter. This
makes it easy to export a Samplitude project to another audio software for special edits.
Use the ?-button to select the external program you want to run.
After editing and saving the file in the external program you can load it back to Samplitude 
using the
recent file list in menu "Project".
This function works only with HDPs in Mono or Stereo Wave format!

Close all audio devices
This menu item in menu Special closes all audio devices to give other audio software a 
chance to use them for playback and recording in multitasking with Samplitude.

Shortcut R for Recording
You can use the r key to open the record window. In the record window the r key starts 
recording, the s key finishes the recording, the o key Closes the record window. So you can 
record complete tracks without the need of button clicking!
The shortcut for snap on/off is now Control + r.



Recording VIPs with default settings
When recording without a VIP, Samplitude creates a new VIP after finishing the recording. 
This VIP
gets its settings from the last    call of the "New VIP" dialog (Units of measurement, Fix 
vertically...).

MSF 75 frame units
You can select the CD type 75 frame per second format as units of measurement in menu 
"Setup >
Units of measurement".

Select 1 View with Shift b
Simply by pressing Shift + b you can switch to 1 view, what is useful when suing the b key to
edit loops
etc. in the 3 views mode!

Wave Import with Ctrl-I
The Wave Import function has the new shortcut Control + I.

Close all Windows with key h
The key h is now the shortcut for the menu Window > Close all Windows.



Menu File

The project menu contains wide-range functions for generating, managing, loading and saving projects.

New Multitrack Project A new virtual project is opened.
Open Project A new project is loaded, which was created by 

Samplitude.
Load CD Track(s) Loads CD ROM tracks via the SCSI bus.
Save Project The actual project is saved.
Save Project as... The actual project is saved with a new name.
Save Complete VIP to... The actual VIP with all needed files is saved to a

new directory.
Save in Format Save project in another format.
Rename Project The actual project gets a new name.
Delete Physical Project A HD project is deleted from harddisk.
Import Sample A Wave, AIFF, Dump or MPEG file is opened.
Export Sample A Samplitude project is saved as a Wave, MPEG 

or Dump file.
Record... The Record window is opened.
Multi Card Record Starts multiple device recording.
Multi Monitor Activates multiple device monitoring.
Load Session Loads a complete Samplitude session.
Save Session Save a complete Samplitude session.

Properties > Sub menu for project properties
Project Information Shows information about the actual project.
MIDI/Video-Link... Synchronizes .MID or .AVI files to a Samplitude 

project.
Multiple Sound Cards Switches the multi card playback mode on or 

off.
Text Comments Edit text comments for the actual project.

Preferences > Select global preferences
System Global parameters for buffers and paths.
Synchronization Options for external synchronization.
Multiple Sound Cards Select several sound cards for playback.
Undo-Definitions... Select Undo options
Video Height Set Height for Video track display 
Font Selection Select font for grid and objects.
Color Settings Select colors for the Samplitude display.
VIP_Mouse Mode Switches between different mouse modi in VIPs.
HDP / RAP_Mouse Mode Switches between different mouse modi in HDPS

and RAPs.
Enable Profiling Activates the DSP power display in the lower left

corner.
Exit Exits Samplitude.



 New Multitrack Project (Menu File)

A new virtual project is opened, you can choose the track and select a name for the new VIP.
The number of tracks depends on the version of Samplitude:
ARC 44 Version: 8 Mono or 4 Stereo
Samplitude Studio V4.0: unlimited track number
New virtual projects get the following bit shifts to avoid clipping (1 bit less than former 
versions):
1,2,and 4 tracks mono and 1 and 2 tracks stereo: 0 dB
8 tracks mono and 4 tracks stereo: -6 dB (1 Bit)
16 tracks Mono and 8 tracks stereo: -12 dB (2 Bits)
The default volume silder position is -6 dB for each track.
Please know, that this setting has no safe volume reserve, if you increase the volume level 
with the sliders you may produce clipping, if the material has maximum level on all tracks.
You can change the volume settings in the dialog Project > Project Information or with the i 
key!

Mono: This button mixes the output of the VIP to Mono in case of Mono tracks. The left and the right 
output of the sound card carry the same signal.

Units of Measurement: Here you can select default units of measurement for the new VIP.

Settings Grid:
Activates the grid view by default.

Fix vertically:
Disables the feature of vertical range marking.

Snap to objects: 
Activates the object snapping for the new VIP

Lock record objects: 
Locks all recorded objects against moving. 
This is very useful in multi track projects!

Shortcuts:
Toolbar:

Keys: e



Open Project (Menu File)

Use the Open Project... command to open already existing projects. Samplitude will let you choose 
between RAM, HD and Virtual projects. After specifying which type of project you want to open, you will 
have a chance to load the wanted file. If a project is successfully loaded, the project window will appear 
on the screen.

Shortcuts:
Keys: l for RAM projects
Keys: SHIFT+l for HD projects
Keys: o for virtual projects
Keys: w for wave files



Load CD Track(s)... (Menu File)

This function allows you to import audio data from most SCSI CD ROM drives (and CD-Writers) on the 
digital domain, without any loss in quality. This works under Windows 95, under Windows NT you need
an installed ASPI manager, e.g. from Adaptec.

To do this please follow these steps:
1. Open the drive list dialog and select your desired CD ROM drive, if you have more than 1 drive
2. Click the Track List Button
3. In the CD track list dialog select one or more tracks in the list box
4. Click on Copy Selected Track(s)..
5. Select a filename for the new wave file and click O.K.
6. Now the audio data is copied from the CD ROM to your hard disk as a new wave file.
7. Close the tracklist dialog and the drive list dialog, in your VIP appear one or more new objects, 

containing the audio data from your CD.

Features of the Drive List Dialog:
Track List (Copy, Play)...    - This button opens the track list dialog for selecting several audio tracks of 
your CD. 
Configuration - This button opens the drive configuration dialog, where you can select special copy 
modes and SCSI IDs...
Reset - Restores the standard drive settings.
Add Drive - Creates a new drive entry in the list for editing the configuration data.
Delete - Deletes the selected drive entry from the drive list.
Save Setup - Saves the drive list and all configuration data in a *.cfg file.
Load Setup - Loads the drive list and all configuration data from a *.cfg file.

Features of the Track List Dialog:
Copy selected Track(s) - This button starts the audio data copy process, all selected tracks from the list 
are copied into one wave file. In the active VIP are created new objects for each track.
Play - Starts audio playback of the first selected track in the list.
Stop - Stops audio playback.
Pause - Stops audio playback for later resuming.
Resume - Resumes playback if previously paused.
Select all tracks - Selects all tracks of the CD for copying the complete volume.
You can select multiple tracks with Ctrl + mouse click or with Shift/ Alt + Cursor keys!
Deselect tracks  - Closes the drive door of the CD ROM drive.

Features of the CD ROM Drive Configuration Dialog:
Drive Name - Lets you edit the name of the drive in the list. This is useful if you create more than one 
entry accessing the same physical drive.
Host Adapter Number - Lets you specify the number of your SCSI adapter - normally 0.
SCSI-ID - Lets you set the ID of your CD ROM drive. Be shure to set the correct ID, there is no error 
checking!
SCSI-LUN - Select the SCSI LUN parameter, normally 0.
Alias - Lets you select a manufacturers type of your CD ROM drive.
Copy Mode Normal - Copies the audio data without any software correction.
Copy Mode Sector Synchronization - Copies the audio data using a software correction algorithm. This 
is useful, because some CD ROM drives cannot seek exactly to the same position between two read 
accesses but Samplitude can correct these differences using this algorithm.
Copy Mode Burst - Optimizes the speed of the copy process, no software correction is done.
Sectors per Read - Defines the number of audio sectors per read cycle, the higher the number the faster 
the copy process will be. Not all SCSI adapters support more than 27 sectors!
Sync Sectors - Defines the number of audio sectors used for the Sector Synchronization. A higher 
number results in a better synchronization but also in a slower copy process.



Save Project (Menu File)

The current project is saved with the name displayed in the project window. If    you previously have not 
specified a name for your project, Samplitude will ask you to do so. 

Shortcuts:

Toolbar:
Keys: s



Save Project as... (Menu File)

You can define the path and name of the new project you want to save your work under. RAM projects 
and virtual projects will be saved with the new names (the source file remains untouched). HD projects 
are renamed on the hard disk. Samplitude will not generate a copy of it for reasons of conserving space 
on your hard drive.

Shortcuts:
Keys: SHIFT + s



Save complete VIP to... (Menu File)

This function in menu "Project" allows saving a VIP with all needed projects (HDPs, RAPs) into
a
specified directory. This makes it easy to copy all files of a VIP to a backup disk etc...



Save in Format (Menu File)

With this function you have the possibility to convert projects between the different Samplitude formats. 
That is useful, if e.g. RAM projects need to be converted into HD projects or stereo Wave files into two 
individual mono files.



Rename Project... (Menu File)

The Rename Project command will let you rename a project file rather than save it to a different file. For 
RAM projects, only the internal names are changed (without being saved). But all corresponding files are 
renamed immediately in the case of HD projects.



Delete Physical Project... (Menu File)

HD projects are deleted from the hard disk. Use this command with caution as all corresponding files are 
lost.



 Import Sample... (Menu File)

Samplitude gives you the option of importing Wave, AIFF, MPEG or dump files into a Samplitude project. 
You will need to specify which type the project is going to be, a RAM Project or a HD Project.



    Export Sample... (Menu File)

The command Export Sample will let you export project files into Wave, MPEG or dump files. Keep in 
mind, that your project file needs to be either in the 8- or 16-bit mode. You can save it both in Mono or 
Stereo format.
When exporting in MPEG format Samplitude uses an 1:10 compression in MPEG 1 layer 2 - this is a near
CD quality compression perfect for backup or file transfer purposes. More compression rates and realtime
encoding / decoding gives you the UpGrade to QDesigns Imedia Audio full version (a demo version is 
on the Samplitude Studio CD-Rom)!



Record... (Menu File)

Use this command to record a new wave file. A new Recording Window will be opened and further 
adjustments for the recording can be made. Please refer to the chapter Quickstart for additional 
explanation of the options available.

Record mode
Specify the settings desired for your recording. Depending on the Samplitude version you can switch 
between 16 Bit and Floating Point mode, whether the recording is to be stereo or mono and if you want to
record either to your hard disk (HD) or to your computers memory (RAM - not in ARC44 version).
Note: Once you have determined a record mode, Samplitude will not let you change the mode for a 
particular VIP project. For example, if you have elected to use a stereo VIP, you will not be able to record 
in Stereo 2 mode.
Preload
The Preload option allows you to load all the buffers before the recording actually begins. This enables 
you to an immediate recording once you click the recording button. Otherwise Samplitude will load the 
buffers and depending on the size of the buffers and the overall computer speed this may take a little bit 
of time.
Sample Rate
Choose the sample rate needed. Please note that this option is based on your sound card's recording 
abilities with different sample rates such as 48 kHz. Make sure your sound card supports the option 
choosen.
Resampling to 44.1 kHz
Some Samplitude versions can perform a real-time sample rate conversion to 44.1 kHz if you are 
recording with a different sample rate. For example, many times a DAT tape is recorded at 48 kHz but the 
tape needs to mastered and prepared for Red Book audio CD processing, which needs to be in 44.1 kHz.
Samplitude allows you to automatically convert the audio during the recording, eliminating the additional 
sample rate conversion step after the recording.
Device
This selects the desired device driver you want to use for the recording. If you have more than one sound 
card installed in your system, this window will let you specify which card to use. Make sure the sound card
is properly installed in Windows and is operational. If you do not see an entry in this window, check 
whether a device driver has been installed for your sound card. This usually is done during the software 
installation for your sound card.
? (Device)
By clicking on the '?' button you can check on the record capabilities of the selected sound card. It shows 
you information on the sound card driver and it's capabilities.
Graphic File while Recording
Samplitude uses files that contain the graphical representation of your audio material for fast display and 
processing purposes. These support files have to be created either during the recording, or after the 
recording. If you check this box, Samplitude will create the support file(s) during the recording. 
However, this can sometimes lead to delays and recording interruption, especially when working with a 
large number of multiple tracks or on a system that is not very fast to start out with. 
Although not a large amount of the computers CPU is needed to create the files, it sometimes is 
advantageous to turn off this feature and let Samplitude calculate the support file information after the 
recording.
Playback while Recording
Simultaneous record and playback is especially important when wanting to monitor existing tracks while 
recording a new track. This option allows you to turn the feature on. To conserve system resources and 
keep the recording error free on slower systems, you may need to turn this feature off.
Note: If you only have one sound card in your system and want to use this feature, you will need a full-
duplex capable sound card. Check the capabilities of your sound card for this functionality. Samplitude will
generate an error message if your sound card is not capable of working in this mode.
Also, this option is grayed out until the first track is recorded.
Virtual Working
Samplitude allows you to choose whether you want to automatically create objects in a VIP once you are 



done with the recording. If you check this box a new object is created for every recording take and 
inserted at the cursor location and in the track(s) you enabled for the recording.
If the box is unchecked Samplitude will not create an object but rather open the data window with the 
contents of the recorded audio material.
Monitor
This checkbox activates the VU meters. Most sound cards also allow you to preview the audio signal you 
are about to record and depending on the features of the sound card, you will be able to monitor the 
recorded signal during the recording.
To keep the system requirements down, you may wish to disable the monitor function if it is not crucial to 
the recording you are doing. This will lower demand on the computer system, which may be required if 
you are working on a slower system.
During the recording the meters will react more slowly due to the priority level change. The most 
important task is to keep the recording error free. For this reason, Samplitude will switch the updating of 
the VU meters to a lower priority to not overload the computer system. This results in a slower reaction 
time of the meters. The levels are still shown with the correct values. Also, if you use lower buffer settings,
the meters are updated in faster intervals.
Corel/Osci
A oscilloscope view can be opened to display the wave form in a scaleable window. When activating the 
Phase checkmark the phase corellation of a stereo signal can be displayed.
A vertical line represents a mono signal, a horizontal line represents a signal with a phase invertion, which
is not wanted in most cases.    
Record Time
This counter indicates the length of the actual recording in minutes, seconds and milliseconds.
Disk Space
This counter shows you the available disk space in total track minutes for the selected sample rate and 
record mode. This counter does not decrease during the recording. It is updated after the recording takes 
place.
Record Offset
This option allows you to specify an offset, which is calculated in samples. Sometimes it is necessary to 
compensate for any delays due to processing speed and other factors, such as your sound card's ability 
to switch between playback and recording mode. Delays can occur between the recording and the 
playback of audio when the Playback while Recording feature is turned on. This option allows 
adjustments if this occurs. Good values to start with are in the 20-2000 sample range.
Help
This brings up the context sensitive help system with information on the features in the Record Parameter
dialog.
New (Button 1)
The path to the left of the button indicates the location of the audio file that is to be recorded. If you click 
on the New button you may enter a new name for the audio file or a new location. This is an easy way to 
target specify directories or hard disks as destinations for the new audio files. If you select a new name, 
the data window is renamed as well.
New (Button 2)
The path to the left of the button indicates the location of the VIP file you are working with. You may 
reassign the VIP to a new location on a hard disk or in another directory. If you specify a new VIP name, a
new VIP is generated with only one track of the same type as the mode that is specified in the Record 
Mode section in the Record Parameter dialog.
Mark Cursor
Samplitude allows you to drop markers (or cursor locations) during the recording. As you click on the 
button the current cursor number advances to the next available number.
This is especially handy when recording audio that needs to be edited at a later point and you want to 
create cursor locations that remind you of events such as errors or song starts of a live recording.
Media
This option allows you to link a media file with the recording. Files that can be linked include MIDI, AVI 
and WAV files. Please refer to MIDI/Video Link in the Properties section for a detailed description of 
available features.
Linking media files is often needed for editing of audio for AVI films or when needing to synchronize a 



MIDI file to add digital audio tracks to it.
Record
Starts recording by activating this button. 
Stop
Stops the recording process. Samplitude will ask you whether you wish to keep the recording or delete it.
Should the computer become overloaded due to swapping data or hard disk access for example, simply 
interrupt the recording with a click of the right mouse button or the space key.
OK
Closes the Record Parameter dialog.

Shortcuts:
Toolbar:

Key: r (second r starts recording)



Multi Card Record (Menu File)

This menu starts the multi card recording process. It can also be started with the button from the upper 
toolbar.
Before starting the recording you have to select the proper wave input device for each track. This can be 
done with the track info dialog (button ?) or with right mouse clicks on the R button in the VIP track. 
Then select the tracks for recording with a left mouse click.
Set all other recording options (pathes, sample rate...) in the Record Dialog, but close it without recording 
with the O.K. button.

Then activate the  button!



Multi Card Monitor (Menu File)

This function lets you monitor the input level via multiple sound cards on the LED peakmeters in each 
track. 
Before starting the monitoring you have to select the proper wave input device for each track. This can be
done with the track info dialog (button ?) or with right mouse clicks on the R button in the VIP track. 
Then select the tracks for recording with a left mouse click.



Load Session (Menu File)

This option will let you load a previously save session. All windows and displays are arranged in the same
way they were found in at the time you saved a session.



Save Session (Menu File)

This will let you save a complete session in Samplitude. This includes information about all just opened 
projects and their respective window positions etc.. This is useful to be able to continue later at the same 
place without having to load the individual projects first.
If a session is stored with the name 'startup.sam', this session is automatically loaded at the next start of 
Samplitude.



Project Information (Menu File)

This will show you information on the current project. This includes creation date, memory size, path and 
file names. For virtual projects a list of all included physical files is displayed. 

There is also a setting of the project volume in steps of 6 dB. This volume setting is important for 
multitrack projects since the sum of all digital tracks may not exceed 16 bites (0 dB). Each track of a 4 
track stereo project must be reduced by 2 bit's (12 dB). In the real world application, tracks are often not 
recorded or played back at the maximum level so that the reduction can be adjusted accordingly. 
However, raising the volume reduction setting may result in clipping.
Shortcuts:

Key: i



Multiple Sound Cards (Samplitude Studio only) (Menu File)

Here you can switch on or off the multiple sound cards playback feature.
If it is activated each track is produced through the sound card which is selected in the track info dialog 
(button ?).
If it is not activated Samplitude mixes all the tracks to the stereo master bus and plays it through the card 
which is selected in the playback parameter window (key p).
This multi card mode is useful when working with multi channel sound cards like ARC 44, ARC 88, DRC 
88 or DAL V8.

Please note:
Playback through several sound cards puts high demands on the accuracy of the sample rate of each 
card! If these do not agree exactly, positioning inaccuracies with longer samples will occur. To 
compensate for these problems you should playback the contents of a track through the same card that 
you recorded them with.



 MIDI/Video Link (Menu File)

MIDI/Video Link is one of the most powerful features of Samplitude. With this option you have the 
opportunity to synchronize media files such as MIDI files or AVI files. These can be complete MIDI songs 
or sequences (*.MID files), Video clips (*.AVI files) or other files for which a MCI driver is installed in 
Windows. 

Synchronizing Samplitude projects with MIDI songs

Since Samplitude offers synchronization with media files, you can set audio tracks to a already existing 
MIDI song. Certain audio effects in VIPs can be perfectly positioned on MIDI material (e.g. drum loops, 
scratches etc.). Otherwise, a project recording can be synchronized with the MIDI file, so that MIDI and 
audio material will play simultaneously. Please note that the MIDI file is always played through the 
selected MIDI device in the Windows Control Panel.

Synchronizing of Samplitude projects with Video-for-Windows movies (AVI)

With this capability Samplitude is an excellent tool for film music arrangements. Film and video clips are 
recorded as AVI files. A Samplitude virtual project can then be synchronized with it. The music, original 
sound, voice tracks, effects and much more can be adjusted on the time line and played with the AVI 
video simultaneously. As the final step, the audio signal can be recorded back to the video tapes original 
audio tracks or mixed for broadcasting. 

File Name
Here you can specify the file name and directory where the media file is located. By clicking on the '?' 
button you will receive a file requester dialog that allows you not only to look for the location on your hard 
disk(s), but also let's you specify which media file type you are looking for. Once you have found the 
media file, simply click on OK and Samplitude will make the link.
Offset
The Offset allows you to specify a different start time for the media file. The default is a zero position, 
which means that the media file would be started at exactly 0 position, which is the beginning of the file. If 
the offset is different than the 0 position the playback of the media file starts at the position you entered. 
Here is an example:
Let's assume that we are working on the audio for an AVI file and the audio section does not appear until 
15 minutes into the AVI file. It would be unnecessary to create 15 minutes of empty space at the 
beginning of the VIP in order to line up the AVI frames and the audio. Instead we can specify an offset of 
15 minutes and the AVI file would start playback at 15 minutes into the video file. However, all the audio in
Samplitude would start at position 0.
It makes good sense to write down the offsets you are specifying for the individual projects you are 
working with. This way you can easily identify offset references for your work.
Play Always
This checkbox allows you to specify whether Samplitude is to play the media file every time you start 
playback or recording in Samplitude. If you un-check the option Samplitude will not play back the media 
file. This is a quick way to turn off the playback of the media file.
Load Always New
If this option is checked Samplitude will always load the media file for every playback or recording of your 
VIP or data window. If the box is not checked, the playback of the media file is performed with the 
contents of the memory. If the media file is too large for the buffers, the playback is performed from the 
hard disk.
Video Options:
Extract Audio from AVI
If the file type is an AVI file with video and audio data, audio streams are extracted from all other 
information and the audio information itself is put into a data window. This allows you to extract and edit 



the audio apart from the rest of the contents in the imported file.
Replace Audio in existing AVI
This option performes a track bouncing of the current VIP into 1 wave file. This file is merged into the 
selected AVI file, so the AVI gets a new audio track.
Create AVI / Audio Copy
This option performes a track bouncing of the current VIP into 1 wave file. The AVI file is copied to a new 
file, which contains the new audio track. This option keeps the original AVI.
Video without sound
This option applies for AVI files only. If the AVI file contains audio the playback of the AVI file and it's audio
could interfere with the audio playback in Samplitude. For this reason it is suggested that you turn the 
audio playback for the AVI file off.
Video in Samplitude window
This option also applies to the AVI file playback only. Normally, the AVI file is played back in a completely 
independent window. This means, that if you run the Samplitude window enlarged you will not see the 
playback of the AVI window. You would need to minimize the Samplitude window or scale the window in 
order to display both windows on the screen. However, by checking this option you can display the AVI 
window as another Samplitude related window, which always stays on top during playback. This allows 
you to display the AVI movie at any time the playback or recording in Samplitude takes place.
Show Video Track
This is a new feature in Samplitude! With this option you can display a video track in the VIP window, 
which shows individual frames of the AVI file. In the upper left hand corner of the VIP window the current 
frame is displayed when clicking the cursor at a particular location in the VIP tracks. This allows you to 
position audio events and material at exact frame positions.
If you zoom into the window, the video track is also enlarged, showing the video frames at a lower zoom 
level as well. If you select to display the window at it's lowest zoom level, each frame is shown in the 
video track.
FX
The FX option allows the adjusting of small delays that can occur on slower computer systems for 
example. The linking of media files with VIP or data windows is based on two playback processes, one for
the Samplitude window and one for the media file window. No synchronizing of material takes place 
during the playback process. This means that on computers that have timing problems due to insufficient 
system resources or speed the digital audio tracks and the media file may run 'out of sync'. With the FX 
option you can specify a factor that is used to do internal sample rate conversion. How does that work?
Since we can not influence the playback speed of the media file, we need to adjust the playback speed of 
the digital audio tracks. Imagine that a normal playback speed is represented with a factor of 100. If the 
digital tracks play ahead of the media file, the playback needs to be slowed down. This would be 
accomplished by multiplying the regular playback speed of 100 with an FX factor just a little below 1, for 
example 0.998. This would result in a playback speed of 99.8, which is a little bit slower than the regular 
speed. This way we would align the digital tracks with the media file.
On the other hand, if the digital audio tracks lag behind the media file playback, a factor higher and 1 
would need to the entered. A value of 1.002 would be an example.
Rule of thumb for this factor is to use small value increments. The values should stay around 1. You will 
need to experiment with this setting, since there is no hard rule about the system performance of an 
individual computer system.
If you do not have any problems with the digital audio tracks and the media file playback staying in sync 
you should not enter any values into this field!
Remove Link
This button will unlink the media file from the Samplitude window. This effectively stops all association 
with the media file. If you do not need any further referenced to the media file you may use this option.
Preview
The Test button allows testing of the current link. By clicking the button the playback of the media file 
should commence. If no playback is visible in a Samplitude window, you may need to check the Video in 
Samplitude window option for AVI files. Other media files should be playing back through the Windows 
multimedia extension, such as the MIDI file player.



Text Comments (Menu File)

You can enter text comments to the current project via a simple text editor. This text can be displayed at 
each new opening of the project. This will preserve important information about the project together with 
the audio material.



System (Menu File)

In the System menu you have options to fine-tune Samplitude. You can specify parameters such as paths
and play and recording buffers. 

A principal rule about buffers: the larger the buffer, the more reliability you gain in playing back audio files 
(especially on slow systems or in full 16-track mode). However, if you increase the buffer size too much, 
the computers processing time becomes longer and delays might be introduced in the overall command 
handling. You will need to find a compromise between these two factors for each individual computer 
system.

Im/Export To enter the default path for wave import and export. Click on the ? button to 
bring up another window to look for a specific directory in case you do not know 
the full path.

HD Projects To adjust the default path for HD projects.

Ram Projects To adjust the default path for RAM projects.

Virtual projects To adjust the default path for virtual projects.

Sessions: The path for sessions is set.

Play/Record Buffer:

Here the buffer sizes for the playback and recording of audio data are determined. Rule of Thumb is: The 
large the buffer the more secure the playback even on slower systems will operate. However, the reaction
time of certain commands will go up. We suggest therefore that you experiment and find a compromise 
between buffer size and overall processing speed. It will depend on the individual system, what 
parameters will work best.

In the lower status bar you can observe how many buffers are used and whether errors occured during 
buffer access. With this display you will quickly find out, whether your system is able to process the 
selected number of tracks with the specified buffer sizes.

The display 'Buf:    2 / 4 Max: 3 Err: 0' would mean, that currently 2 out of 4 buffers are in use, the 
maximum buffers used during playback is 3, with no errors during playback. Bigger buffers usually 
increase the performance of the hard disk and the maximum track number in the continuous operation.

An increase in buffer numbers increases above all the safety of the system in the light of short term 
overloads, as they can emerge for example through single track crossfades or short overlaps of several 
tracks. Please keep in mind, that the buffer size is measured in stereo sample. A buffer size of 8192 
requires therefore 32 kBytes storage. Under no circumstances should the total memory used for the 
buffers be larger than the physical RAM in the computer. Otherwise virtual storage is used, which undoes 
the positive effect of big buffers.

The menu    option 'Help', 'System Information' shows the current system and memory usage of 
Samplitude.

RAM Buffer The value is defaulted to 8192 samples. This ensures a small access time to 
your computers RAM. For speedier reaction time, try a smaller value.

HD Buffer Default value is a 8192 samples buffer size. This will ensure under normal 
circumstances a short access time to HD. Samplitude will make use of this 
buffer for HD operations such as range testing, loops and other functions in 



conjunction with HD projects. For speedier reaction time try smaller values. If 
you encounter dropouts or phase shifting raise the value of this buffer.

VIP Buffer The default value is a 8192 samples buffer size. Samplitude uses this buffer 
when working with VIPs. In VIPs you are interested in error free playback of 
your audio data. For this reason a higher buffer is used since the system has to 
handle more data throughput.

Realtime Buffer: This buffer is used for realtime preview functions of the digital filters and the 
dynamics functions in the Studio version.

Buffer Number This option will let you specify how many buffers you want to use for data 
handling. The values can be set between 2 and 10. More buffers mean more 
security, but also more memory demand.

HD Record Buffer The default value is 8192 samples. The HD Record Buffer parameter is used for
audio recording to your hard disk. It indicates the block size of the data written 
to the disk.

Please note that if you increase the buffer sizes too much Windows will start putting data into its own 
Swapfiles which in turn will slow down Samplitude significantly.

Shortcuts:
Keys: y



 Synchronization (Menu File)

Samplitude Studio will slave to SMPTE/MTC/MC and can act as the master for MIDI Clock and MIDI Time
Code. Please note, that in most cases the slave sync functions work more stabile under Windows95 
than the master mode !

To run Samplitude in multitasking with a sequencer a MIDI connection must exist between the 
sequencer and Samplitude. That can be done through simple connection of a MIDI input to a MIDI output 
with for example a MIDI interface of a soundcard. 

Better is an internal combination of the programs through a Multi MIDI driver (available as shareware 
software, e.g. Hubis MIDI Loopback from the Samplitude Studio CD-ROM), which connects the output of 
one program to the input of another one. Keep in mind that one program will need to act as the 'master', 
while the other takes the position of the 'slave'. Select the modes in the programs accordingly. Starting 
and stopping is done from within the 'master'. If possible Samplitude should be the slave!

If Samplitude needs to be synchronized to a tape machine, such as a video recorder or a multitrack 
recorder, a SMPTE interface with Windows driver is necessary.

Internally the computer interfaces process the SMPTE code as MIDI Time Code (MTC). You can also use 
an external SMPTE to MTC converter and feed the MTC signal to a MIDI input port on a MIDI interface in 
the computer.

Samplitude supports now real chase lock sync (MIDI Clock and MIDI Time Code/SMPTE).
This means, that the internal sample rate of Samplitudes playback or recording is variied in small
steps, so that Samplitude can follow little timing changes of the sync master.
This is very useful when using sync between a tape or video recorder (master) and Samplitude (slave),
because most tape machines always produce small pitch changes, which results in delays between
the tape and Samplitude, when not using chase lock sync. If the timing changes are too big,
Samplitude produces heavy pitch changes, which may be reduced by entering smaller values for the
Sync Velocity in the sync dialog. Try values of 200 or more, when you need fast pitch changes in sync
mode! In the lower right status bar you can read the actual/maximal pitch change in cents ( 1 cent =
1/100 halftone).
Please know, that the chase lock sync performes a real time resampling (if not using ARC44), which 
needs a certain processing power, so be carefully on slow machines!
When receiving SMPTE/MTC you can start and stop playback with the space key - Samplitude will
always be in sync!

MIDI Clock Input Device:
Here the driver must be selected from which Samplitude will receive MIDI Clocks for the synchronization.
BPM:
Here the tempo must be entered, with which the MIDI Clocks should be received.

MIDI Clock Output Device:
Select the driver through which Samplitude will send MIDI Clocks to the synchronized equipment.
BPM:
Here the tempo must be entered, with which the MIDI Clocks should be sent.

SMPTE / MTC Input Device:
Select the device driver through which Samplitude will receive the SMPTE/MTC signal.

MTC Output Device:
Select the device driver through which Samplitude will send the MIDI Time Code master signal.

Type:



Select the proper frame rate. For example 24 frames for cinematic synchronization, 25 frames for PAL 
video and audio synchronization, 30 frames for NTSC video.

Preroll-Frames:
You can specify, how many frames Samplitude is to ignore before the synchronization starts. Here you 
can account for the fact, that certain analog instruments need time to reach the correct speed. In order to 
have Samplitude link up to the proper time values, a certain preroll frame count can be specified.

Sync Velocity
You can specify how fast Samplitude follows a pitch change of the sync master. A value of 100 is good for
normal purposes. If you need faster pitch changes, try 200 or 300. If you need to reduce the pitch 
changes in Samplitude try 50 or 30!

SMPTE-Offset:
The SMPTE offset is indicated in milliseconds and in SMPTE frames. The offset is removed from the 
incoming SMPTE time code signal to line up differences between tape material and recorded samples in 
Samplitude. With an offset of '60:00:00' milliseconds (1 hour) a tape that was previously stripped can be 
synchronized, if the start point for the recording/playback starts at 1 hour. Samplitude will, however, start 
at the correct beginning position.

FX:
With this parameter possible inaccuracies during the positioning of long samples can be equalized. 
Requirement is a flawless synchronization at the sample beginning. Follow the instructions in the chapter 
'Problem Solutions'.

Shortcut:    key g



Undo Definitions (Menu File)

The depth of undo can be specified when working with VIPs. A value of 20 means that the last 20 
changes can be undone.



Video Height (Menu File)

Samplitude allows you to link to an AVI file. The AVI movie is played back whenever the VIP or data 
window is played back or recorded into. If the option to display the AVI frames in the VIP window, the 
height of the AVI pictures is determined with this setting.



Font Selection (Menu File)

Samplitude will also let you specify the font used for text display in the various objects.



Colors (Menu File)

Samplitude lets you specify the color for various areas of the screen. Use this menu option if you want to 
change the default color to another one.



VIP Mouse Mode (Menu File)

Samplitude uses as a preset the left and right mouse button for the functions in virtual projects. The 
documentation exclusively describes this mode.

It is however possible, to execute all functions (like with other programs) with the left mouse button only. If
you click on the right mouse button, a popup menu will appear in which you can select, which function the
left mouse button is to execute.

In virtual projects (VIP) exist these modes:
Right Mouse Button:
Activates the standard mode in which objects are move with the right mouse button.

Ranges Mode:
The left mouse button is used to mark regions and cursors.    

Objects Mode:
The left mouse button is used for object manipulation.    

Volume Mode:
The left mouse button is used for the manipulation of the volume curves (Volume Rubberbands).

Volume/Objects:
The left mouse button is used for the manipulation of the volume curves and the objects (Volume 
Rubberbands).

Volume Drawing:
The left mouse button is used for freehand drawing of the volume curves. This mode is excellent for
creating your own fade curves etc. !



HDP / RAP Mouse Mode (Menu File)

In physical projects (HDP, RAP) exist these modes:
Ranges Mode:
The left mouse button is used to mark regions and cursors (default).    

Draw Wave
In this mode you can use freehand drawing to manipulate the waveform. This is useful to correct 
single samples, small distortion peaks, clicks etc... Please use a zoom level of 1:1 or larger for 
exact handling!

Draw Volume
In this mode you can draw the volume of the sample, e.g. to create a special fade curve.
The middle of the display is volume 100%, the lower border is volume 0 and the upper corner is 
volume 200%.



Enable Profiling (Menu File)

This menu lets you enable the DSP power display in the lower left corner of the screen. 
Always be shure to to need less than 100% to avoid hangs during playback!
If your project needs too much processing power you can:
- reduce the number of DSP effects in the mixer
- reduce the number of tracks with audio objects
- increase the VIP buffer size in menu System



Exit (Menu File)

This command will exit Samplitude. Please note that all changes made to any project not saved prior to 
exiting will be lost.

Shortcut: Alt + F4





MIDI-Sample-Dump (Menu File)

This function (Pro and Studio version only) enables a sample to be transferred to other equipment 
through a MIDI interface. They are often MIDI-Samplers or Keyboards with sample RAM to store the 
sample. If you own a Keyboard which is able to receive samples via MIDI-Sample-Dump, Samplitude 
offers a substitute for expensive sampling equipment. Samplitude can be used as a sample editor for 
cutting, editing and looping samples conveniently through graphical layout. The sample already edited 
can be sent to MIDI equipment and must be specified by a key/keygroup.Samplitude is compatible and 
with all equipment supporting the MIDI-Sample-Dump Standard, e.g. AKAI-Sampler, Roland Sampler, 
Yamaha SY-85/99, Kurzweil K 2000, EMU Emax and others. Please refer to the manual of your 
equipment for compatibility with the MIDI-Sample-Dump Standard.

Physical projects such as RAM or HD projects can be dumped (sent). Before dumping virtual projects, 
you will need to convert them into a physical project (RAM or HD). Use the menu Object and select the 
option Save as HD Project.... 

When receiving a sample with Samplitude, a RAM project will always be created. Please keep in mind 
that the physical limitation of a received sample dump is 2.048.383 samples based on the standards 
limitations. The memory required for a RAM project should be sufficient for most systems.
                      
MIDI-IN Device This button enables you to choose the device through which the PC receives MIDI 

data. Please make sure that the PC and the MIDI equipment can communicate with 
each other by selecting the proper settings for both MIDI-In and MIDI-Out. While the 
transfer occurs an error correction is performed. Handshaking between the devices 
needs to be established for this to work properly.

MIDI-Out Device This button lets you choose the device through which the PC sends MIDI data.

Channel Some MIDI equipment will let you specify a channel for the sample dump. If your 
equipment supports this feature you can specify the MIDI channel with this option.

Sample/Key Some MIDI equipment can be set to receive a sample for a specific key (original 
pitch). Should you have this option available you can specify the key used.

Receive Dump To receive a sample, click on this button. You will need to start the transmission on 
your MIDI equipment after you clicked on the Receive Dump button. Otherwise 
Samplitude will not detect the beginning of the data dumped.

Send Dump Click on this button to start transmitting the sample data to your MIDI equipment. To 
receive the data with your MIDI equipment you will need to start the receiving process 
on your MIDI device before you click on the Send Dump button.

Abort dump If you need to interrupt the transmission, click on this button. The sample dump is 
aborted immediately.





Menu Edit

This menu contains all functions which are similar to cutting on a tape machine. Please note for stereo 
projects that these operations are performed on both samples in the project.
In virtual projects you can mark track sensitive ranges, so only the selected tracks are manipulated.
Activate cutting and copy also makes a project named Clip activated. The window for this project will 
appear if double-click on the icon.

Undo Undo last operation(s) (VIP).
Redo Undo last Undo-operation(s) (VIP).
Cut Cuts the marked range into the Clip (VIP, HDP, 

RAP).
Delete Deletes the marked range. (VIP, HDP, RAP)
Clear Replaces the marked range with silence. (VIP)
Copy Copies the marked range into the Clip. (VIP, HDP, 

RAP)
Copy and Clear Copies the marked range into the Clip and clears 

it in the project. (VIP)
Copy As Copies the marked range into a new file. (HDP, 

RAP)
Paste/Insert Inserts sample data from the Clip on the cursor 

position. (VIP, HDP, RAP)
Overwrite with Clip Overwrites sample data with the Clip.. (VIP, HDP, 

RAP)
Extract Range Deletes sample data before and after the marked 

range. (VIP, HDP, RAP)

Edit complete Tracks (only VIP)
Cut Tracks Cuts complete tracks. (VIP)
Copy Tracks Copies complete tracks. (VIP)
Insert Tracks Inserts complete tracks. (VIP)
Delete Tracks Deletes complete tracks. (VIP)

Mix with Clip Mix sample data with the Clip. HDP, RAP)
Insert Workspace Inserts memory in the length of the range. (HDP, 

RAP)
Crossfading Crossfades sample data with the Clip. (VIP, HDP, 

RAP)
Auto Crossfade active Switches auto crossfade mode on or off. (VIP)
Amplitude / 2 The amplitude of the samples is halved. (HDP, 

RAP)
Amplitude * 2 The amplitude of the samples is doubled. (HDP, 

RAP)
Sampledata / 2 The number of samples is halved. (VIP, HDP, RAP)
Sampledata * 2 The number of samples is doubled. (HDP, RAP)
Delete Volume Handle Deletes selected volume handles. (VIP)
Delete Panorama Handle Deletes selected panorama handles. (VIP)
Delete Undo Levels Deletes all Undo levels. (VIP)

Undo (Menu Edit)

Samplitude offers you a comfortable way of tracking your changes in virtual projects. Up to 100 changes 
can be kept in memory and traced backwards



That means, virtual processes and physical processes (such as normalize, reverb, filter with activated 
Create Copy option etc.) can be reversed (undone).

Range and cursor manipulations can also be undone using the Undo feature.

Thanks to this extremely efficient feature, critical operations can simply be tried and then reversed to 
return to the original status if the results are not satisfactory.

Shortcuts:
Keys: CTRL+z



Redo (Menu Edit)
Redo revokes the latest undo command.

Shortcuts:
Keys: CTRL+a



Cut (Menu Edit)

The data of the marked range is removed from the current project and placed onto the Clip (Clipboard). 
Since the range was physically removed from the sample, the contents of the sample are reconstructed 
and the overall length is going to be shorter. In case of a virtual object, the range is removed and two 
objects are left behind containing the remainder of the object data.

Keep in mind, that the Clip contains as many samples (mono or stereo) as have been removed from the 
project. The Clip will contain one sample if you have cut the range out of a mono project, two samples if 
taken from a stereo project. 

Also, the sample resolution is the same as in the project. The former contents of the Clip are deleted.

After the function has completed successfully, the cursor will be positioned at the same location the 
removed range started. If you have accidentally removed a range, simply reinsert the range right after you
have cut it from the project. Since the cursor position denotes the beginning of the range, the cut data will 
be inserted at the same position.

Shortcuts:

Toolbar:
Keys: CTRL + x or x



Delete (Menu Edit)

The data of the current range is deleted. The sample data after the deleted range is added at the position 
the deleted range started. The sample length becomes shorter.

Please note that this command will not save the deleted data to the Clip. If you want to preserve the 
deleted sample data, use the Cut command. Using this the Delete command will delete the data from the 
current sample and preserve the contents of the Clip.

Shortcuts:
Keys: Del



Clear (Menu Edit)

The data of the current range is replaced with silence.
Please note that this command will not save the deleted data to the Clip. If you want to preserve the 
deleted data, use the Cut or Copy command. Using the Delete command will delete the data from the 
current project and preserve the contents of the Clip.

Shortcuts:
Keys: Alt + Del



Copy (Menu Edit)

The current range is copied into the Clip but not deleted in the project. The sample length is not varied. 
Please note that the former Clip contents are deleted. The Clip again has the same attributes as the 
project.

Shortcuts:

Toolbar:
Keys: CTRL + c or c



Copy amd Clear (Menu Edit)

The current range is copied into the Clip and cleared in the project. The project length is not changed. 
Please note that the previous Clip contents are deleted.

Shortcuts:
Keys: Alt + c



Copy as (Menu Edit)

The current range of a physical project (HDP od RAP) is copied into a new file. A file requester appears to
select the name of the new project.



Insert/Paste (Menu Edit)

To insert the contents of the Clip at the current cursor position, use this command. If a range is selected, 
the contents of the Clip are inserted before the selected range. The remaining sample data is shifted 
toward the end and the sample length is extended by the inserted data.

If the Clip was empty Samplitude will inform you with an error message.

The following table shows how Samplitude responds in the case the clip and the project have different 
channel numbers:

Clip Project Clip Channel Project Channel
Mono Mono Channel 1 Channel 1

Stereo Stereo Channel 1 Channel 1

Channel 2 Channel 2

Mono Stereo Channel 1 Channel 1

Channel 1 Channel 2

Stereo Mono Channel 1 Channel 1

The inserted data is defined as a range for further processing. If you inserted the data by mistake, simply 
delete the range with the Cut command in the Cut menu. 

Shortcuts:

Toolbar:
Keys: CTRL +v or v



Overwrite with Clip (Menu Edit)

The current range is replaced with the Clip contents. The overall sample length remains unchanged. The 
data that occupied this position before cannot be recalled. The Clip contents are not changed. The 
assignment of the Clip channels follows the table mentioned above.

In virtual projects a marked range defines the track and the position where the Clip will be inserted.

Shortcuts:
key: Alt +v or Insert Key

 



Extract Range (Menu Edit)

This function is the counter part of the Cut function. The current range is maintained and the unselected 
sample data is removed. 

Please note that this function will not copy the deleted data to the Clip. All deleted data is lost. On the 
contrary, the contents of the Clip are preserved.

Shortcuts:

Toolbar:



Cut Tracks (Menu Edit)

All selected tracks in the VIP are cutted into the Virtclip



Copy Tracks (Menu Edit)

All selected tracks in the VIP are copied into the Virtclip



Insert Tracks (Menu Edit)

All tracks in the Virtclip are inserted into the current VIP below the actual marked range.



Delete Tracks (Menu Edit)

All marked tracks are deleted from the actual VIP. 



Insert Workspace (Menu Edit)

The Insert Workspace option will insert blank data at the current cursor position or the position of the 
currently selected range. Size and position of the inserted blank space will depend on the length of the 
range selected before. 

The blank space will actually contain data with zero value. The data following the insertion point will be 
added to the end of the blank space. The defined range is maintained, the overall sample is extended by 
the length of the inserted space.

If you do not have sufficient memory to insert the workspace (i.e. with RAM projects), Samplitude will 
display an error message.



 Crossfading (Menu Edit)

with RAM or HD projects:

The range in front of the cursor or the marked range is cross-faded with the Clip contents. Follow the 
steps below:

1) Copy a range into the Clip.

2) Set the cursor on the desired position and then call up the crossfading function.

with Virtual Projects (VIP):

Two objects in a VIP track can be comfortably enhanced with a realtime crossfade. To accomplish this the
back object must be selected. Then the crossfade function is called. You can indicate the length of the 
fade in different units or get the range from the current area. 
Make sure that sufficient material is available before and/or behind the object borders to be able to 
produce the desired crossfade length. 

The curve forms of the fades (In/Out) can be freely selected from linear to exponential to logarithmic. If an
area is marked over the crossfade interface it can be monitored with the spacebar while the parameters 
are changed in the editor. A realtime preview is always available this way!

Keep in mind, that long crossfades require twice as much processing power than simple tracks. After all, 
two samples are simultaneously mixed and played in realtime. If needed increase the VIP buffer size in 
the menu 'Setup', System'. Linear crossfade curves conserve more processing power than non-linear 
curves!

Shortcuts:
Toolbar:



Auto Crossfade active (Menu Edit)

If this option is turned on, all newly recorded or cutted material in a VIP or material that is copied from a 
data window into a VIP track has an automatic crossfade applied to it.
A global setting for fade-in and fade-out parameters are assigned to the object. These settings can be 
changed with the crossfade editor in the Edit, Crossfade menu.
If two objects are overlapped that had an automatic crossfade applied to them a real-time crossfade is the
result.
The auto crossfade mode is an excellent tool to easily perform a linear cut of a spoken voice track, jingle 
track etc., which requires a soft passage without the unwanted 'pops'. If needed each crossfade can be 
edited in the editor or by manually manipulating the handles. 

Shortcuts:
Toolbar



Mix with Clip (Menu Edit)

The range contents and the Clip contents are mixed. Channel assignment between project and Clip 
follows the table above (See Insert function). The contents of the Clip are not altered.

Since either components are combined with their full sample values, make sure that no overmodulation 
takes place. This function is performed by way of addition. This assures on one hand, that the project 
sample remains free of a sudden volume decrease. On the other hand modification of the amplitude might
need to be performed before the mix to keep the resulting sample from clipping and distorting. For 
information on amplitude modification see Editing Menu. 



Amplitude / 2 (Menu Edit)
This function divides the amplitude of all sample values by a factor of 2. The same could be achieved by a
fade-in/fade-out with parameters ranging from 50% to 50%. However, this function is much faster since 
computing time is greatly reduced.



Amplitude * 2 (Menu Edit)
The same holds true for the Amplitude * 2 function. However, sample amplitude values are multiplied by a
factor of 2, thus corresponding with a fade-in/fade-out process with parameters ranging from 200% to 
200%.



Sampledata / 2 (Menu Edit)
Every second sampling value is removed and the complete sample is reduced to half its length. The 
audible pitch is doubled, i.e. raised by one octave. When halving the sampling rate you will notice that the 
corresponding upper harmonics are missing.



Sampledata * 2 (Menu Edit)
This function inserts a new value between two neighboring sampling values. It is the average of the two 
sampling values.

The complete sample changes to twice its length and the resulting pitch of the sample is cut in half. You 
must then double the playing rate to achieve the former pitch.

You should note that the higher playing rate does not lead to new upper harmonics.



Delete Volume Handle (Menu Edit)
With this function volume points can be deleted which have been previously selected. For individual 
volume points a double click with the right mouse button is sufficient to delete it. However, for several 
selected points (e.g. with Shift + right key or through the lasso function) the 'Delete Volume Handle' 
function is available.



Delete Panorama Handle (Menu Edit)
With this function panorama points can be deleted which have been previously selected. For individual 
panorama points a double click with the right mouse button is sufficient to delete it. However, for several 
selected points (e.g. with Shift + right key or through the lasso function) the 'Delete Panorama Handle' 
function is available.



Delete Undo Levels (Menu Edit)

This feature will delete the Undo levels of a virtual project. This is useful, if for example certain physical 
projects are left in the Undo chain, but do not exist in the VIP anymore. You won't be able to process or 
delete the data window if the Undo chain still contains a reference. After deleting the Undo levels these 
projects are available again. 



View Menu

This menu contains tools for manipulating the display of Samplitude.

Graphic Refresh Calculates new graphic data of a project.
Sections Select number of views.
Fix vertically Marks ranges always with full hight.
Show Grid Switch grid on or off.
Grid Setup Select kind of grid.
Units of Measurement Selects several units of measurement for the time

display.
Snap to Grid Switches the snapping functions on and off.
Snap Setup Chooses the kind of the snapping.
VIP Display Mode Select and toggle Display Preferences in VIPs. 
Horizontally This sub menu contains all functions for 

horizontal zooming and scrolling. 
Vertically This sub menu contains all functions for vertical 

zooming and scrolling. 



Graphic Refresh (Menu View)

Display inaccuracies after a complicated sample processing can be cleared by using this menu option. 
The screen (window) will be cleared and redrawn to display the project properly.



Sections (Menu View)

Samplitude allows the optional display of one, two or three sections of the samples belonging to one 
project or the VIP itself. Other sample programs usually show only one window of a sample.

If you select 2, Samplitude will display the same sample in two window sections. Each section can be 
handled separately. It is possible, for example, to represent the complete sample in one section and a 
zoomed in version of a certain range in the other.

The mode 3 sections is especially useful for searching for loop points.

The whole sample can be shown in the upper section, while the section on the lower left displays the 
beginning of the loop range and the section on the lower right the end of the range. Use the split range 
function for this purpose (key b).

Go back to 1 view with Shift b!

This is only an example of the mode 3 view. All sections can be handled independently. 

You can also drag ranges over the section bounds. Establish the starting point of a range by clicking, then
keep the mouse button pressed and change over to another section. Samplitude will show you the size of 
the range and at the desired location release the left mouse button to determine the end of this range.



Fix vertically (Menu View)

Ranges can be dragged (pulled) in Samplitude horizontally and vertically as well. If this option seems too 
strange to you, you can fix the upper edge of a range(s) to the maximum value and the lower end to the 
minimum value. Thus you get the usual representation in range dragging. However, a trade-off is, that you
will not be able to define the vertical extension of a section by choosing the vertical range button.



Show Grid (Menu View)

This menu function will display the grid on the project window. The units of measurement defined in Units 
of Measurement will appear in the upper sections of the grid.

Shortcuts:
Keys: #



Grid Setup (Menu View)

With this option you can define the type of grid that is used for the Show Grid option. Select between 
several line styles.



Units of Measurement (Menu View)

Units of Measurement is used to specify the grid dimensions. Several display options are available which 
will appear at the upper section of the grid.

The units supplied with Samplitude are Samples, Milliseconds, three SMPTE Frame options, the MSF 
format for red book CDs (SMPTE with 75 frames) and Bars for bpm display.

Note: If you want to find out what the current speed of the a selected quarter bar is, simply select the 
Beats option. The upper indicator L: will display the BPM. 



 Snap to Grid (Menu View)

This function switches the rasters on and off.

When working with virtual objects the Virtual Raster becomes available. Objects can only be shifted to the
beginning, the end or the hot spot of another object. The reference point is usually the beginning of the 
object to be shifted to. A hot spot when defined will be used as a reference point as well.

If several objects have been selected, the shift is performed by lining up the beginning of the last selected
object in the sequence with the reference object or raster point. All selected objects remain their position 
to each other.

This option can be used to easily rearrange objects with their audio patterns and gain sample-exact 
connections.

The following is an explanation of the options in the Raster Definition window which appears by selecting 
Range, Raster and Raster Definition....

Shortcuts:
Toolbar:

Keys: Ctrl + r



 Snap Setup (Menu View)

Object Activates the object raster.

Range Activates the range raster and enables the use of the current marked range as 
raster base (by clicking on the button Get Range). This option is very useful if 
you have found the perfect location defining a particular music bar in the 
sample. To transfer that range into the raster use the command Get Range.

Fixed Bar Raster Activates a raster which is based on bars and their beats from the beginning of 
the project. You can specify the speed of the measure by entering the BPM 
(Beats Per Measure) value in the dialog box. By clicking on the Bar Options 
button you have more options to specify the parameters for this option such as 
the time signature.

Free Bar Raster Activates a raster which is based is bars. The difference to the Fixed Bar Raster
option is that Samplitude takes the number of beats entered in the dialog box 
and automatically calculates the speed from the length and position of the 
range. If a complete 4/4 measure is marked the number of beats in the measure
would be 4. The length of the range would determine the speed in BPM that is 
needed to play the sample in the marked time frame.

Bar Definitions This dialog lets you specify the bar settings, e.g. Numerator / Denominator, the 
speed in beats per minute and the timer resolution in peaks per quarter note.

Shortcuts:
Keys: SHIFT + r



VIP Display Mode (Menu View)

The Display Preferences were designed to help you define the two alternative display modes possible in 
Samplitude when working with virtual projects. 

Usually you choose mode 1 for detailed drawing of samples with all information displayed and mode 2 for 
a quick drawing without graphics. Switching between the two modes is possible by pressing the Tab-key.

The menu option will provide you with another window in which you can specify the details of the two 
different display modes.

Definition
This will allow you to set the following configuration options for the VIP display. Settings can be made for 
the to display modes.
Sample / Halve
The graphical representation of the audio material can be displayed as a whole wave form or half the form
for higher definition. Checking this box will display the wave form with half it's information.
This mode is recommended, because the grid function (key #) and the vertical zoom functions (Ctrl + 
cursor up/down) are perfetcly adapted to this draw mode.
Background
Each object in the VIP track can be assigned with a color. The color is displayed if this option is checked. 
Otherwise, the same background color is used as for the track background.
Object Name
Objects in VIP windows can have their own name. If this option is checked the object name is displayed.
Project Name
Samplitude also allows you to display the audio file name in each object. This is especially useful if you 
quickly want to identify the audio file used in an object. Checking this option will display the file name in 
the object.
Group Number
Objects in VIP windows can be grouped together. When grouping objects it is helpful if the group number 
is displayed in the object. This option allows you to display that information in the object.
Buttons/Slider
By default Samplitude displays the buttons and sliders for each track. However, on smaller displays it may
be desirable to turn the display for the buttons and sliders off. By unchecking this option they are not 
displayed.
Peak Meters
Peak meters can also be displayed in VIP windows and in the mixer window for some Samplitude 
versions. Keep in mind that the peak meters require system resources since the are update in real-time. If
you are running Samplitude on a slower system you may want to disable the peak meters. This option 
allows you to do that.
Change Mouse
The Change Mouse option displays arrows and similar mouse symbols when the pointer is moved over 
components such as the cursor markers in the VIP window marker track. If you do not want to display the 
different pointer shapes, un-check this option.
New Object Mode
New Object Mode if turned on will display the start point and end point of the currently selected object in 
the upper left hand corner of the VIP window. If the option is not checked the current cursor location is 
shown.
Show Border
Decides if a border is drawn between tracks in a VIP. Switch it off to save space for VIPs with lots of 
tracks on small displays!

Active
Allows you to determine which mode is to be used. This can also be done with the TAB key from the VIP 
window without having to call up the VIP Display Definitions dialog.
Mode 1
Switches the VIP Display to mode 1.



Mode 2
Switches the VIP Display to mode 2.
Switch Modes
Switches between the two VIP Display modes.
Shortcuts:

Keys: SHIFT + Tab



Horizontally (Menu View)

This menu contains all the functions of the horizontal (red) position bar.



Vertically (Menu View)

This menu contains all the functions of the vertical (blue) position bar. 



Object Menu

In menu Edit you can find functions for range oriented manipulations of your project.
The object menu contains functions for object manipulation in virtual projects (VIPs).

New Object A new object is generated.
Cut Objects All selected objects are cutted.
Insert Objects The objects in CLIP will be inserted at the cursor 

position.
Delete Objects All selected objects will be deleted.
Extract Objects All NOT selected objects will be deleted.
Duplicate Objects All selected objects will be duplicated.
Duplicate Objects multiple All selected objects will be duplicated multiple.
Lock Options Selects options for object locking.
Lock Objects All selected objects will be protected from moving.
Unlock Objects All selected objects will be unlocked.
Build Loop Object Generate an object with a loop range.
Hotspot The current cursor position is made a reference 

point.
Move Object Moves objects to a specified position..
Split Objects All selected objects are separated at the cursor 

position.
Trim Objects Set object borders to the marked range.
Select Objects All objects in marked range are selected.
Switch Selection All objects in marked range toggle the selection.
Group All selected objects build a group.
Ungroup All selected objects will be ungrouped. 
Object Background Color Sets a background color for objects.
Object Foreground Color Sets a foreground color for objects.
Object Name Changes the name of objects.
Object Editor Opens the Object Editor.



New Object (Menu Object)

Use this function to create an a virtual object. The current range in the physical project will be inserted 
into the virtual project at the cursor position. It will also be the currently selected object. This is the same 
procedure as the drag & drop method explained earlier in this chapter.



Select Objects (Menu Object)

To select all objects located partially or entirely in the marked range or at the current cursor position. 



Switch Selection (Menu Object)

To select all objects located partially or entirely in the marked range or at the current cursor position. 



Cut Objects (Menu Object)

The currently selected object is replaced with empty space and copied to the VirtClip. The length of the 
current project remains and all other non-selected objects remain in their positions. The previous contents
of the VirtClip is replaced with the cut object
If there is a marked range all objects will be cutted at the range borders.
.



Copy Objects (Menu Object)

To place a copy of the currently selected object into the VirtClip select this option. The contents of the 
VirtClip can then be inserted into the project using the Insert Objects option (see below). The previous 
contents of the VirtClip is replaced.



Insert Objects (Menu Object)

Objects in the VirtClip can be inserted in the project at the current cursor position. The other objects in the
project maintain their positions. Please note that portions of the already existing objects might be covered 
by the newly inserted object. Simply drag the new object to a different set of tracks or reposition the object
on the same tracks.



Delete Objects (Menu Object)

The selected objects are deleted from the current project. The length of the current project however 
remains the same. Previously unselected objects keep their positions. The contents of the VirtClip remain 
unchanged.

Shortcuts:
Keys: CTRL + Del



Extract Objects (Menu Object)

All currently unselected objects are deleted. The contents of the VirtClip are not changed. Use this option 
with caution. Make sure you have all objects marked as selected which are to remain in the virtual project.



Duplicate Objects (Menu Object)

All selected objects are duplicated and pasted to the same position as the original objects. The original 
object is overlaid with the copied object. The duplicate object can easily be shifted to a desired position by
using the mouse. If several objects have been selected before the duplication, press the shift key before 
shifting to ensure that all objects remain in selected status and are shifted together.
This option does not make use of the VirtClip, so all contents of the VirtClip remain unchanged.
This function is also available using your mouse. Press and hold the Ctrl-key, click on the object you want 
to duplicate and drag the copy to a new position in the project.



Duplicate Objects multiple (Menu object)
With this function selected objects can be duplicated repeatedly. A dialogue is opened, in which the 
number of copies, the respective distance and the total length can be indicated. Also consider with this 
method the possibility to build loop objects!



 Lock Options (Menu Object)

Here you can select, which options should be disabled:
Moving: Disables moving of objects (default). This is useful in multitrack projects to avoid 
delays between several tracks.
Volume changing: The volume handles are disabled.
Fade In/Fade Out: The fade handles are disabled.
Length changing: The length handles are disabled.



Lock Objects (Menu Object)

To protect objects from unintended shifting use this option. First select the objects you want to lock in 
place and activate the lock function. A diagonal line is placed across the locked object.



Unlock Objects (Menu Object)

Locked objects are unlocked and made available for shifting. Make sure you have selected the object(s) 
you want to unlock prior to activating the unlock function.



Build Loop Object (Menu Object)
With this function a loop can be defined within an object. An area which indicates the loop length must be 
marked in the object first. 
The object then becomes the loop object. That means that the number of loops can simply be 'raised' with
the 'length handlers' at the bottom of the object. 

Such generated loop objects are ideal for generating long drum sequences from only one drum loop! 
Loop objects also help to save memory, since in the VIP only one object is handled rather than multiple 
objects or copies of the same material or very long samples!



Hotspot (Menu Object)

The current cursor position is made a reference point for the raster function applied to a selected object. 
Instead of the objects beginning, the hot spot is now used for shifting by different rasters. 
Hot spots are illustrated by stroked vertical lines. Hot spots may stand outside an object (in front of or 
behind the object). 
This function is very useful for cases where the portion of an object to be synchronized does not line up 
with its beginning.



Split Objects (Menu Object)

You can separate objects when you need to delete or shift only parts of them. All selected objects are 
separated from the cursor position into two individual objects. When a covered object is separated, the 
object just being created will cover the original.

Shortcuts:

Key: t



Trim Objects (Menu Object)

This function sets the object borders to the actual marked range. Select the object you would like to trim 
with the right mouse button first. Then select the range with the left mouse button, the range must be 
inside the objects borders.

Shortcuts:

Key: Ctrl + t



Group (Menu Object)

All selected objects are grouped together. All operations are applied to the whole group. 

Shortcuts:

Toolbar:



Ungroup (Menu Object)

Selected objects are ungrouped. Individual objects are available for processing after that.

Shortcuts:
Toolbar:



Object Background Color (Menu Object)

Sometimes it is necessary to distinguish certain objects from others. Samplitude will let you specify 
different colors for selected objects. Once you have selected one or more objects, choose Object 
Background Color from the Object menu and specify a different background color for the objects. After 
clicking on OK all selected objects will have the specified background color. 



Object Foreground Color (Menu Object)

The foreground color (such as sample data displayed) can be changed as well. After selecting the desired
color, all selected objects in the project will have the same foreground color.



Object Name (Menu Object)

Another way to distinguish certain objects is to give them a different name. Samplitude will let you specify 
a name (such as Verse) with this option. Please note that the name only shows up if you enabled this 
option in the Object Drawmode definition window (available from the Setup menu or by pressing 
Shift+Tab when the object is selected).



Object Editor (Menu Object)

The object editor lets you select the curve types of the real time object fades (fade in and 
fade out). So you can
give the fades any curve type from logarithmic to exponential.
Activate the object editor with the menu "Object > Object Editor" or with a right + left 
mouse click on
the object!

Shortcut: right + left mouse button



Move Objects (Menu Object)

With this function you can move an object to a specified position. A dialog is opened, where you can 
select the new position in samples, milliseconds or SMPTE time.
ve.



Menu Effects

This menu will let you add effects to the sample data.
Some functions only work for a marked range. If you want to edit the whole sample you will need to select
the whole sample as a range (see function Range All in the Range menu).

Normalize... Sample data values in a marked range are normalized.
Switch Channels Switches left and right stereo channel.
Parametric EQ A parametric 3 band equalizer is opened.
Graphic EQ A graphic 5 band equalizer is opend.
Draw Filter/Spectrum FFT Filter for analyzing and drawing in the frequency 

domain.
Compressor/ Expander/ Distortion Dynamics functions like Compressor, Limiter, 

Expander, Gate and Distortion.
Room Simulator Simulates Reverb and other room effects.
Declipping Eliminates Clipping.
Remove DC-Offset Removes a DC offset from the marked range.
Convolution Convolution function for reverb, echo filter and morph

effects.
Get Noise Sample Copy the marked range to the NoiseSample project 

for the noise reduction
Noise Reduction Remove Noise from the sample using the Noise 

Sample
Timestretching/   Pitchshifting/   
Resample

Resampling, Timestretching and Pitch Shifting.

Change Samplerate... Creates a new project with another sample rate.
Fade in/out... Sample data values in a marked range are faded in or out.
Set Zero Sample data values in a marked range are set to zero .
Invert Phase Sample data values in a marked range are inverted.
Revert Sample data values in a marked range are reversed.
Echo... An echo effect is calculated.
Build Loop A smooth loop is calculated.
Generator Creates Standard Waveforms.



 Normalize (Menu Effects)

Normalize File (phys.)
This function modifies the sample's overall amplitude.
The data is altered so that the maximum amplitude occurring in a specified range is set to 100% (or any 
other value between 1-400%). Samplitude will first attempt to detect the maximum and relate it to the 
percentage chosen. Then all other values are weighted with the new factor.
The Normalize function is designed to fully modulate or over-modulate samples. A particular application is
processing that is done before a conversion from a higher sample resolution to a lower resolution takes 
place. Since the dynamic range of the low resolution is smaller, it still can be fully utilized by applying the 
Normalize function.
If working with sounds from one single instrument, you should set the factor to 100%.
If, however, your audio material has background percussion for example, you will be able to over-
modulate the sample to 120% to 200%. This will only cut off the new percussion peaks. The same method
allows you to alter the sound of natural instruments by over-modulating them.
As preparation for further physical processing, such as filters, reverb, dynamic compression etc., a level 
reduction of 50-70% is suggested. This should avoid clipping during post processing.

Normalize Object (virt.)
This function will perform real-time normalizing on the selected objects. This is different than the physical 
normalizing, which will restructure the audio file.
The real-time normalizing will look for the peaks in your audio material and adjust the volume so that the 
peaks represent 0 dB. The rest of the audio material is scaled accordingly.
You can return the virtual object to it's original volume setting by selecting Object Volume = 0 dB from the 
Object Editor.

Shortcuts:
Toolbar:

Keys: n (virtual)
Shift + n (phys.)



 Fade in/out (Menu Effects)
This function allows sample ranges to be faded in or out. 

The amplitude is varied in its time characteristic from the start value of the beginning to the final value at 
the end of the range. When the function has been called, a window appears in which you can specific 
parameters for this operation.

A simple fade-in operation would be performed with the parameters from 0% to 100%, whereas normal 
fade-out requires the specification from 100% to 0%.

The fade curve can be adjusted from linear to exponential or logarithmic.

Notice that real time fading is applied to virtual projects only (with handles). For all other projects (RAM 
and HD) the sample data is physically altered.

Shortcuts:
Keys: f



 Parametric Equalizer (Menu Effects)

This dialog contains a 3-band parametric equalizer. You can activate filters on three freely selectable 
frequency ranges to adjust the sound of a sample. You can produce wideband frequency adjustments for 
both high and low pass ranges as well as smallband corrections of specific frequency ranges.

To accomplish this you must mark an area in the current project or with the 'a' key the entire project. (HDP
and RAP Projects).
 On a quite fast computer (486/66 and higher) a realtime preview can be activated with the test button. 
With the preview a specific setting can be easily examined before it is written back to the sample. On a 
Pentium with 90 MHz or higher all five bands can be calculated in realtime and played back 
simultaneously!

Please know that there is a powerful realtime mixer (key m) which contains a 3 band full parametric EQ 
per channel. So often the use of the destructive EQ is not necessary.

Frequency:
With the frequency faders the middle frequency of the individual filters can be adjusted between 10 Hz 
and 24 kHz. Through the free choice of the frequency several filters can also be set to the same values to
achieve a greater effect.

Width:
Here the width of the individual filter can be adjusted between 10 Hz and 10 kHz.

Decibel:
This fader set the amount the filter is increased or decreased (+/- 20 dB). A fader setting of '0' deactivates 
the filter and thus consumes no additional processing power.

Volume:
You can adjust the overall volume with this faders if due to the filtration of the individual levels the volume 
is too low.

Test:
This button activates the realtime preview. If the preview cannot be turned off by pressing the 'Test' button
again (due to overload of the computer) press the spacebar to stop the audio playback. Increase the 
realtime buffer size in the menu 'Setup', 'System' if needed!

Setup 1-3:
Here you can change between three different filter setups so that you can quickly achieve an acoustic 
comparison between the different settings during the preview function ('Test' button).

3D-FFT:
This button activates the three-dimensional frequency display for the sample (Fast Fourier 
Transformation). You can analyze which frequencies occur in the material and how the filtration affects 
them. The current filter parameters are already included!

FFT:
This button activates the two-dimensional frequency display of the first 512 sample values of the current 
area. The current filter parameters are also included here so that a preview of the filter effect is possible!

Filters:
This button activates the display of the original frequency filter settings set in the faders. Please keep in 
mind, that this curve actually represents the exact frequency response of the specified filter and not only a
crude approximation like it is the case with many other systems. (The curve shows the original frequency 
response of the impulse response of the filter.)



The effects of a particular the equalizer effect can even be increased if it is repeatedly applied to a 
sample. Various frequency manipulations can be therefore performed on the material!

At this point we would like to thank the Institute for Technical Acoustics of the TU Dresden (Technical 
University of Dresden, Germany) for their excellent cooperation.
 



 Graphic Equalizer (Menu Effects)
This dialog contains a 5 band graphic equalizer. The filters can be adjusted on five pre-determined 
frequency ranges, to alter the sound of a sample.

To accomplish this you must mark an area in the current project or with the 'a' key the entire project.
(RAP and HDP Projects.)
 On a quite fast computer (486/66 and higher) a realtime preview can be activated with the test button. 
With the preview a specific setting can be easily examined before it is written back to the sample. On a 
Pentium with 90 MHz or higher all five bands can be calculated in realtime and played back 
simultaneously!

Please know that there is a powerful realtime mixer (key m) which contains a 3 band full parametric EQ 
per channel. So often the use of the destructive EQ is not necessary.

Equalizer:
The frequency ranges can be raised or lowered individually with the five faders. If you set the fader to the 
'0' position the filter is deactivated and will not consume any processing power. 

Volume:
You can adjust the overall volume with this faders if due to the filtration of the individual levels the volume 
is too low.

Test:
This button activates the realtime preview. If the preview cannot be turned off by pressing the 'Test' button
again (due to overload of the computer) press the spacebar to stop the audio playback. Increase the 
realtime buffer size in the menu 'Setup', 'System' if needed!

3D-FFT:
This button activates the three-dimensional frequency display for the sample (Fast Fourier 
Transformation). You can analyze which frequencies occur in the material and how the filtration affects 
them. The current filter parameters are already included!

FFT:
This button activates the two-dimensional frequency display of the first 512 sample values of the current 
area. The current filter parameters are also included here so that a preview of the filter effect is possible!

Filters:
This button activates the display of the original frequency filter settings set in the faders. Please keep in 
mind, that this curve actually represents the exact frequency response of the specified filter and not only a
crude approximation like it is the case with many other systems. (The curve shows the original frequency 
response of the impulse response of the filter.)

The effects of a particular the equalizer effect can even be increased if it is repeatedly applied to a 
sample. Various frequency manipulations can be therefore performed on the material!

At this point we would like to thank the Institute for Technical Acoustics of the TU Dresden (Technical 
University of Dresden, Germany) for their excellent cooperation!

 



Draw Filter/Spectrum (FFT Filter) (Menu Effects) 

Introduction

The FFT Filter Spectrum Analyzer is a high quality tool that allows you to solve typical problems that may 
arise in every day studio work. The Analyzer is a combination of a FFT spectrum analyzer and a FFT 
filter. The calculated frequency response can be freely edited with a drawing function and reapplied to
the audio material. The real time preview function allows for intuitive and time saving previewing of 
the changed audio.

 Some applications for this function are:

· Frequency response Verification and correction of a recording or mix.
· High precession frequency measurements i.e. verification of the tuning of instruments.
· High quality filtering: fine tuning or complete frequency alteration of samples without changing the 

phase response. Typical filter application effects such as the worsening of impulse responses or the 
room characteristic are completely eliminated. The filter does not contain its own amplitude.

· Sub-base precession correction by raising or reducing the amplitude is possible in the range of 10 to 
50 Hz without the typical dampening effect that occurs with conventional filters. This is ideal for Dance
music or eliminating of rumbling noises and similar effects.

· Detailed volume reduction or amplification of specific instruments or tones in a recording.
· Formant filtering.
· Dynamic filtering Crossfading of two filter curves for filter switch effects, variable frequency fading and

more.
· Applying of frequency responses from other mixes or room characteristics, including patterns from 

particular loudspeakers. This is of great help when given the task to fit samples into a mix or to create
and simulate specific listening environments.

· Correction of frequency responses from recording or listening rooms, loudspeakers, amplifiers and 
others.

First Steps
Description of Graphical Elements and Corresponding Functions
Description of additional Functions on the Main Window
Additional Settings in the Advanced Settings Dialog
Problems and Solutions regarding the FFT Filter Spectrum Analyzer



First Steps (FFT Analysefilter)

We suggest to experiment with the exercises given below to gain an understanding of the FFT Filter 
Analyzer.
Before you proceed with the exercises please reduce the volume of your amplifier. This technology allows
easy amplification in the lowest frequency ranges that can damage your speakers if the volume is set too 
high.

1. Filtering and Frequency Analysis:

1. Mark a range in the data window or select an object in the VIP.
2. Display the FFT Filter Analyzer dialog with Menu->Draw Filter/Spectrum.
3. A blue curve is displayed, which shows the frequency response of the selected audio material. 

However, if only a specific range is analyzed and not the complete file the Analyze ALL button can
be pressed to have Samplitude analyze the complete contents of the audio file. The red curve 
represents the frequency response of the applied filter setting. The initial setting is 0 dB for all 
frequencies.

4. Use left mouse button to draw a filter curve into the display. The frequency response of the filter 
changes accordingly. The blue curve also changes during the drawing of the filter curve. It now 
displays the new frequency response that the audio material would adapt. The blue curve is 
therefore considered the corrected frequency response.

5. If you are using a faster computer, such as a Pentium 90 and higher, you can use the Test Mono, 
Right or Left buttons to preview the results of the filter in real time. Otherwise the Preview button 
can be used to process a portion of the audio material non-destructively and play it back.

2. Filtering with the Direct/Match Mode:
You also have the option to draw the desired frequency response (the blue curve) direct with the mouse. 
Click on the Direct/Match option in the Edit Mode section to access this mode. Once you start drawing the
desired frequency response into the graphic area, the yellow curve shows the original frequency response
of the material for comparison. This type of editing mode only makes sense for certain cases. Distortions 
due to a large increase of a frequency range can quickly occur. If this happens use the click on the Prev. 
Clipp. button to return to a more moderate setting.
If you draw the blue curve directly into the graphic display the frequency response of the filter is also 
changed. To picture this process use the Reset button to return the filter to its default setting. Next, switch 
back to the Filter mode in Edit Mode to confirm that the filter curve is back to its default setting of 0 dB. 
Now we can return to the Direct/Match edit mode and draw a new blue curve. If you now return to the 
filter mode the filter frequency response has changed as well (red curve).
There is also a possibility to display all three curves at the same time. To switch to this mode click on 
Settings in the dialog. Another dialog appears on the screen that contains further refinements of the 
Analyzer setting. In this dialog is a Draw Settings section in which the setting 3 in Number Figures can be 
selected to display all three curves.

3. Dynamic Filtering (Crossfading of two filter curves):
Select the mode Dynamic Start from the Mode section in the main Analyzer dialog. The displayed 
frequency response represents only the left range of the sample. The response can be edited separately 
by using the above editing methods. However, the change only affects the beginning of the marked range 
in the data window or the VIP object.
Next, select Dynamic End and change the frequency response curve (red curve). The new setting only 
affects the right range of the sample material. In other words, the beginning and the end of the audio 
material have different adjusted frequency response settings and during the playback of the complete 
range the frequency properties of the audio material are faded from the beginning to the end.

The crossfade can have different settings. A detailed explanation for the various crossfade methods can 
be found in the description of the individual parameters.



A tip for working with dynamic filtering: To gain a quick understanding of the dynamic filtering possibilities 
we suggest to experiment with a sample that contains a noise signal (white or pink noise or audio that 
contains a significant amount of noise).

4. Transferring of frequency responses from one sample to another:
This process can be defined as two steps, the learning step and the actual filtering:

1. Mark a range in a data window that you want to use as the source frequency response.
2. Display the FFT Filter/Spectrum Analyzer dialog (Effects->Draw Filter/Spectrum).
3. Click on Analyze All.
4. In the Edit Mode select the setting Direct/Match, otherwise the transfer process will not work properly.
5. Click on Settings to display the detail dialog and save all settings with the option Save Setup.
6. Next, close the detail dialog by clicking on Cancel and also close the analyzer dialog.

The learning process is now finished. The next task is to apply the saved settings to the other audio 
material:

1. Mark the desired range in the data window that is to receive the frequency response from the earlier 
material.

2. Display the FFT Analyzer dialog.
3. Load the saved frequency response settings with Settings, Load Setup.
4. Return to the main dialog and change the Edit Mode back to the Filter setting. The filter curve now 

represents the frequency response of the first audio material and the current audio material will be 
filtered with the response of the former!

5. To listen to the results click on Test, Preview or OK.

Please note: The results may not necessarily yield the desired effect at first. To learn more about practical
tips in working with the settings and parameters, please refer to the tutorial on the FFT Analyzer, which 
describes several examples.



Description of Graphical Elements and Corresponding Functions   (FFT   
Analysefilter)

Overview of the curve types:
There is a total of nine curves that are available for use. The yellow curve always displays the original 
frequency response, whereas the red filter curve and the blue curve show the corrected frequency 
response.The blue curve are a nearly representation of the frequency response that the material is 
supposed to have after the filter has finished processing the audio.

In the Edit Mode Filter the red curve can be edited. In the Edit Mode Direct/Match the blue one is 
available for updating. 
The first group of three curves (yellow, red, blue) is used in the Static Mode, the second group is used for 
the beginning of the dynamic filtering (Edit Mode: Dynamic Start) and the third is used for the end of the 
dynamic filtering (Edit Mode: Dynamic End).

Faders and Zoom Options:
The left fader is responsible for changing the amplitude scale of the graphic display for the yellow and the 
blue curves, in other words, the original and the desired frequency responses. The amplitude is shown in 
dB to the right of the vertical fader.
The right fader changes the filter range (red curve). If the fader is moved up the range is expanded and 
the curve can reduce or increase the frequency response. The exact values of that amplitude change are 
shown to the left of the vertical fader in dB. (Its only for small changes. The smallest and the highest value
can be edited with the parameters max. Range and min. Range, please look for the description of this 
parameters below.)

In the lower left-hand corner are four buttons that will change the zoom levels of the display. The In button
zooms into the display by one level. The Out button will do the opposite. There is a total of 10 zoom levels
available. The buttons All and Max zoom either all the way into the graphic or all the way out in displaying 
the maximum resolution. If you click a second time on the button, the program will return the display to the
last zoom level. This can be used to quickly change the display to accommodate further editing. The fader
beneath the graphic display allows scrolling of the display section if a higher zoom level is selected. The 
selected frequency range is shown in Hz above the display.

Graphic display mode selectors:

Below the graphic display are four radio button sections that allow you to switch between different display 
modes.

Draw mode: The frequency responses can be displayed either as curves or as diagrams by changing this
mode. The diagram mode is especially useful for low-band range editing since there are usually less 
frequency bands available for editing.
kHz/Notes: The display can be changed to show the frequency in Hz or the notes that the response is 
following. Displaying the data in notes is only possible when the frequency display log is selected.
Freq lin/log: This radio button allows you to switch between the logarithmic and linear display mode. The 
logarithmic display mode follows the human frequency perception. As with the keys on a piano the half 
tones or intervals of the display is constant throughout the frequency range.
dB lin/log: The level in the display can be scaled logarithmically or linear. The logarithmic display would 
conform to the human perception of loudness or volume levels.



Description of additional Functions on the Main Window   (FFT Analysefilter)  

Filter Mode:
Static: In this mode the edited filter curve affects the complete selected range of the selected sample 
(HDP or RAM-Project) or the complete VIP object.
Dynamic Start: This mode filters the audio in a dynamic (time dependent) way. The filter curve is faded 
between two curves. The first curve (Start) can be edited with this mode. The displayed frequency 
response curve represents the beginning of the marked range.
Dynamic End: The second part of the dynamic filtering curve can be edited with this mode. The 
displayed frequency response curve affects the end of the marked range (End).

Edit Mode:
Filter: The filter curve (red curve) can be edited with this mode.
Direct/Match: The corrected frequency response (blue curve) can be edited here.
To apply frequency responses to other samples saving of the current settings is necessary with the 
Setting, Save Setup button.

Analyze All: The frequency response of the complete audio file is calculated. This only works with the 
filter mode Static.

Reset: All curves are reset to their default values of 0 db.
Invert: The filter curve is inverted, which allows you to correct the frequency response of rooms and 
loudspeakers.
Prev. Clipp.: Prevent Clipping. If the frequency response has been edited in a way that the filtered audio 
is distorting and clipping, this button will quickly adjust the curve to correct the mistake.

Test Mono: This is a real time preview function that plays back the filtered audio for mono audio files or 
stereo samples that are played back in mono mode.
If the preview cannot be turned off by pressing the 'Test' button again (due to overload of the computer) 
press the spacebar to stop the audio playback.
If you want to close the dialogbox with Cancel, please stop the audio playback before!.

Test Left: A real time preview function that will play back the left channel of a stereo sample or plays back
a mono sample. (To preview the filter changes in real time with a true stereo audio file or image would 
overwhelm standard PCs.)
Test Right: A real time preview function that plays back the right channel of a stereo sample or plays 
back a mono sample.
Preview: This function previews the changes, but not in real time. Samplitude will process a portion of the
audio material non-destructively and plays it back. This mode can process both the left and right channel 
of the audio. The resulting audio playback is with hundert percent consistent with the final results after the
settings are committed to the audio material.
Play Orig: The original audio material is played back for comparison.
Settings: This will display another dialog with detailed settings for the filter function. This dialog does not 
have to be closed in order to work in the main Filter Spectrum dialog. Both dialogs can stay open and the 
settings in either dialog can be altered at the same time. Please close this dialog before you will start the 
final processing with the OK Button.
Help: The help window is displayed.
OK: This will commit the changes in the filter dialog to the audio material, sample or VIP object.
Cancel: The dialog is closed without executing any filtering changes.



Additional Settings in the Advanced Settings Dialog   (FFT Analysefilter)  

Analyze Parameters: This setting affects the frequency analysis. This mode is for experts who wish to 
make further adjustments to the way the audio is analyzed and usually does not pose a significant 
influence on the most common ways the analyzer is used.

Analyze Precision: During the analyzing process the audio is separated into individual blocks. The 
setting High overlaps these blocks with a 50% ratio, whereas Normal appends the blocks without 
overlapping them. With a High setting short sounds such as 1/32 notes are analyzed more sufficiently. If 
High is selected, the calculation time for the analysis is doubled which is a significant increase especially 
when Analyze All is selected.

Analyze Accuracy: The setting Noise will slightly diversify the analyzing results of overtones. The peaks 
are widened. The same is true on the other hand for the setting Tones, which incorrectly alters the 
complete frequency response of noise type sounds. This may be the case for instruments like percussion 
instruments such as a Hi-Hat and similar. Those inaccuracies show especially up with smaller resolution 
settings.

Channels: For stereo samples you can decide whether the left, right or both channels are to be analyzed.

Analyze Time: You can also decide how many seconds of the audio material are to be analyzed when 
the FFT Analyzer is first displayed or when the resolution and any of the Analyze Parameters are 
changed.
This setting only affects the display of the frequency response in the Static mode.

Please note: Every time an Analyze Parameter is changed or the Resolution is changed the frequency 
response is re-calculated. If you previously used the Analyze All button to calculate the response for the 
complete audio range you will need to use that function again as the re-calculation due to the above 
mentioned changes will cause you to lose the previous analysis results. In this case the button for 
Analyze All will be enabled again.

Filter Parameters: This setting affects the filter processing.

Precision and Precision Real Time: These settings help to achieve a happy medium between the 
processing time and small reductions in the quality of the results. Settings can be chosen for the real time 
previewing (Test Left and Test Right) and the non real time Preview function, which processes a small 
section of the audio material first. The section Precision also affects the accuracy and processing time of 
the filter function when the OK button is pressed.
It is possible to make different adjustments to the precision sections to achieve a fast real time preview 
playback (without overloading the system by keeping the setting to Test1, Test2 or Normal). For the final 
application of the filter to the audio material the section Precision can have different settings to achieve 
the highest quality. For this reason it is recommended to use the Preview button to have Samplitude 
calculate a section of the audio material with the higher precision settings to verify the final results before 
committing the change. The settings can be different for the real time preview and the Preview button 
function. Thats why the preview types can be a little bit different in quality especially in the Filter Mode 
Dynamic.

Test1: This is the fastest calculation type. It can happen that a soft tremolo effect is audible with this 
setting. It is also possible that especially with a low Resolution setting the audio appears to be sounding 
rough. Additional may appear very small delay effects. However, these artifacts are often outside of the 
audible frequency range. This setting should be only used for previewing!
Test2: More processing power is required and the calculation is somewhat slower. A small amount of 
modulation can be sometimes heard in the lower band frequency ranges if extreme filter settings are 
used, or if the Resolution is small.



Normal: No reduction in quality is audible.
High: Compared with the Normal setting the processing load is increased by 30%. When using dynamic 
filtering the settings are mixed with a smooth transition.

Max. Range, min. Range: The range for the maximum and minimum amplification is set here. (The scroll
bar to the right of the graphic display can be used to perform fine tuning as well.) If parts of the spectrum 
are to be fully faded out set the Min Range to a low value (i.e. 120 dB).

Threshold: When editing the (blue) curve in the Direct/Match edit mode only those frequencies are 
changed that reach values beyond the threshold setting. This makes the increasing or cutting of 
overtones easier.

Draw Settings: Additional settings for the way the curves are displayed are available with this section.

Draw Grid: The Grid can be turned off or on.
Curve Numbers: You can select how many curves are to be displayed in the graphic display.

Dynamic Filter Mode: Three separate modes are available for the dynamic filtering process.

Direct: Simple morphing between two curves is performed.
Circle/Direct: Morphing is done between the two curves and the start curve is moved to the side (toward 
higher or lower frequencies). If you have selected a band pass filter as the start curve the middle 
frequencies are changed in time (filter sweep).
The highest value of the start and end curves are determined and a range is set in which the sweep is 
performed. (If you are working in the Filter edit mode you will first need to edit the red curve. If the 
complete filter curve is at 0 dB no highest value is available for calculation.)
Circle: The first filter curve is moved in this mode. The highest and lowest values of the start and end 
curves determine again the range in which the sweep is taking place. The second curve is only used to 
determine the end point of the sweep! Otherwise it will have no influence on the final result.

A tip: You may want to use a broad band or noise signal to experiment with the different settings for the 
dynamic filter mode. This will quickly assist with an understanding how the filter works.

Resolution: This parameter equally affects the analyzing and filtering processes. It determines how many
individual analyze frequencies or filter bands are available when calculating the curves. The number of 
analytical frequencies equals half of the Resolution value.
The processing time increases with higher resolution values. Every step increases it by approximately 
5%. 

Here are some hints to selecting the proper values.

Frequency Analysis:
To reach accuracy in the lower frequency ranges a higher resolution is needed (starting with 8192). The 
accuracy of the analysis in Hz at a sample rate of 44.1 kHz is listed in the table below:

 
Resolution Accuracy in Hz Resolution Accuracy in Hz
256 172 4096 10,7
512 86 8192 5,3
1024 43 16384 2,7
2048 21,5 32768 1,35

Filtering:
High resolutions (8192) are only needed for low frequency ranges or specific fading of overtones. All other

applications can use values of 1024 or 2048. Values below 1024 almost never yield useful results.

Two important suggestions:



· If you have drawn very detailed filter curves it is imperative to save the parameters of the curves! 
When switching modes or parameters the curves are closely matched but will not maintain the same 
details.

· When previewing the filter settings and working with high resolutions in realtime, please make sure 
that the Real Time buffer setting (File->Preferences->System) is the same or slightly higher than the 
setting for the Resolution in the Advanced Setting dialog of the FFT Analyzer.                                                 
Otherweise the realtime previewing is not possible.                                                                                                     
Setting the resolution to a higher value than 8192 will not be recommended for realtime previewing, 
because the internal realtime buffer size of the algorithm is the same as the setting for the resolution. 
While editing the curve with an active real time preview the editing would sound choppy in that case.

Save Setup, Load Setup: These two buttons can be used to save and load all the parameter settings 
and curve outlines. The default extension for this type of file is *.fff.
Important: If you want to use the same filter settings for other audio material you will need to make sure 
that the Edit Mode is turned to the setting Filter. Only this setting saves the red curve. This is the case 
even if the filtering is done indirect through editing of the blue curve in the edit mode Direct/Match!

If you are saving the settings when the mode Direct/Match is selected, the saved frequency response can
be transferred to other audio material. In this case the blue curve is changed into the red curve while 
loading.



Problems and Solutions regarding the FFT Filter Spectrum Analyzer (FFT Analysefilter)

· Slight tremolo or rough sounding audio, delay effects:
This can happen when the setting Test1 is selected in the Precision section of the Advanced Settings 
dialog. Use a different setting for the precision.

· Modulation effects with extreme filter settings for low frequency ranges:
This is also caused by the setting Test1 in the Precision section of the Advanced Settings dialog. 
Selecting a different setting may solve this problem.

· Problems with the real time preview when using higher resolutions:
Make sure that the Real Time buffer setting in File->Preferences->System is either the same or higher
than that of the Resolution setting in the Advanced Setting dialog of the FFT Filter.

· You are unable to completely eliminate specific ranges of a spectrum:
Make sure you are using the edit mode Filter and reduce the setting for dB Min (in Settings) to a value
between 100 to 120 dB.

· Differences between filtering and analysis (If the filter processing was done and the frequency 
response of the edited audio range was analyzed for a second time. A new analytical process does 
not coincide with the corrected frequency response (the blue curve) before the processing. Why not ?:
The responses will be be closely coincide if the option Analyze All and the setting Analyze Precision 
High are used before the filtering process and for the new analyze.

· Unexpected resonance like artifacts are introduced also when filtering with with broadband 
bandpasses:
Reduce the angle of the curves by omitting vertical lines when drawing the curves.

· The morphing results for the dynamic filtering are not even when using the filter mode Dynamic Start 
or End:
Use the highest setting for the Filter Precision.
The dynamic filter mode Direct reduces this problem when using smaller Resolution values. You may 
have to experiment with different settings for the other dynamic filter modes.



Room Simulator (Menu Effects)

This function allows you to simulate reverb patterns of various room types. The impulse response of a 
room is applied to audio material when using this option.
A room impulse response is the sound that is received when a shockwave type sound, such as a gun 
shoot, is released into the room. The response from the shockwave contains needed information to 
recreate the exact consistency and reverb nature of the room.
Samplitude allows you to manipulate the impulse response with the parameters in the Room Simulation 
dialog. This allows you comfortable editing of reverb characteristics in the same way conventional digital 
effects units enable changes with parameters. You also have the option to choose from various impulse 
patterns. Some are located in the rap directory. The rap directory is a child directory of the working 
directory from Samplitude.
The graphic display offers a representation of the envelope and the fade-in and fade-out parameters and 
allows you to preview the changed settings of the room simulation.

Impulse Response This allows you to select the impulse response pattern. The first five entries are pre-
defined response patterns an will be loaded automatically. They are located in the rap directory. This is 
only the case if you have selected the response patterns while the installation of Samplitude.

The list will also display RAM or HDP projects that are currently opened as data windows. If you want to 
include a specific impulse response not listed in the default directory, make sure it is opened before you 
call up the room simulator dialog. 
Please note: If the sample or data window does not contain an impulse response no reverb effect will be 
added!
A hint: Its possible to change the pre-defined impulse response patterns and also the number of them.
You must know for this that Samplitude tries to open all RAM-Projects, which have a name like rev_n.rap. 
They must be located in the rap directory. N is a number between 1 and 50. (The rap directory is a child 
directory of the working directory from Samplitude).

Play
The selected impulse response pattern is played back.

Impulse Response Envelope
Early Reflect.
This parameter allows you to set the amount of the early reflection. It uses the first 5% of the impulse 
response, which can be raised or lowered.
Late Reverb
The later reverb portions can be amplified or decreased. This parameter uses the remaining 95% of the 
impulse response.
Length %
This setting will shorten the length of the reverb effect to up to 5% of the original length by shortening the 
impulse response pattern. Please keep in mind that the reverb can end rather abrupt, which may lead to 
unnatural decay patterns. You can compensate by applying a lower Late Reverb setting to fade the 
impulse response. The graphic display will assist you in allowing a quick optical check of the envelope.
Spectral Edit
High Freq.
This setting allows dampening of high frequency portions of the reverb effect.
Low Freq.
This setting dampens low frequencies of the reverb effect.
Mix
Original %
This setting allows you to determine the amount of original signal that is to be mixed with the reverb 
signal. A setting of 0% will only contain the reverb signal. At 50% both signals are present with the same 
volume and amplitude amount.
Reverb dB
The setting determines the overall amplitude of the reverb effect in dB.



Load Setup
This allows you to load previously saved settings. Please make sure that the exact same impulse 
response pattern is selected that was used when the settings were saved.
Save Setup
All settings can be saved with this option.
Create Copy
When checking this box Samplitude will create a copy of the marked range into the same audio file as the
original material. This can be done to compare the results with the original material. Please consider the 
length of the marked range and the available hard disk space or RAM memory! It must be activated for 
working with the Undo-Function in virtual projects.

Preview
Allows you to preview the settings.
Play Original
Plays the original audio material without applying any of the current settings.

Presets
A hint: If the presets will cause really well sounding results depends naturally from the selected impulse 
response pattern. But they are in all cases useful as initial position for searching to good parameter 
settings.
Long
This preset creates a long reverb effect.
Medium
This preset creates a reverb effect of medium length.
Short
This preset creates a short reverb effect.
Effect
This preset sets the volume of the original material to 0 and creates a rather strong sounding effect.
Original
This setting will not alter the impulse response pattern, allowing you to apply the exact same room effect 
of the room the response pattern was recorded in. Use this option if you would like to achieve the same 
room setting with your audio material.
Draw Mode
dB lin
The graphic display will follow the usual sample display based on the linear amplitude scaling applied to 
the graphic.
dB log
The scaling of the amplitude display follows a logarithmic pattern. This coincides with the way the human 
ear perceives volume changes.
A few tips for using the Room Simulator
The Room Simulator can be used to recreate the characteristics of a multitude of room reverbs. By editing
the impulse response pattern itself a number of different effects can be achieved. Here are a few 
suggestions:
* Use the function Revert on the impulse response to create a reverse reverb.
* The equalizers can be used to create severe frequency responses in the impulse response material and
subsequently in the audio altered with the Room Simulator.
* By using the Time Stretching function the size of the room can be altered without affecting the 
resonance behavior of the room itself.
* Use the Draw Wave function in the HDP / RAP Mouse Mode dialog to remove early reflections of the 
room or add others to it.
You may want to experiment with short samples of your own audio material by creating a fade-out in the 
sample. You can use the sample as the impulse response! Interesting and sometimes amazing effects 
can be created this way!

Troubleshooting the Room Simulator
The program seems to not respond after the Preview or OK buttons were clicked:



On slower systems and long impulse responses it can happen that the status display takes longer to 
display the progress of the calculation. Since the algorithm works in sections the display may not be 
updated immediately or in quick increments.
The output signal seems to be distorted:
Reduce the setting for Reverb in the Mix section of the dialog.
The results of the effect are not what I would expect from a reverb like effect:
Check to see whether the selected impulse response pattern contains a valid signal by playing back the 
pattern with the Play button next to the name of the file.
An error message appears indicating that the response pattern is too long:
The algorithm can only process patterns that are up to 524286 samples in length. Shorten the pattern 
material and use the Late Reverb to fade out the cut end of the sample.
The reverb ends unnaturally harsh:
The parameter Late Reverb can be used to fade out the impulse response to a zero value. Use the 
graphic display to test the parameters effect on the response. Especially when using the dB log setting for
the display the response can be monitored to see whether the amplitude effectively fades to a zero value.
Resulting file has a large DC offset:
The impuls response must not contain a DC offset. Please remove it using the menu Effects > Remove 
DC Offset!
Heavy hard disk activity or an error message concerning insufficient memory was received:
The algorithm needs an immense amount of storage, especially with long impulse response patterns. All 
background processes should be terminated and all RAM projects that are not needed should be closed.



 Resample / Timestretching (Menu Effects)

Important: If you want to change the sample rate of a whole audio file (e.g. from 48 KHz to 44.1 KHz) 
please use the separate function Change Sample Rate in the Effects menu!

All algorithms in this dialog only use the parameter factor (upper left edit control) to set the amount of 
effect. All the other input fields in the parameter group simply control this factor. This makes it easy to 
specify the factor by typing in the new length, pitch or tempo in bpm. Press Refresh Display to calculate 
the actual factor if needed!

The following algorithms can be used:
Resampling: When using a factor lower than 1.0 the material becomes faster and higher. This is very 
similar to an analog tape deck which runs at a higher or lower speed. Also samplers and pcm-
synthesizers use this type of algorithm for transposing the samples or waveforms. Use this mode to 
correct the pitch and speed of any audio material which may change ist length.

Pitch Shifting
The pitch of the sample is changed, maintaining the length. Use this mode to transpose an audio object 
without changing the length. 
Time Stretching
The length of the sample is changed, maintaining the pitch. Use this mode for example to change the 
tempo of a drum loop without changing the pitch.

Time Stretching and Pitch Shifting are no lossless procedures - depending on the factor there can occur 
short delays or other artifacts in the sample. To minimize these artifacts you have the choice between 2 
internal algorithms:
Non Smooth / Fast: Use this mode for factors in the range of 0.9...1.1. This algorithm keeps the original 
phase even of stereo material, but it produces more artifatcs when using with large factors.
With the parameter Range you can adjust the range length which is used for creating crossfades. This 
helps you matching the algorithm to the audio material.
Normally a range length of 1000 samples gives best results, but you can increase it to get a smoother 
result. 

Smooth: This mode uses a much more complex algorithm which needs more calculating time. But it 
gives in most cases better results when using large factors. The phase of the material is changed to get a 
smoother sound. If you are for example dealing with speaking or singing voices or orchestral instruments 
this would be no problem.The strength of this smoothness can be controled by the parameter Strenght 
Smoothness in 5 steps.



Change Sample Rate (Menu Effects)

Use this function to change the sample rate of a whole audio file. This may be needed to convert a DAT 
recording at 48 KHz to 44.1 KHz for use on an audio CD.
After choosing the new sample rate you can select a filename for the new project.

Please know, that resampling to 44.1 KHz also can be done while recording in realtime.
The playback parameter windows (key p) contains a Varispeed option for realtime resampling while 
playback - so often the sample rate convertion can be done in realtime!



Declipping (Menu Effects)

This dialog can be used to reduce or eliminated the clipping in certain audio material.

· Distorted Sample Threshold: The number of samples is specified at which the algorithm is 
supposed to start correcting the distortion. Normal values are ranging from 2 to 5 samples.
· Distorted Sample Volume Threshold: The volume level can be specified at which the algorithm 
is to analyze and correct the audio material. This is important, since various sound cards display different 
clipping behavior. Some DAT recorders contain an analog safety circuit to prevent levels from reaching 
their maximum. Often a value of 0.5 dB or less is needed in these cases.
By entering a value of e.g. -6 dB all samples above 50% of the maximum level possible will be considered
distorted and re-calculated. Analog material that reaches distortion levels can be cleaned up this way.
· Get Level from marked Range Height: This option allows you to adjust the de-clipping level 
based on the height of the marked range. This is useful if a distorted part has been previously marked 
precisely and is to be corrected now.
· Number of continued samples after Clipping: This value determines how many samples the 
algorithm uses after the distortion occurrence. Important are the number of constantly increasing or 
decreasing sample information values.
This is helpful with sound cards (such as the Soundblaster) that report chaotic sample information in 
distortion ranges. Many times the end of the distortion range can then only be recognized if the value is 
increased by a setting of 5 to 10.
A clean distortion peak only requires a value of 1.
· Set Maximum Level to 0 dB: The material can be normalized to 0 dB (100%) after the de-
clipping process. This is recommended if you work with 16-bit material, since there would be no volume 
reserve available for the distortion correction. When working with floating point material this option can be 
disregarded, since the floating point format has an unlimited dynamics range available. 
This way, the material can be manually adjusted to the desired output level.



Noise Reduction  (Menu Effects)

The Noise Reduction function can be used to effectively remove annoying noise material from the audio 
with very little or almost no discoloration of the original audio. For this function the algorithm needs an 
example of the noise print that needs to be removed. This function works best with types of noises such 
as a constant occurrence of a ground loop, air conditioner, hum, tape hiss or feedback. Please note that 
this algorithm was not necessarily developed to remove pops and clicks from audio material. However, a 
typical click noise floor such as vinyl recordings can still be fairly successfully treaded with this function.

Here is an outline of using this function:

1. Mark a range in the audio material or select in a VIP object that contains only the noise print.
2. Copy the range to a special clipboard with Effects->Get Noise Sample. Especially for noisy material 

such as tape hiss the rule of thumb works best: The longer the Noise Sample material the better the 
algorithm will work!

3. Next, mark the section in the data window or select the VIP object that needs the noise signal 
removed.

4. Open the dialog Noise Reduction in the Effect menu.
5. In the Noise Sample box select the NoiseSample setting, since this project contains the noise print.
6. Make all desired changes in the dialog or load a preset and click on OK to process the sample.
7. You also may wish to preview the changes before committing them to the audio material by clicking 

on the Preview button.
If you are satisfied with the changes you may click on OK to commit them to the audio material. You 
may also refer to the section on Noise Reduction: Tips and Trick for information on finding the best 
settings in this dialog.

A list of the parameters:

Noise Sample:
This selects the project that contains the noise material or print. This has to be open as a project in 
Samplitude before it can be selected here (see above).

Resolution:
The internal resolution of the algorithm can be selected in three levels. Higher resolution settings need 
more processing time. It is important to experiment with these settings since a higher resolution does not 
always yield better results! For material such as the spoken voice or short beats best results are achieved
with small resolution settings.

Precision and Precision Real Time:
The precision of the algorithm can be chosen from three levels. The higher the settings in this dialog the 
longer the processing time to calculate the effect. However, this also leads to a slightly enhanced result. If
you are working with different settings for the Precision section than for the Precision Real Time section 
the results during the real time previewing of the audio will differ from the final results when pressing the 
OK button. For the real time previewing you may want to select less demanding settings in the Precision 
Real Time to not overload the computer system with the real time calculation.
If you are uncertain as to the final results it may help to listen to an example of the final results with the 
regular non realtime Preview function.
The setting Test can cause a small amount of tremolo or a certain roughness in the audio playback. 
Additional may appear very small delay effects. This setting should be only used for previewing!

Absorption:
The settings low, medium and high will determine the effectiveness of the algorithm. The additional fader 
allows for fine-tuning of the setting, which always operates in the selected setting range. This parameter 
sets the level of the noise print sample absorption or amplifying. This is visible in the graphic display. The 
yellow curve is the original spectrum of the noise print sample and the blue curve, the corrected spectrum,



which is internally used to remove the noise from the audio.
Small settings can lead to incomplete removal of the noise material or can cause an increase in artifacts. 
High settings may lead to discoloration of the original material, which is audible in a phase like 
transformation or high-pitch modulations. These effects are largely dependent on the type of noise and 
are also influenced by the texture of the original material. A higher level of noise does not necessarily 
warrant a higher correction setting!

Mix:
This setting allows you to add portions of the original material that contains the noise print back to the 
noise free material. With very high settings the noise audio is mixed back into the final results.
Why would this make any sense, since the goal is to remove the noise and not mix it back into the 
resulting audio?
It may be advantageous to keep a portion of the noise print in the audio. An example would be that of 
vinyl records which have a particular feeling to them. Another example would be an interview with 
background noise. It is not always desirable to completely remove the background noise. Also, if the noise
signal is not completely reduced artifacts may not be audible.

Artifact Suppression Parameters:
This setting helps to suppress artifacts occurrences which can often show up with high volume medium 
bandwidth noise signals. If you always select high settings in the dialog the quality of the end result may 
actually be worsened. You should therefore select settings that just get by without introducing artifacts.

Attack: The amount of attack for the noise reduction function is set with this parameter. A higher value will
effectively reduce the amount of artifacts. However, the response time of the audio material can be 
slightly impacted. In the case of a voice-over or a vocal piece for example the results may not be as good 
with a high attack setting as for example orchestral instruments. For this same reason the attack method 
(high values) may be better suited to reduce artifacts for musical tracks.
Release: When dealing with sounds such as those of percussion instruments or late reflections in audio 
material, this parameter can help to prevent a high amount of suppression of the fade out phase of the 
sound. High values for this parameter will usually accomplish this. However, it is also possible that the 
artifacts are increased. It may make sense to find an acceptable average setting.
Static Smoothing: The corrected spectrum of the noise signal is leveled. The internal algorithm to reduce
the noise level uses this corrected signal. This is shown by the blue curve in the graphic display.
By using this method the artifacts are reduced. High values of this parameter will yield good results for 
voice-overs or vocal tracks. However, the same high settings may cause a certain roughness in musical 
recordings, especially pitched orchester instruments.

Save Setup, Load Setup: All configured settings in the dialog can be saved with this option. The default 
extension for this type of file is *.nrd.
Test Mono: This is a real time preview option for mono samples or stereo samples that are played back 
in mono. This will require at least a Pentium 120 CPU. If the preview cannot be turned off by pressing the 
'Test' button again (due to overload of the computer) press the spacebar to stop the audio playback. If you
want to close the dialogbox with Cancel, the audio playback has to be stopped before!.

(Test) Left: Real time preview for the left channel of a stereo sample or mono samples. (Using real stereo
previewing would require more processing power than is available for the most common computer 
systems.)
(Test) Right: Real time preview for the right channel of a stereo sample or mono samples.
Preview: This is the non-real time preview function. This option is fully capable of producing results in a 
true stereo spectrum. The reproduced audio represents the material after the changes are committed to 
the audio file.
Play Orig.: This will playback the original audio material for comparison.
Help: The help dialog is displayed.
OK: The audio material is processed with the configured settings in the Noise Reduction dialog.



Cancel: The dialog is closed without making changes to the audio material.

About the presets:
The type of noise signal and audio material that is to be treated can be selected with presets. The 
parameters in the dialog are set accordingly. Especially in difficult case the results may not necessarily be
acceptable right from the start. However, the presets can be a great place to start when looking for that 
perfect setting to remove noise from your material.

The graphics display and its elements:
The graphic display shows the original spectrum of the noise signal in a yellow curve. The corrected 
spectrum, which is used by the internal algorithm for the noise reduction, is shown in a blue curve. The 
left side numbers show the level in dB. The top numbers show the frequency in Hz.
The level of the corrected spectrum is set by the parameter Correction; the curve is additionally corrected 
by the setting Static Smoothing.
Display Mode: The display can be switched between showing curves or lines.
Freq. Lin/Log: The frequency scaling is switched from logarithmic to a linear method.
dB Lin/Log: The level scaling is switched from logarithmic to a linear method.

About Artifacts:

When attempting to remove noise signals from material in which the noise volume reaches or exceeds 
the volume of the actual audio a metallic sounding signal can be introduced. This is called an artifact 
signal. Its amplitude often is much lower than the original noise signal, most often around 20 dB. 
However, because of its synthetic nature the human ear is very sensitive to this sound. This problem 
usually only occurs in very difficult cases. To remove artifacts highly optimized options are available. All 
parameters in the Artifact Suppression Parameters section can be used for this purpose.

Noise Reduction: Tips and Tricks

· To look for the best settings please follow the steps below:

1. Select a preset by matching a default setting with the type of audio material that needs correction 
and the type of noise. Otherwise follow the next steps.

2. Experiment with a good setting for the Correction parameter.
The noise signal should not be audible anymore. Possible artifacts should not necessarily be 
suppressed by a high value in the Correction field. The audio could end up sounding very dull.

3. To reduce possible artifacts increase the value for Attack and/or Static Smoothing. The selected 
method depends on the audio material that needs treatment.

4. Slightly reduce the value for Correction at this point. The artifacts my increase, which can be 
compensated by increasing the values for Attack and/or Static Smoothing. The results can often 
be vastly improved with this method.

5. If you are using the setting Precision: High the resulting audio may further improve. Please note 
that the processing time and the load on the CPU also increase.

· If the original audio material or noise signal contain a constant pattern (such as DC offset) we 
recommend removing it with Effects->Remove DC Offset prior to using the noise reduction function.

· Discoloration of the original audio material can be reduced by repeated use of the noise reduction 
algorithm. A low absorption level (Correction) should be chosen. Once the first attempt has been 
executed the remaining noise signal in very low volume sections should be used as the noise print for
the next attempt.

· High level broadband noise can be difficult to remove. It is therefore suggested to treat the material 
prior to using the noise reduction with a filter. The Equalizer can be used to cut frequencies that are 
not used by the original audio. For a female voice for example all frequencies below 200 Hz and 
above 8000 Hz can be safely reduced. For instruments everything below the lowest not played can be



reduced. If for example the lowest note played is an A=440Hz then everything below 440 Hz can be 
cut. The FFT Spectrum Analyze Filter (Effects->Draw Filter/Spectrum) is best suited for this task.

· In difficult cases that make it almost impossible to produce an acceptable end result it is always 
possible to simply just correct the noise signal. A higher value for Mix may help.

· Whether artifacts are audible depends in large part on the volume of the end result and the frequency 
response of the playback. If you know where the audio is reproduced (movie theatre, TV, radio, etc.) it
may help to prepare the audio in similar conditions.

· For sound designers: The algorithm can be used to achieve interesting discoloration of the original 
material, especially if the Noise Sample contains other material than that of noise signals!

Problems and Solutions

· Processing results in silence:
This most likely happened because the noise sample contained the original audio material by 
mistake.

· Strong discoloration and flanging:
The noise sample may contain sections from the actual audio material or is different sample material.

· A slight tremolo, delay or a certain roughness was introduced to the material:
This can be produced by the setting Test in the Precision parameter. When finally committing the 
changes to the audio material this setting should not be used!

· Metallic like artifacts:
Please read the suggestions in the section About Artifacts and Noise Reduction Tips and Tricks from 
more information on how to deal with this problem.

· Problems with the real time preview when using high settings:
Care should be taken that the real time buffer (File->Preferences->System) is set to 8192 bytes! (The 
next higher setting of 16384 bytes may slightly improve the performance. However, editing during real
time preview playback may produce slight interruptions.)



Remove DC offset (Menu Effects)

This function in menu "Effects" removes a DC offset in the marked range of a physical 
project (RAP or
HDP). Some sound cards produce such a DC offset while recording, so it is useful, if you can 
remove
it!



Convolution (Menu Effects)

With this function it is possible to convolve a sample with another sample.
This means, that the original sample will in a special way filtered with the convolution sample. Common 
overtones will be amplified, different overtones will be dumped in their amplitude.

This performs nifty reverb, delay, filter or morph-effects between the two samples.

Convolution Sample
Specify the desired convolution sample here. Please note that you will need to load the data window into 
Samplitude prior to selecting it from this list. Only patterns (audio files) that are loaded will be listed.
When using files longer than 1048576 samples only the first 1048576 samples will be used.

Result (dB)
You can increase or decrease the volume of the result.

Original %
You can specify a percentage of the original signal that is to be mixed with the convolution signal. Various 
effect to original audio relationships can be achieved with this parameter. 



Set Zero (Menu Effects)
Sample data values in a marked range are set to zero (no data). Noise and imperfections in a sample can
thus be eliminated.



Invert Phase (Menu Effects)
The sample data within the marked range is inverted along the amplitude axis. This phase inversion 
means that negative values become positive and vice versa. This function, too, is reversible.

The Invert function permits samples with different phases to be matched.

Along with the available mixing functions (which are, from a mathematical viewpoint, adding functions) 
you can actually subtract samples by applying this function to the selected sample.



Revert (Menu Effects)
The sample data in the marked range is reversed along the time axis. The playback of the sample data 
happens from the end to the beginning. This allows for very interesting effects, not to mention the hidden 
messages frequently referred to in various songs.

This function is reversible: if you do not mark a new range, calling this function once more leads to the 
original material.



Switch Channels (Menu Effects)

With this function you can switch left and right stereo channel. This is useful to correct 
recordings with switched channels.



 Echo (Menu Effects)
Samplitude allows you to apply an echo effect to the marked range in the data window. The graphic 
display in the dialog can be used to give you an idea at what time frame the first delay signal appears.
Echo Delay
This section will determine the length of the echo delay.
BPM
You can specify a particular BPM speed if the echo needs to run in sync with the audio material. For 
example, if a music piece is set at 110 BPM you could specify the same setting here and have the delay 
appear with the exact beats of the music.
Millisec
Specify a setting in milliseconds for the delay.
1000 ms
This will select a preset of 1000 ms for the delay.
500 ms
This will select a preset of 500 ms for the delay.
200 ms
This will select a preset of 200 ms for the delay.
Echo Decay in %
This parameter specifies the volume decrease between the single echo events in percent. A value close 
to 100% results in a slower echo delay. Values below 40% lead to rapid decay.
95 %
This will select a preset of 95%.
80 %
This will select a preset of 80%.
50 %
This will select a preset of 50%.
Echo Mode
The Echo Mode setting will determine the type of delay you would like to apply. The graphic display will 
give you an idea of the echo events with the individual modes.
1 Delay (only in mixer mode)
Only one delay will occur in the audio material.
Feedback
The echo events are repeated in the interval specified in the Echo Delay settings. The Echo Decay is 
applied to the repeated events and depending on the settings there the events occur with a percentage of
the previous event.
Multi Tap (only in mixer mode)
The Multi Tap delay applies a particular algorithm that repeats portions of the delay event between the 
major delay events determined by the Echo Delay settings. This allows for a variety of delay events that 
are repeated and seem to be building up while the decay applies a fading of earlier events.
Track Delay (only in mixer mode)
This mode delays the whole track, what can be useful to correct audio delays in large rooms or other 
purposes.

Load Setup
This allows you to load previously saved settings. Please make sure that the exact same impulse 
response pattern is selected that was used when the settings were saved.
Save Setup
All settings can be saved with this option.



Build Loop (Menu Effects)

This function utilizes a complex algorithm for optimizing loops in physical projects. It is useful when 
samples are to be used for instrumental sounds as well as wave table synthesizer.

Before you can process a sample you need to mark a range in your sample that already defines the rough
edges of the sample loop. Remember that you can shift and vary a range during playback to find the best 
loop position. A comfortable way to look at the loop positions is by activating the split range mode by 
pressing b. The sample will be displayed in 3 sections.

To gain an interruption-free loop the outer limits of the range will be set to zero. By applying a crossfade to
the material at the loop end containing the sample data in front of the loop beginning, Samplitude will 
create a smooth transition between loop end and loop beginning.

When a cursor is set in front of the marked range, the range between the cursor and the beginning of the 
loop will be used for the crossfade. This offers you a feature found in professional hardware samplers. To 
achieve a short crossfade set the cursor close to the loop beginning. To receive a long crossfade position 
the cursor further away from the loop beginning.

Notice that the distance between cursor and beginning of the loop range needs to be smaller than the 
loop range itself to make a crossfade possible.

Shortcuts:
Toolbar:



Generator (Menu Effects)

This dialog contains a powerful generator of several test tones. Please be shure to have activated a 
physical project (HDP or RAP) before opening this dialog!
The generated waveform is stored in the Clipboard, so it can be easily included into other projects.
You can adjust type, frequency and length in samples of the created waveform.

The following types can be selected:
Square, pulse, triangle, sine, saw up, saw down and white noise.



Menu Range
Samplitude offers a convenient way of working with ranges. The Range menu will let you use these 
options. 

Range all The range will cover the complete sample.
Cursor to beginning Sets the cursor to the beginning of the project.
Cursor to end Sets the cursor to the end of the project.
Cursor to beginning of range Sets the cursor to the beginning of the marked 

range.
Cursor to end of range Sets the cursor to the end of the marked range.
Range to beginning The beginning of the range will be extended toward to the 

beginning of the project.
Range to end The end of the range will be extended toward the end of 

the project.
Flip Range left The current range is shifted left. 
Flip Range right The current range is shifted right. 
Beginning of Range -> 0 Shifts the beginning of a range right to next zero 

position.
Beginning of Range <- 0 Shifts the beginning of a range left to next zero 

position.
End of Range -> 0 Shifts the end of a range right to next zero 

position.
End of Range <- 0 Shifts the end of a range left to next zero position.
Range Length to Sets the range length to 1...16 beats.
Split Range Splits current range in 3 views for better loop 

search.
Split Range for Video Splits current range in 3 views, zoomed down to 1 

frame.
Store Range Stores current on a function key.
Get Range Recall range from function key.
Get Range Length Recall the length of a range from function key.
Store Cursor Stores current cursor on a number key.
Store Realtime Cursor Stores current cursor on a number key while 

playback.
Get Cursor Recall cursor from a number key.
Set Cursors on Range Borders Sets 2 cursors to start and end of the range.
Set Cursors on Silence Sets cursor to silent positions in the sample.
Get last Range Recalls the last range.
Range Editor Edit range borders numerically.
Object Lasso Select several objects with a lasso.

Range all (Menu Range)

The range will cover the complete sample. This command comes in handy if you want to apply changes 
to the entire sample with functions that normally only address certain ranges.

Shortcuts:

Toolbar:
Keys: a



Cursor to beginning (Menu Range)

Both the beginning and the end of a range are located at the current cursor position.

Shortcuts:

Toolbar:
Keys: Home



Cursor to range end (Menu Range)

Sets the cursor to the beginning of the actual marked range.

Shortcuts:

Keys: Alt + cursor left



Cursor to range beginning (Menu Range)

Sets the cursor to the beginning of the actual marked range.

Shortcuts:

Keys: Alt + cursor right



Cursor to end (Menu Range)

The beginning and end of the range are positioned at the end of the sample.

Shortcuts:

Toolbar:
Keys: End



Range to beginning (Menu Range)

The beginning of the range will be extended toward to the beginning of the project.

Shortcuts:
Keys: SHIFT + Home



Range to end (Menu Range)

The end of the range will be extended toward the end of the project.

Shortcuts:
Keys: SHIFT + End



Range length to Beat 1...16 (Menu Range)

Sets the range length to 1...16 beats. Set the tempo in bpm with menu Range > Snap to... (definitions).



Flip Range left (Menu Range)

The current range is shifted left by the length of the range. Its end will be its former beginning. If there is 
not enough room to place the range, the command will not be executed.

Shortcuts:
Keys: CTRL + SHIFT + left



Flip Range right (Menu Range)

The current range is shifted right by the length of the range. Its beginning will be its former end. Keep in 
mind that if there is not enough room to place the range, the command will not be executed.

Shortcuts:
Keys: CTRL + SHIFT +right



Split Range (Menu Range)

This function is in particular useful for working with loops. If not already displaying in Split Range Mode 
the project is first switched to this mode displaying three sections on the screen.

The upper section displays the whole sample. The section located at the bottom left displays the data 
near the beginning of the range. The section at the bottom right displays the data near the end of the 
range.

The boundaries of the range can be exactly positioned in the lower sections, while the upper section will 
display the location of the entire range. You can also define ranges across several sections.

Shortcuts:
Keys: b
off Shift + b



Split Range for Video (Menu Range)

This function is in particular useful for working with AVI Videos. 

The upper section displays the whole sample. The section located at the bottom left displays the data 
near the beginning of the range. The section at the bottom right displays the data near the end of the 
range.

Both lower sections are zoomed down to a single frame accuracy.

The boundaries of the range can be exactly positioned in the lower sections, while the upper section will 
display the location of the entire range. You can also define ranges across several sections.



Store Range (Menu Range)

Another powerful feature of Samplitude is the option of defining and saving different ranges for future 
retrieval. An unlimited number of ranges can be defined. You can for example specify different loops and 
compare them while you recall their ranges. 

All ranges of a project can be seen in menu tools > range manager. There all ranges can be renamed or 
played.

If you select this menu item, you have to specify a number with which the current range is to be defined.

Shortcuts:
Keys: SHIFT + F2 ... F10

You can define more ranges by using the submenu Other. You will need to specify a name for the range 
selected.

Shortcuts:
Keys: SHIFT + F11



Get Range (Menu Range)

By selecting this option you can choose one of the defined ranges as the current range.

Samplitude even lets you choose a range while playing. The specified range becomes the current one 
and is audible. Using this method you can change between two ranges comparing them with each other.

Shortcuts:
Keys: F2 ... F10



Get Range Length(Menu Range)

By selecting this option you can choose the length of one of the defined ranges as the current range.

Samplitude even lets you choose a range length while playing. The specified range becomes the current 
one and is audible. Using this method you can change between two range length comparing them with 
each other.

Shortcuts:
Keys: Shift + Ctrl + F2 ... F10



Store Cursor (Menu Range)

You can save as many cursor positions as needed. Using this option you can create markers (locator 
points) along the sample for easy retrieval.

Shortcuts:
Keys: SHIFT + 1 ... 0

Using the submenu Other, you can define more cursors with a desired name.

Defined cursors can be seen    above the sample data section of the project window and can be moved 
with the mouse.

Shortcuts:
Keys: SHIFT + [



Store Realtime Cursor (Menu Range)

With this function (Alt + number key) cursors can be stored during playback. A specific position in the 
material can this way be set for later processing.

Shortcuts:
Keys: ALT + 1 ... 0



Get Cursor (Menu Range)

By selecting this menu option you can easily locate cursor points. Simply specify the desired cursor 
location and Samplitude will position the cursor at that location.

You can even select a new cursor location while playing the sample. 

You should keep in mind that, whenever a cursor has been defined, the range between the cursor and the
end of the sample is played.

Shortcuts:
Keys: 1 ... 0



Set Cursors on Range Borders (Menu Range)

This function sets two cursors to the beginning (S) and the end (E) of a marked range.



Set Cursors on Silence (Menu Range)

This function sets cursors on silent regions in the sample (only in physical projects - HDP or RAP).

You can choose the minimal length of the pause, a threshold level, the start number and a prefix for the 
cursor name.

This is very useful to mark the regions of sample CDs etc...



Beginning of Range -> 0 (Menu Range)

This function shifts the beginning of range to the right of the next zero position.

The function can be called from the keyboard by pressing the left Shift + Alt keys and 6 on the numeric 
keypad at the same time. You can also press the PgUp key.

Shortcuts:
Keys: PageUp



Beginning of Range <- 0 (Menu Range)

This function shifts the beginning of the range to the left of the next zero position.

The function can be called from the keyboard by pressing of the left Shift + Alt keys and 4 on the numeric 
keypad. You can also press the PgDn key.

Shortcuts:
Keys: SHIFT + PageUp



End of Range -> 0 (Menu Range)

This function shifts the end of the range to the right of the next zero position (change in polarity). Zero 
position is the next sample value with zero value or the boundary between a positive and a negative 
sample value (or vice versa).

This is particular useful for searching for loop points.

The function can be called from the keyboard by pressing the right Shift + Alt keys and 6 on the numeric 
keypad or the PgDn keys.

Shortcuts:
Keys: PageDown



End of Range <- 0 (Menu Range)

This function shifts the end of the range to the left of the next zero position.

The function can be called from the keyboard by simultaneously pressing the right Shift + Alt keys and 4 
on the numeric keypad or by pressing the Shift + PgDn keys.

Shortcuts:
Keys: SHIFT + PageDown



Range Borders to Zero Crossing (Menu Range)

This function shifts the beginning of the range to the next zero psotiion and the end of the range to the left
of the next zero position.



Get last Range (Menu Range)
This function restores the last range that was marked. It comes in handy when a range was mistakenly 
deleted by a mouse click.



Range Editor (Menu Range)
The beginning, the end and length of a marked range can be numerically changed in different units of 
measurement. This function will let you specify the minute details of a particular range you need to set.

If you change any of the values in the Range Start, Range Length or Range End sections, all other values
will automatically be updated with the exceptions below:

Change values in the Range Start section:
The end will be maintained.

Change values in the Range End section:
The start will be maintained.

Change values in the Range Length section:
The start will be maintained.

    
Please note the format of the Bar dialog box. The format is displayed as Bar:Quarter:Clicks. Thus a 4/4 
bar with 96 clicks could look like this:

014:03:024

The number of quarters per minute (BPM) can be set in the BPM dialog box of the Raster Definition 
window. 



Object Lasso (Menu Range)

With this function a special mode for the object lasso can be activated:    

The lasso function can also be started direct in an object rather than having to start between two objects. 
This is useful if there is no empty room between objects to start the lasso function.



Menu Tools

Track Bouncing Converts a VIP to a HDP or Wave file.
Remove unused Samples Delete all unused ranges in physical projects.
Range Manager... The window of the range manager is opend.
Cursor Manager... The window of the cursor manager is opend.
Object Manager Opens the Object Manager.
CD Submenu
Set Track Set a track marker.
Set SubIndex Set a subindex marker.
Set Pause Set a pause marker.
Set Indices on Object Edges Set track indices automatically on object edges.
Remove Index Remove an index marker on cursor position.
Remove all Indices Remove all index markers.
Make CD (no calculatings) Create the TOC, keep the Wave files unchanged, 

no fade/crossfade calculations.
Make CD (original files) Create the TOC, calculate all fades/crossfades 

down to the original Wave files (destructive).
Make CD (complete file) Create the TOC, calculate all Waves and 

fades/crossfades to a new file (non destructive).
Show TOC Display the TOC for manual editing.
Set Pause Time Set the default pause time.
Set Start Pause Time Set the default start pause time (before track 1).
Bouncing (internal mixdown) Mix the marked range into one wave file, replace 

the related objects in the VIP.



Foreground Color Select color for sample drawing.
Background Color Select color behind the samples.



Track Bouncing (Menu Tools)

The current virtual project can be converted into a Samplitude HD project or a wave file. Samplitude offers
two ways to perform this function:

1) The complete VIP is converted into a HD project.
2) Only the marked range will be converted.
This function eases the disadvantage of having only a limited number of tracks in the VIP. The tracks 
which have already been arranged will be converted into a HD project and the virtual tracks are freed up 
for other tracks to be added track bouncing).
This function requires large memory in some cases. This depends on the length of the VIP.
The maximum amplitude in dB of the resulting file will be displayed after the conversion takes places.

In four track projects two tracks are mixed respectively on one output channel. To avoid clipping during 
the mixing a reduction of the amplitude by 6 dB is performed (that corresponds to dividing it by two). 
In eight track projects the reduction is set to 12 dB. This reduction can be manually 'turned off' in the 
menu 'Project', 'Project Info' by setting a different value. 



Remove unused Samples (Menu Tools)

With this function all projects belonging to the active VIP can be edited in a way that all samples not used 
in the VIP are deleted. The objects in the VIP are thereby automatically adjusted. The VIP itself will not 
change. This function can save much memory.

However, after performing this function length corrections of the objects are only possible on a limited 
scale.



 Range Manager... (Menu Tools)

The Range manager is a window illustrating all ranges of the current project. The current range is marked
by a colored bar. The range bounds are marked by clicking on the range name. The range name can be 
changed in the lower line. Ranges can be deleted and new ranges can be saved.
With the Play Once button you can playback the actual range once, with Play Loop it is played as a loop.
This way you can use the range manager as a simple jingle player!



 Cursor Manager... (Menu Tools)

The cursor manager is a window showing you all cursors of the current project. The current cursor is 
marked by a colored bar. Clicking on the name of a cursor switches to the marked position in the 
corresponding project. Cursor names can be changed in the lower line Cursors can be deleted. New 
cursors can be saved. 



Object Manager (Menu Tools)
In the object manager all objects used in a VIP are indicated in sequence of their temporal appearance. 
With this option the object manager features a function which is often offered in other programs with 'Play 
Lists'.

In the object manager objects can be selected, which are also activated in the VIP. Small objects can be 
identified and manipulated easily. 
Ctrl + a mouse click will select several objects; Shift + a mouse click will select all objects between two 
marks (like in the Windows Explorer).

Especially productive is the search function in the object manager:

With it you can look for certain objects in full text mode rather than just the graphical representation of the 
objects. An example would be to look for all HD projects with the name 'XYZ.HDP' or all objects that 
contain the name 'Intro'. You simply enter the search criteria in the text field and click on 'Search'. All 
found objects will be selected and are available for further processing.



Make CD (Menu CD)

With this button you can choose between 3 modes of the CD creation:

- no calculatings
Use this function to create the TOC file (Table of Contents) of your CD.
This mode does not calculate any fades, crossfades or volume curves, so you should use it only if 
you did no virtual editing in the timeline and the project contains only one stereo track.
Your Wave files stay unchanged (non destructive). 
The TOC file is located in the VIP directory after this function.

- use original files
Use this function to create the TOC file (Table of Contents) of your CD.
This mode calculates all fades, crossfades or volume curves down to your Wave files. So be shure 
to have backups of the waves if something goes wrong with this process!
There must not be overlapping objects on several tracks!
Your Wave files will be changed during this process (destructive). 
The TOC file is located in the VIP directory after this function.

- complete file
Use this function to create the TOC file (Table of Contents) of your CD.
This mode calculates all your waves with fades, crossfades or volume curves and mixer effects 
into one large Wave file. So be shure to have enough free disk space for this function, an entire CD 
needs about 750 MB for the Wave!
Your Wave files will not be changed during this process (non destructive). 
The TOC file is located in the VIP directory after this function.

- Run CDAudio
Here you can select if you want to run the CD writing software CDAudio automatically. The 
actual TOC file is used as parameter for CDAudio, so you can start the CD burning process 
immediately.
The Samplitude projects are closed before to avoid file conflicts.
If you installed CDAudio to another path than c:\cdaudio you have to select the actual path!



Set Track (Menu CD)

Use this function to set a track marker on the current cursor position. All later markers will be renumbered.
Each track on your CD needs a track marker, typically set after a short pause at the beginning of the next 
title.
Use the function    Track markers on object edges to create the markers automatically on the borders of 
the sample objects!

Shortcuts:
Toolbar:



Set Subindex (Menu CD)

Use this function to set a subindex marker on the current cursor position. All later subindexmarkers will be
renumbered.
Sub indices are not necessary for your CD but useful for marking several regions in one track.

Shortcuts:
Toolbar:



Set Pause (Menu CD)

Use this function to set a pause marker on the current cursor position. This lets the CD player switch the 
output to absolute silence while playback until to the next track marker.



Set Indices on Object Edges (Menu CD)

Use this function to set the track markers automatically on the beginning of each sample object in the first 
track of the timeline.
First you should remove all markers with the function Remove all Indices, if there already exist track 
markers.
If you have several sample objects for one track you can combine them first using the function Bouncing. 

Shortcuts:
Toolbar:



Remove Index (Menu CD)

Use this function to remove a previously set track or subindex marker. First click on the marker (the small 
rectangle below the number), then activate this function to delete it!



Remove all Indices (Menu CD)

Use this function to remove all previously set track or subindex markers. This can be helpful before calling
the function Set track markers on object edges !



Make CD (no calculatings) (Menu CD)

Use this function to create the TOC file (Table of Contents) of your CD.
This mode does not calculate any fades, crossfades or volume curves, so you should use it only if 
you did no virtual editing and only one stereo track in the timeline.
Your Wave files stay unchanged (non destructive). 
The TOC file is located in the VIP directory after this function.

Shortcuts:
Toolbar:



Make CD (use original files) (Menu CD)

Use this function to create the TOC file (Table of Contents) of your CD.
This mode calculates all fades, crossfades or volume curves down to your Wave files. So be shure 
to have backups of the waves if something goes wrong with this process!
There must not be overlapping objects on several tracks!
Your Wave files will be changed during this process (destructive). 
The TOC file is located in the VIP directory after this function.

Shortcuts:
Toolbar:



Make CD (complete file) (Menu CD)

Use this function to create the TOC file (Table of Contents) of your CD.
This mode calculates all your waves with fades, crossfades or volume curves and realtime mixer 
effects into one large Wave file. So be shure to have enough free disk space for this function, an entire 
CD needs about 750 MB for the Wave!
Your Wave files will not be changed during this process (non destructive). 
The TOC file is located in the VIP directory after this function.

Shortcuts:
Toolbar:



Show TOC (Menu CD)

Use this function to open the actual TOC file for reading and manual editing.
Please be carefull while editing this file, because there is no error checking build in!
Normally all TOC editing is done by Samplitude ´s virtual timeline editor without the need of manual text 
input. 



Set Pause Time (Menu CD)

Use this function to set the length of the default pause between two tracks. These pause length is needed
for the raster function, which lets the sample objects snap to the edges of other objects + this pause time. 
Normally a pause time of 2 seconds is used.



Set Start Pause Time (Menu CD)

Use this function to set the length of the default pause before the first track. 
Normally a start pause time of 2 seconds is used.



Bouncing (Menu CD)

Use this function to convert the objects inside a marked range into a new wave file. This may be useful if 
you have several objects in one track and you want to use the automatic indec function. Simply convert all
objects into one new file - the index function will find the correct track borders!



Grid Color... (Menu Setup)

Samplitude lets you specify a color for the grid display. After selecting this option, the program will present
you with a window in which you can choose the desired color for the grid.



Menu Special

This menu gives you access to special functions dealing with manipulation of projects.

Unlink Project Splits Stereo projects into two Mono projects.
(nur HDP und RAP)

Link Projects Links two Mono projects to a Stereo project.
(nur HDP und RAP)

Append Projects Appends one project to another. (VIP, HDP und
RAP)

Change Bit Resolution Changes the bit resolution of a physical 
project.

Mono Mixes a Stereo project into a Mono project.
Stereo Doubles a Mono project into a Stereo project.
Play once Plays marked range (or from cursor) once.
Play loop Plays marked range (or from cursor) looped.
Play in Range Plays from beginning of the project into a 

marked range and loops it.
Play with Preload Preload buffers for fast play start.
Stop Stops playback.
Forward/Backward Playback Forward/Backward.
Restart-Play Restart playback from the beginning.
External Program1,2 Runs an external program with actual project 

file.(nur HDP).
Close audio devices Closes all audio devices.



Unlink Project (Menu Special)

Sometimes it is necessary to split a 2 channel stereo project (two joined mono projects) into two 
independent mono projects. With this menu option you can terminate the static connection between the 
projects.

If you would like to join the projects again, simply select Link Projects from the Special menu (see below).



Link Projects (Menu Special)

Two mono projects are linked to one stereo project. This is a convenient way of editing joined mono 
samples with the same operations.

Make sure that the windows of the two projects to be linked are open. Select one of the objects as the 
current object (click on it with the right mouse button) and call up the Link Projects menu option. Next, 
click on the project you want to join. Samplitude will link the two projects.

Samplitude will automatically match the sample length of the two projects but not the bit resolution.



Append Projects (Menu Special)

With this function a project can be appended with another project, i.e. the material of one project is copied
directly behind the material of the first.

You need to first select the object you want to append. Then you activate the menu and click on the 
project you want to add to the first.

A particular use of this option is the 'cleaning up' of VIP's that contain numerous physical samples.



Change Bit Resolution (Menu Special)

In Samplitude you can change the sample resolution of a HD project. The program will create a new 
window with a copy of the sample (range) in the desired format. This way you can easily preview the 
change before further editing takes place. The original remains unchanged.

Possible sample resolution range from 1 bit to 16 bit. Select the desired radio button and its resolution. To
start the conversion click on the OK button. The Cancel button will return you to the previous screen.

Resolutions between 1 and 8 bits occupy 1 byte per sampling value, resolutions between 9 and 16 bits 
occupy two bytes each.

Also some functions only work with16 Bit samples.

If you like to manipulate an 8-bit sound in different ways, you should convert it to 16 bits before you start. 
Computing inaccuracies of altering digital samples will be reduced when done in the 16-bit format. After 
you are done manipulating the sample in 16-bit format, you can convert it back to a 8-bit sample.



Mono (Menu Special)

The current project is converted into a mono mode. If it was a stereo project before, both channels will be 
mixed. The previous samples are first added with 100% of their image and then divided by two to prevent 
overmodulation (distortion). This is an equivalent of reducing the volume by 6 dB.



Stereo (Menu Special)

The original mono project is duplicated and converted into a single stereo project with the same sample in
both channels. 



Play once (Menu Special)

The project or the range is played once.

Shortcuts:
Toolbar:

Keys: Space



Play loop (Menu Special)

The project or the range is played in a loop.

Shortcuts:
Toolbar:

Keys: Space



Play in Range (Menu Special)

If you have specified a range selecting this menu option (or button) will start the playback of the sample 
from the beginning, enter the range and continue to loop through the range until you press the stop key 
(button). This mode is very useful when testing loops for instrument samples.

Shortcuts:
Toolbar:

Keys: Space



Stop (Menu Special)

The playback is stopped for all projects types.

Shortcuts:
Toolbar:

Keys: Space



Play with Preload (Menu Special)

All buffers are loaded and the playback is ready to be started. Another window will appear with which 
playback can be started at your convenience. No delays will occur. This function is useful on slower 
systems and if    a synchronization must be started in manual mode and an exact start has to be 
performed.

Shortcut
key: Shift + Space



Forward/Backward(Menu Special)

The playback direction can be changed even during the actual playback.



Restart Play (Menu Special)

Playback will start at the beginning even during the actual playback.
Shortcut    is the Backspace key.



External Program 1, 2 (Studio only) (Menu Special)

This menu item in menu "Special" runs an external program with the actual project as 
parameter. This
makes it easy to export a Samplitude project to another audio software for special edits.
Use the ?-button to select the external program you want to run.
After editing and saving the file in the external program you can load it back to Samplitude 
using the
recent file list in menu "Project".
This function works only with HDPs in Mono or Stereo Wave format!



Close audio devices (Menu Special)

This menu item in menu Special closes all audio devices to give other audio software a 
chance to use them for playback and recording in multitasking with Samplitude.



Menu Window

Cascade Arranges all open windows.
Tile Arranges all open windows.
Untile Restores previous arrangement.
Arrange Icons Arranges all icons.
Toolbar Shows or hides the upper toolbar.
Statusbar Shows or hides the status bar.
Positionbar Shows or hides the position bar.
Rangebar Shows or hides the range bar.
Playbar Shows or hides the play bar.
CD Bar Shows or hides the CD bar.
Transport Control Shows or hides the transport control window.
Mixer Shows or hides the real time mixer window.
Time Display Shows or hides the time display window.
Oszi / Correlation Shows or hides the oscilloscope and phase 

correlation window.
Play Parameter Select sample rate and output device for 

playback, control scrubbing and varipitch.
Close All Windows Closes all open windows..
Physical Projects to Icons Changes all physical projects to icons, VIPs stay 

in full size..
Half Height Changes the Samplitude screen to half the 

height.
Window 1, 2, ... Activates the window 1,2...

Cascade (Menu Window)

This function arranges all open windows in a cascade style.



Tile (Menu Window)

All open windows are moved next to each other, making use of the whole display area. This is useful 
when dragging physical sample ranges into VIPs.

Shortcuts:
Keys: Return/Enter



Tile (Menu Window)

All open windows are moved next to each other, making use of the whole display area. This is useful 
when dragging physical sample ranges into VIPs.

Shortcuts:
Keys: Return/Enter



Untile (Menu Window)

This function will return the window order to the previous state.
Shortcut is Shift + Return.



Arrange Icons (Menu Window)

All icons are rearranged along the lower portion of the screen.



Toolbar (Menu Window)

Shows or hides the upper tool bar.



Statusbar (Menu Window)

Shows or hides the status bar on the lower portion of the display.



Positionbar (Menu Window)

Shows or hides the positioning bar on the lower portion of the display.



Playbar (Menu Window)

Shows or hides the play bar on the upper portion of the display.



Rangebar (Menu Window)

Shows or hides the range bar on the lower portion of the display.



CD Bar (Menu Window)

Shows or hides the CD bar on the upper portion of the display.



Transport Control (Menu Window)
Shows or hides the transport control window.
This window lets you quickly activate the play, stop, record and scroll functions.
There is a difference between these buttons and the use of the space bar ot the upper toolbar:
If you stop playback, the cursor stays on the last playback position. Next play start continues playback 
from this position.
The fast forward and backward scrolling functions also work while playing!
 
You can zoom the window to any size and position it anywhere on the screen!.



 Mixer (Menu Window)

This command opens the powerful 4 bus real time mixer of Samplitude.

Note: Depending on the number of tracks you need a certain processing power for all the realtime effects,
please use the Preferences Profiling tool to check the DSP power of your machine while playback! Well 
installed Pentium 133 or faster systems normally have no problems to perform all the effects.

Track 1 through 8
AUX1 - adjust the send level to AUX1 bus
AUX2 - adjust the send level to AUX2 bus
? - Here you can select the wave output devices for the AUX channels. Please select different devices 
than the master output device (key p). The second device is only used in stereo VIPs with 2 stereo AUX 
sends.
Echo - adjust echo decay, right mouse button opens echo dialog 
Comp - adjust compressor ratio, right mouse button opens Compressor dialog
Hi - adjust high eq band, right mouse button opens EQ dialog
Mid - adjust middle eq band, right mouse button opens EQ dialog
Low - adjust low eq band, right mouse button opens EQ dialog
Pan - adjust the panorama position. When using stereo files only one panorama knob of both tracks can 
be used.
Mute - mute the selected track. Note: This checkmark is not identical with the Mute button in Vips!
Solo - solo the selected track. Note: This checkmark is not identical with the Solo button in Vips!
Link - links 2 Mono tracks to 1 Stereo track.
Auto - activates the fader automation for this track
Volume Fader - adjust the volume of the selected track.

Master Section:
AUX Send Level
AUX1 - adjust the master level on the AUX1 bus
AUX2 - adjust the master level on the AUX2 bus
Master Compressor
Ratio - adjust compressor ratio, right mouse button opens Compressor dialog
Thresh. - adjust compressor threshold, right mouse button opens Compressor dialog
Master Equalizer
Low - adjust low eq band, right mouse button opens EQ dialog
Mid - adjust middle eq band, right mouse button opens EQ dialog
Hi - adjust high eq band, right mouse button opens EQ dialog
Master Volume + Image
Mono / Enh. - controls the stereo image of the master bus. 
Att. - attenuates the input of all tracks by 6 or 12 dB. This may be useful to avoid overmodulation.
Link - links the master faders together
Volume Faders - Adjust the master volume
Play/Stop - Start/Stop playback
Small Window - Switch to small mixer window
Mute FX - mute all Eqs, Compressors and Echos
Mute AUX - mute all AUX sends
Reset FX - reset all Eqs, Compressors and Echos to standard settings
Reset AUX - reset all AUX send levels to standard positions
Reset (Mono) - reset complete mixer to standard settings for use with mono projects
Reset (Stereo) - reset complete mixer to standard settings for use with stereo projects
Load Setup - load a complete mixer setup
Save Setup - save a complete mixer setup
Osci / Corel. - open the Oscilloscope / Phase Correlation display

Shortcuts:



Keys: m
Toolbar: 



Time Display (Menu Window)

Shows or hides the time display window.
This window always shows the actual time position in the actual format.You can change this format with 
the menu Units of Measurement. We recommend the SMPTE format: hours:minutes:seconds:frames.
You can change the colors and the font name in the Setup menu.
You can zoom the window to any size and position it anywhere on the screen!.



Osci / Correlation (Menu Window)

A simple oscilloscope view can be opened to display the wave form in a scaleable window. When 
activating the Phase checkmark the phase correlation of a stereo signal can be displayed.
A vertical line represents a mono signal, a horizontal line represents a signal with a phase invertion, which
is not wanted in most cases.    



Play Parameter (Menu Window)

The Play Parameter window which appears after selecting this menu option is designed to quickly enter 
playback parameters. Below is an explanation of the options available in this window.

                                                                                                    
Sample Rate The sample rate can be changed here as long as the soundcard supports the 

new rate (some soundcards even support changing the rate while playing the 
sample!). This is especially useful to hear notes in a sample range played in a 
different octave. When selecting half the sample rate the pitch should be the 
same. It would be played one octave lower.

Device To specify the driver of the sound card use this dialog box. Its necessary if you 
have several soundcards installed in your computer.

Autoscroll The Autoscroll section will let you activate the autoscroll feature. It is especially 
useful when working with long disk files. The project window will follow the 
cursor during playback. 
When working in 2 or 3 section display mode, the autoscroll feature will cause 
the individual sections to follow the cursor as well. If you have zoomed into one 
of the sections, the cursor will move through the section faster resulting in more 
screen redraws.

There are two alternatives in auto scrolling. 

The Soft option performs a smooth scrolling of the whole waveform, the cursor 
stays in the centre of the display. This mode needs a fast graphics board, 
because the complete screen is scrolled between the cursor steps.

The Page option performs a page by page scrolling.
Please note, that the auto scrolling requires certain processing power based on 
your processor, graphic card and the resolution of the display. For this reason 
you might encounter small interruptions in playing the audio files. Should this 
occur simply disable the auto scroll feature or raise the buffer size (select Setup 
menu and click on System).

Scrubbing
While pressing the 0 key on the numeric block (Numlock active) and moving the mouse you 
can perform scrubbing. Samplitude starts
playback at a very low speed, the mouse position relative to the start cursor controls the 
speed.
There are two scrubbing modes (in playback parameter window - key p):

Relative: The distance between the playback cursor and the mouse sets the playback 
speed.
Absolute: The position of the mouse in the window sets the playback speed - at the left 
border
playback speed is 200% backward, at the right border speed is 200 % forward, in the middle
of the
window the speed is 0.
There is a real time resampling performed for changing the playback rate without changing 
the sample
rate of the sound card. For best performance use small play buffer sizes and a fast processor
(Pentium recommended) !

Varipitch
Samplitude supports smooth changes of the pitch while playback, even in multi track 



projects (vertical
slider in playback parameter window - key p).
Activate the Varispeed mode with the "active" button, then you can change the playback 
speed in
various kinds:
Vertical slider - Changes the playback speed from -200% to +200%
Pitch Factor - Lets you specify a certain pitch factor manually
Halftones    - Lets you specify a value of halftones. The playback will be transposed the 
number of
halftones.
Internal Rate - Here you can set a sample rate for the varipitch calculation. If you want to 
play a wave
file with a sample rate of 48 KHz but your sound card can only play rates up to 44.1 KHz 
simply set the
internal rate to 48 and activate varispeed. You listen the same result as playing with real 48 
KHz!
This function is also very useful for digital playback to DAT with 44.1 KHz samples and and 
vice versa!
BPM - Here you can type in the original bpm value of your material and a destination bpm 
value, which
is reached using the varipitch.
Important: Varipitch works also while recording! So you can set the pitch to -2 halftones, 
sing a song
into the computer, then switch off the varipitch - your track is transposed two halftones 
higher!
There is a real time resampling performed for changing the playback rate without changing 
the sample
rate of the sound card. For best performance use small play buffer sizes and a fast processor
(Pentium recommended) !

Shortcuts:
Keys: p



Close all Windows (Menu Window)

Closes all opened projects. Before closing a window/project, Samplitude will ask you whether you would 
like to save the project.



Hide all physical Projects (Menu Window)

This function will hide all physical projects to make room for the display of the virtual projects.



Physical Projects to Icons (Menu Window)

This function will reduce all physical projects to their icons to make room for the display of the virtual 
projects.



Half Height (Menu Window)

The Samplitude screen is shown in the upper half of the display.
This is useful, when using a sequencer program in multitasking. So you can switch between Samplitude 
and the sequencer without the need of complete screen redraws.



1, 2, ... (Menu Window)

Choose active window from the list.



Menu Help

This menu contains the context sensitive online help functions of Samplitude, the title screen with the 
SEKD Logo, CompuServe e-Mail contact.

Contents of Help... Shows the items, for which help is
available.

Using Help... How to use the online help 
system.

Context Help Activates the context sensitive 
help system.

About 
Samplitude...

Shows copyright notice and the 
version of Samplitude.

System 
Information

Shows informations about 
memory usage etc...



Contents of Help... (Menu Help)

Use this command to show the contents of the help system. Click the command, for which 
help is needed!



Using Help... (Menu Help)

Use this command for getting informations about the online help system.



About Samplitude... (Menu Help)

Copyright notices and version numbers are displayed.



Context Help (Menu Help)

Use this command, to get help about any part of Samplitude. Click the

button in the upper toolbar and then click on any button or menu item to get the help 
information.



Tip of the Day (Menu Help)

Use this command, to show the list of tips.
This function needs the file tips.txt in the Samplitude directory.



System Information (Menu Help)

A window is displayed, containing information about the memory status and other parameters.

Particularly useful is the display of the free storage on all connected disk drives, the used system 
resources utilized by Samplitude and the memory usage. Make sure the parameter for system memory 
used by Samplitude never grows larger than the displayed overall system memory available (physical 
RAM). If this happens, the performance of Samplitude is reduced caused by page swapping (virtual 
memory) done to compensate for the missing memory.



Dialogbox for file selection

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document.    A filename can contain up to eight characters
and an extension of up to three characters.    Samplitude adds the extension you specify 
in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<< Add other File Save As dialog box options depending on which ones your application 
chooses via the OFN_ flags of the OPENFILENAME structure used by the CFileDialog. >>





File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    Samplitude adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<< Add other File Save As dialog box options depending on which ones your application 
chooses via the OFN_ flags of the OPENFILENAME structure used by the CFileDialog. >>



1, 2, 3, 4 (Menu File)

Use the numbers and file names to open one of the last 4 projects.



Undo/Can't Undo command (Edit menu)

<< Your application's user interface for Undo may differ from the one described below.    
Modify this help text accordingly. >>

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<< Write application-specific help here. >>



Upper Toolbar

Bild Aktion

Save Project

Cut Range
Copy Range
Insert Range

New virtual Project 
Raster on/off
Auto Crossfade Mode
Group objects
Ungroup objetcs

Cursor to beginning
Range all
Cursor to end

Normalize Range
Extract Range
Build Loop
Crossfade

Stop Playback
Play once
Play loop
Play in Range

Mixer

Record
Multi Card Record
Contextsensitive Help

The next buttons are useful for simulate cuttings before the real cut is done:



Play to the beginning of the marked range.

Play from the beginning of the marked range.

Play to the end of the marked range.

Play from the end of the marked range.

Simulate cut: Start playback before the range, jump over the range and continue playback after 
the range.



Status Bar

The statusbar is displayed in the lower line of the Samplitude screen. A black bar shows the 
progress in most edit functions.



Title Bar

The titlebar is displayed in the upper line of a windows. It contaisn informations about the 
project title and its length in samples and in bytes.



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Change size (System-Menu)



Move (Control-Menu)



Symbol (Control-Menu)



Full Screen (System-Menu)



Next Window (Control-Menu)



Previous Window (Control-Menu)



Quit (Control-Menu)



Restore (Control-Menu)



Change zu... (Control-Menu)



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Edit Projects

Use the lower button bar for positioning in the project and for zooming.
Use the upper toolbar and the menus for edit operations.
Mark a range and set cursors with the left mousebutton.
Move objects in a virtual project with the right mousebutton.
Start playback with the SPACE key.
Edit the sampleparameters with the P key.

Here the function of the buttons in the tracks of virtual projects (VIPs):
? - This will open the track information dialogue. You can enter a name as well as setting devices for multi
v´card playback and recording.
= - Joins two mono tracks. Volume operations will affect both tracks. (only in Mono VIPs)
M - Mute. This will mute the selected track. Right mouse clicks cylce to all devices for the multi card 
playback mode.
S - Solo. Only this track is played.
L - Lock. Prevents editing with the menu 'Edit' for this track.
V - Volume. Activates the volume curve for this track.
P - Panorama. Activates the panorama curve for this track (only in stereo VIPs).
R - Record. Enables this track to the recording. Right mouse clicks cylce to all devices for the multi card 
record mode.
Besides the buttons above there is also a volume slider situated in the left section, one for each track and 
a panning slider.

The 8 lower left buttons in a VIP store 4 setups (S1...S4 incl. zoom level, cursor position and display 
mode) and 4 zoom levels (Z1...Z4). So you can quickly switch f.e. between a full size display, a 10 
seconds zoom range and a sample exact zooom level for perfect editing!

LED level meters
Each track in a VIP can have its own exact LED level meter. Switch this function on or off 
with the menu
"Setup > VIP Display Preferences" or with the Shift + Tab key.
The level meters work both while recording and playback and store the maximum level 
(peak hold
function).
Important: Because drawing of    all the LEDs in a multi track VIP needs some processing 
time, switch
them off, when your machine is too slow!
Zoom In/Out by dragging the scroller
There is a new way of zooming in and out: Simply drag the left or right border of the 
scrollbar button
with the mouse. If the "change mouse" mode is activated in Shift-Tab dialog, the mouse 
pointer
becomes an left-right-arrow, if you are above the position for the zoom function!
Move all objects and volume points behind actual position (key k)
While pressing the k-key you can move all objects and volume rubber points behind the 
actual cursor
position with the right mousebutton. This makes it easy to create free space in a VIP or re-
arrange
large projects without the need of grouping objects!



No Help available

For this object is no help available.



No Help available

For this window is no help available.



Quickstart
In this chapter you are guided through the most important functions of Samplitude without completely 
explaining all the details. The emphasis lies on grasping of essential working techniques. After reading or 
practical test of the examples the Quickstart chapter should enable you to learn all remaining details 
contained in the rest of the manual.

Your first recording
Lets go ahead and try recording some audio with Samplitude. A good way to start out is to take some 
audio material you might be working with right now and recording a short section into the first track of your
new VIP. The next step is to overdub on the second track.

To record audio:
1. Close all windows by pressing the H key.
2. Click on File, New Project and select a 4 stereo track project.

Samplitude will open up a 4 stereo track project and will situate the window on the screen. By 
pressing the Enter key you can enlarge the VIP window. Note the red R1 button activated on the first 
track. This is Samplitudes way of letting you know which track is ready for additional audio recording. 
You can select individual tracks for recording. For some Samplitude versions in a true mono track 
virtual project you can have up to two tracks enabled for recording. This would represent a left and 
right mono track recording, which in turn would make up a stereo image. Other versions of 
Samplitude might allow you to record multiple tracks simultaneously. 

3. Click on the Record button in the toolbar or on the transport control window.
Now you have the Record Parameter dialog appears on the screen. In it you can make several 
selections as far as your recording settings are concerned. For the time being we are not concerning 
ourselves with any settings and leave the default settings in place.

4. Click on the Monitor button.
This option allows you to preview the audio prior to actually recording it. The LED peakmeters will 
show you whether your audio is coming in too loud as well. If you see a Clip indicator, please reduce 
the volume of the audio signal.

5. Start the audio source to monitor the strength of the audio signal.
You might need to adjust the volume with either an external mixing console or by using the sound 
cards audio utilities to adjust the input volume. If the levels are at the desired volume you can move 
on to the next step.

6. Restart the audio again and click on the Record button or press R on the keyboard.
Samplitude will now start recording your audio and will indicate the length and progress of the 
recording in the Record Time field. During the recording the monitor LED peakmeters might actually 
react a little bit sluggish depending on the computer speed of your system. This is because 
Samplitude monitors the audio signal that is recorded from the buffers, which are lagging behind to 
ensure that the recording process takes top priority.

7. At the desired length click the Stop button.
If you did your recording with the Record Parameter dialogue, Samplitude will stop the recording and 
display a dialogue that basically asks you to confirm the recording. You have a choice to redo your 
recording at this point. If you click on the Delete button, you return to the Record Parameter window 
and you can redo your recording all over. If you click on the OK button, Samplitude will insert a new 
object at the beginning of the first track.

Recording the second track
Now that we have successfully recorded the first track, we can move on to record the second track. 



Depending on whether you have one of the sound cards that allow for simultaneous playback and record, 
you will be able to monitor the first track while you record the second track.

To record the second track:
1. Click on the R button on the second track.

This enables the second track for the recording. Disable the first track if needed!

2. Click on the Record button in the toolbar.
The Record Parameter dialogue appears on the screen and allows you to make further choices. 
Since we want to monitor the already existing track, we will need to enable the option Playback while 
Recording. Note: This requires that you have a sound card that is capable of simultaneously 
recording and playing back audio. If you do not have such a card and your system, Samplitude will 
generate a error display indicating that there is some problem with your sound card. This is normal as
Samplitude is not able to address the card for the simultaneous playback and record functionality, 
also referred to as full-duplex.

3. Click on the Playback while Recording option.
4. Click on the Monitor button.
5. Start the audio for the second track or sing into the microphone.

If the levels need to be adjusted again, please do so now.

6. Click on the Record button or press the R key.
Samplitude now starts recording the second audio track and at the same time will playback the 
contents of the first track.

7. Click the Stop button at the desired location.
The confirmation dialogue appears on the screen. If you click on OK Samplitude inserts another 
object into the second track. If you decide to delete the audio, you have another chance to record the 
audio over again.

Note: You can add additional tracks at this point by repeating the above steps. Depending on the system 
configuration and power of your computer system, you may be able to record a number of additional 
tracks. However, if Samplitude starts to skip the audio playback during the recording process, it is time to 
reduce the number of playback tracks. The skipping of the audio is an indication that either your buffer 
settings are too low or your computer system cannot carry all the load. If you run into problems while 
recording additional tracks, please see the chapter on Problems and Solutions.

Recording at different Cursor Positions.

The playback can be started and stopped with the spacebar. Now your project should be played direct 
from the hard disk. If you encounter interruptions in the playback or small slopes during the playback, 
follow the steps below to solve these problems:

- Open 'System' in the menu File > Preferences.
- There you will find a section with different buffer sizes. The VIP buffer is responsible for the playback of 
the virtual project. Increase this value e.g. to 16384 or 32768 bytes by clicking on the '+' button. Now the 
playback should work faultlessly. The downside is, that more storage is required now and the cursor 
follows the current position in larger steps (by the size of the buffer). It is important to find the best 
compromise between safety (large buffer) and fast reaction (small buffer). The buffer 'HD Record' is 
responsible for the recording to the harddisk files and should be set to the same value as the VIP buffers.
If the playback from harddisk also works faultlessly, you have successfully mastered the first hurdles in 
the working with Samplitude. If you should have problems with the Quickstart chapter, consult the chapter
'Problem Solutions' at the end of the manual or the detailed descriptions of all functions!
If you are primarily interested in creating and processing multitrack projects, continue to read the next 



paragraph on virtual projects. If your interests are in physical sample editing, refer to the chapter that 
follows for the most important steps.
We recommend in any case however to read through all of the paragraphs, since they discuss many 
tricks and functions!

Virtual projects

Virtual projects (VIP) are the strongest side of Samplitude. Most tasks which occur in the normal 
recording routine are performed in them. Virtual projects allow the combination of unlimited individual 
recordings into complex arrangements in any number of tracks (Pro version: 8 tracks). The best of it: all 
necessary processes (positioning, cutting, volume, fades and crossfades) are performed non-destructive, 
i.e. they do not destroy the original material but are processed in realtime during playback. To reach the 
maximum performance, the corresponding routines were programmed in highly optimized assembler 
code. That makes Samplitude a an extraordinary and fast program!

First, open a virtual project with the menu 'Project', 'New Project', 'Virtual' or by clicking the 'New Project' 
button and choose '4 Stereo tracks' in the dialog box.
A window with 4 empty tracks is opened in which the uppermost track corresponds to the left stereo 
channel. The next track corresponds to the right channel and so on. Record a signal as described before 
in the previous chapter to the first two tracks. You can also integrate ranges from physical samples (RAM 
or HD project) into a VIP:
Arrange the windows of the virtual project (VIP) and the physical samples (RAP or HDP). This is easily 
accomplished through pressing the 'Return' key.
Next, mark a certain area in the sample (or the entire sample with the 'a' key) and pull the area with the 
mouse into the virtual project (Drag & Drop).

Your sample object now appears as a box in one of the virtual tracks. If you activate it with the right 
mouse button, five small black corners, called 'handlers', will appear.
All object functions are executed and set with the right mouse button! First you should move the object 
with the mouse - always, remember to use the right mouse button! Do not click on any of the five 
handlers, but click in the object. If you move the mouse now while holding down the right mouse button, 
you can shift the sample on the time line or between the tracks. Arrangement can hardly be done in a 
more simply way!
To change the length of the object, use the lower handlers at the sample beginning or end. If you have 
simultaneously opened the physical project, you will see a marked area in it, which corresponds exactly to
length of the object. To open the corresponding sample object, a double click with the right mouse button 
on the object will immediately bring up a window with the sample in it. The highlit area indicates the 
position of the object in the physical sample. The volume of the object can be changed with the middle 
handler by decreasing the size of the object. The smaller the object, the softer the volume becomes. You 
can test it by playing back the project.

The two handlers above on the left and on the right are finally for fading in and fading out a sample object.
If they are pulled to the object middle, the object will be faded in and faded out. These effects are also 
calculated in realtime. That means, that they will not physically alter the original material and can easily 
be undone.
In virtual projects (VIP) an UnDo function is always available, which can cancel up to 100 of the last 
changes. Call up the menu 'Edit', 'Undo' or press Ctrl+z. You don't need to be concerned anymore about 
destroying your arrangement inadvertently!
Experiment some with the handlers by creating two more objects. You can either record something else 
and pull some more samples from the physical projects into the VIP, or you can duplicate the objects in 
the VIP as follows: 
Hold the Control-key (Strg) and pull the object with the right mouse button into another track. This will 
create a copy of the original object, which can be placed anywhere in the VIP. This way you can easily 
generate one long drum track from a drum loop, especially with the help of the grid function. By clicking 
on the mouse button you can activate a screen, which causes that object to be positioned exactly on the 



edges of the other objects (Object Grid). 
This creates sample exact passages between the individual objects without having to constantly zoom 
into the object!
There are different grid types, which can be selected in the menu 'Range', 'Grid', 'Grid Type'. You can 
select a grid based on bars for example. This feature is described in chapter 4.5 in more detail.
Now that you have learned the basics of the objects, it is recommended to have a look at the buttons at 
the left edge of each track:

? - This will open the track information dialogue. You can enter a name as well as setting devices for multi
v´card playback and recording.
= - Joins two mono tracks. Volume operations will affect both tracks. (only in Mono VIPs)
M - Mute. This will mute the selected track. Right mouse clicks cylce to all devices for the multi card 
playback mode.
S - Solo. Only this track is played.
L - Lock. Prevents editing with the menu 'Edit' for this track.
V - Volume. Activates the volume curve for this track.
P - Panorama. Activates the panorama curve for this track (only in stereo VIPs).
R - Record. Enables this track to the recording. Right mouse clicks cylce to all devices for the multi card 
record mode.
Besides the buttons above there is also a volume slider situated in the left section, one for each track 
and    a panning slider.
Many musicians have already experience with MIDI sequencers. This is why we arranged these buttons 
in a similar way to facilitate a fast introduction.

Activate for example the V-Button:
In virtual projects a freely definable volume curve can be defined for each track ('Volume Rubberband'). 
These volume curves are calculated in realtime and therefore do not change the audio data on the disk. 
To accomplish this a certain processing power is required, which should be available with a 486/66 or 
Pentium. 
By double clicking on the volume curve with the right mouse button a new handler is produced, which can
be freely moved. Another double click on the handler will make it disappear from the curve. Digital mixing 
automation isn't done easier!

The 8 lower left buttons in a VIP store 4 setups when holding the Shift key while pressing the buttons 
(S1...S4 incl. zoom level, cursor position and display mode) and 4 zoom levels (Z1...Z4). So you can 
quickly switch f.e. between a full size display, a 10 seconds zoom range and a sample exact zooom level 
for perfect editing!

Another powerful function are virtual crossfades:
If the auto crossfade mode is activated (menu Edit), overlapping objects within a track can be executed 
with a realtime crossfade. It is also possible to activate the crossfade with the crossfade button in the 
upper tool bar.
To accomplish this the back object always forwards the crossfade parameters to the object in the front. 
Select an object and shift it from behind partially over another object. You can select various curve forms 
for the fade. After leaving the editor the crossfade can also be changed with the handlers of the object in 
the back.
In the auto crossfade mode all newly recorded objects will automatically be processed with a standard 
fade, so that they execute a crossfade when overlapped with other objects. This standard fade can be 
edited in the crossfade editor with the buttons 'XXSet/Get Global'. Additionally the crossfade parameters 
can be changed in retrospect with the handlers. 
Please keep in mind, that long crossfades require more than double the processing power of simple 
tracks. After all, two samples are simultaneously played and mixed in realtime. Linear crossfade curves 
save more processing power than non-linear crossfades!

A Look At the Object Menu



It is probably very helpful to have a look at the Object menu to gain a quick overview of the functions available 
specifically for objects in VIPs. Similar to the introduction on physical sample editing, only the most important function
will be covered.

Please note! The functions to mark ranges and to set cursors as well as the different playback modes will also work 
with virtual projects. A range can quickly be marked with the left mouse button and played with the Space bar, 
manipulating the objects (right mouse button) until the results are really perfect.
The cut functions in the menu Edit will also work with VIPs. They will cut all tracks at the same time, regardless of the 
limits of the object. This way a whole verse can be copied from many individual elements and inserted at another 
position. Simply mark a range over the verse, press the c key to copy it and place the cursor at a new position. Press 
v to insert it at that spot. Nothing is more simple!

Grouping Objects

With this function you can group a number of objects. You first have to select all the objects by clicking on them with 
the right mouse button while holding the Shift key pressed. Then activate the group function by clicking on the Group 
Selected button. The grouped objects can then be shifted or copied by pressing the Ctrl key. 

You can also group individual groups. This way you can build complex arrangements from smaller elements without 
loosing track of them. Objects which are based on stereo samples are actually existing of a group of 2 objects which 
are always edited together.
Groups can also be separated with the Ungroup button to create, for example, a mild phase shifting effect from left to 
right or to adjust the volume for the individual tracks to gain a panning effect.

Lock Objects

Once you have place objects in the proper spots you can prevent accidental shifting by locking them in place. Once 
locked, the object displays a diagonal line within the object.

The Hotspot

Objects which do not contain the acoustical peak at the beginning are difficult to integrate in the arrangement using 
the raster option. The hotspot function is the remedy for that type of problem.
Select the desired object and set the cursor to the raster position of your choice. Then select menu Object, Hotspot. 
The object will be lined up to other objects to the new position and not the beginning of it. A typical example of such a 
problem is the sample of a smashed in door in which the actual smashing sound is the most important and not the 
noise of the opening door.

For further details about particular functions, please read the following chapters in the manual.

You should be up and running now. If you ran into problems during Quickstart consult the chapter 
Problem Solutions at the end of the manual. 



Virtual Working

Selection of objects with the mouse
Multiple selection of objects
Unselect objects
Move objects
Edit the borders of objects
Fade In / Fade Out
Object-Volume
Covering objects

General
Virtual projects are one of the most powerful functions of Samplitude.

From many physical projects (RAM and HD samples) a complex arrangement can be made by using 
virtual projects. All interface operations are also virtual, that is, they dont destroy the original samples. You
can experiment with different settings without altering the original sample.

Even though your audio hardware is only capable of putting out audio data in 2 tracks (channels/stereo), 
Samplitude can handle more than 2 tracks in any virtual project. As an example, you could fade a stereo 
project and at the same time bring in another stereo track, blending speech with music.

Digital processing requires a certain amount of processing power from your computer system. Slower 
machines will limit the number of tracks you will be able to manage. On a typical 486/33 a maximum 
number of four tracks can be mixed and output through the audio outputs without running into problems. A
486/66 or a Pentium processor should handle 8 tracks in 16 bit quality without problems. Another 
important factor to watch out for is the speed of your hard disk.

Here the function of the buttons in the tracks of virtual projects (VIPs):
? - This will open the track information dialogue. You can enter a name as well as setting devices for multi
v´card playback and recording.
= - Joins two mono tracks. Volume operations will affect both tracks. (only in Mono VIPs)
M - Mute. This will mute the selected track. Right mouse clicks cylce to all devices for the multi card 
playback mode.
S - Solo. Only this track is played.
L - Lock. Prevents editing with the menu 'Edit' for this track.
V - Volume. Activates the volume curve for this track.
P - Panorama. Activates the panorama curve for this track (only in stereo VIPs).
R - Record. Enables this track to the recording. Right mouse clicks cylce to all devices for the multi card 
record mode.
Besides the buttons above there is also a volume slider situated in the left section, one for each track and 
a panning slider.

Multi Card Mode - Here you can switch on or off the multiple sound cards playback feature.
If it is activated each track is produced through the sound card which is selected in the track info dialog 
(button ?).
If it is not activated Samplitude mixes all the tracks to the stereo master bus and plays it through the card 
which is selected in the playback parameter window (key p).
This multi card mode is useful when working with multi channel sound cards like ARC 44, ARC 88, DRC 
88 or DAL V8.
Please note:
Playback through several sound cards puts high demands on the accuracy of the sample rate of each 
card! If these do not agree exactly, positioning inaccuracies with longer samples will occur. To 
compensate for these problems you should playback the contents of a track through the same card that 
you recorded them with.



The 8 lower left buttons in a VIP store 4 setups (S1...S4 incl. zoom level, cursor position and display 
mode) and 4 zoom levels (Z1...Z4). So you can quickly switch f.e. between a full size display, a 10 
seconds zoom range and a sample exact zooom level for perfect editing!

To integrate physical samples into a virtual project, record directly into a VIP using the R-buttons in 
the tracks or follow these steps:

1) Open the RAM or HD project.

2) Mark the complete project as a range (key a) or only the range to be joined in the VIP.

3) Give a name to the range for later identification.

4) Create a new VIP (key e), using the project menu or the corresponding button on the button 
bar.

5) To position the windows on the screen, press the Enter key.

6) The specified range in the RAM or HD project can be dragged onto the virtual project 
window. To do this click on the physical project range and hold the mouse button. Now drag 
the range onto the virtual project window. You will notice that the range is being pulled to the 
nearest group of tracks (for stereo projects, single track for mono projects). 
After releasing the mouse button the sample range will appear at exactly the same position 
you released the mouse button.

Please note that a VIP is always longer than the samples being shown in it. The first sample may take 
80% of the space. So, producing more objects or shifting backwards will scale the graphics again.

Manipulating the Display of a VIP

There are two ways of displaying a VIP. The Tab key switches between the display modes. Shift + Tab 
calls an editor to define the display modes. One allows the display of all data and graphics. Another 
allows illustration of only text. The second mode is recommended for use with a large number of projects 
since it is faster in reconstructing the window contents.

VIP objects can also be displayed with different background colors. This will allow you to distinguish 
objects with different color codes. 

To select different colors, follow the steps below:

1) Select the VIP object by clicking on it with the right mouse button.

2) From the Object menu select Object Background Color....

3) Select the desired color and click on OK to return to the project window. The color should 
have changed to the one you selected.



Selecting an object using the mouse
To select an object simply click on it with the right mouse button. You should see 5 small handles that 
appear at the beginning and end of the object and in the middle. If you click on the object again, the 
selection will be revoked. 

The frames around the object will also be inverted if the right mouse button remains being pressed.

If you select an object this way, you will deselect all previous selected objects.

If you double right click on the object, the corresponding physical project (RAM or HD) will be opened. 
The range representing that object is marked at the same time.



Selecting several objects using mouse

Pressing the right mouse button together with the Shift key enables the selection of an object without 
revoking the selection of other objects. 



Unselecting objects

Click the mouse next to an object and all selected objects are unselected.



Move objects
After one or more objects have been selected, they can be moved horizontally (on the time axis ) or 
vertically (in the track number). You will need to click on the object(s) and hold the mouse button. By 
dragging the object(s) you can either shift it to a new position on the time scale or move the object to a 
different track. 

When shifting multiple objects, please keep in mind that the shift can only occur until one of the objects 
reaches its outer limits. In other words, if the first object in the group reaches the beginning of the virtual 
project the shifting will stop at that point.



Changing the beginning and end of objects in VIPs
The two lower handles of an object define the edges of the object. By manipulating the handles you can 
change the beginning and the end of an object. The beginning of the object can be shifted forward or 
backward, when you first click on the front handle and then keep the right mouse button pressed. 

The beginning of the object can only be shifted to the beginning of the physical sample or to the end of 
the object. Respectively, the end of the object can only be shifted as far as to the end of the physical 
samples or the beginning of the object. 



Fade In / Fade Out
The two upper corners of an object are the handles for fading in and fading out. Fading in and out can be 
easily achieved by manipulating those handles. As already explained, this function is performed in real-
time mode. Any alterations you make here will leave the original physical sample unchanged. 

You can specify fades without risking loosing any sample data.

Since real-time fading requires system resources, you might encounter small interruptions during 
playback on slower computers even though Samplitude make use of optimized Assembler programming. 
Should this occur try increasing the VIP buffer values by selecting System... from the Setup menu.



Object-Volume
The volume of any object can be adjusted using the handle in the middle of the object. This function is 
also performed in real-time. If your system cant handle the needed requirements, the physical sample can
be set to the appropriate volume levels using the normalization function.

For dynamic volume changes use the volume rubberbands (button V in each track).



Covering of objects
On a track (channel), only one object can be played at a time. When an object is shifted and covers a 
certain portion of another object, the invisible portion of the covered object cannot be played.

Shift the object to make the invisible portion of the covered object portion visible and audible.



Raster
Samplitude offers a sophisticated way of positioning objects. An invisible raster helps you (when turned 
on) in shifting objects to exact positions. Please refer to the menu option Range, Raster for further 
explanation of this function.

Object Raster

As explained above, rasters will let you easily shift objects to a specific position. Using this function with 
the Object Raster, you can only shift objects as far as to the beginning, the end or the hotspot of another 
object. The front edge of the object is normally the reference point. A hotspot for the object is only taken 
into account if its already defined. If several objects are selected, they will always be shifted to the front 
edge (or the hotspot) of the object which is selected as the last (the mouse points to this object).

This function will let you rearrange audio patterns easily and quickly by gaining sample exact merge 
points.



When virtual projects are loaded into memory, Samplitude open all physical projects (RAM and HD) which
belong to the VIP first and positions their icons on the screen bottom part of the screen. The window for 
the virtual projects will then be opened.



The Screen of Samplitude

After you have started Samplitude, you will see a window with some information about the program. 

The lower margin shows a bar of buttons, which will be used for positioning sections later on. They are 
operated with the left mouse button. On the upper tool bar youll see some symbols of commands most 
often used.

To have a first look at Samplitude, you should create a project, or load a demo project. To do this, you 
need to select the following menu options: 

From the File menu, select Open Project... and open a virtual project.

You will see a virtual project with different sample objects which are situated along the time axis in the 
tracks.

If you press the Spacebar you will hear the samples displayed on the screen. If you dont hear anything at 
this point, you will need to check out your soundcard and/or sound equipment. Please refer to the chapter
Quickstart for further help.

The project window can be shifted and varied in size. If you change the window size or position, the 
screen will be redrawn. Please note that the title bar contains the file name, the sample resolution and the
sample length. You can calculate the memory size needed in bytes from the sample length, the resolution 
and the channel number.

The icons in the lower section of the screen represent the physical projects bound together in the virtual 
project. 



Definitions

Here are some important definitions of some specific terms, which are frequently used in this manual. 
Please dont skip ahead, even though some might be familiar to you. The terms are used in a special 
context and will not be explained further in this manual.

Familiar terms such as button, window and requester are not explained here. You will find them explained 
in a Windows manual.

            Project  

            View  

            Range  

            Cursor  

            Playback  

            Objects  

            Clip  



Project

A physical project consists of one (stereo) or several (mono) samples. Samples of one project are always 
processed together. They have the same sampling rate, the same sample value and the same length. 
Choose the corresponding window to access a physical project. The title bar of the physical project 
window contains the project name, the sample resolution, the sample length and the memory used in 
kBytes.

To activate a project, just click the mouse on the respective window. To edit samples of a stereo project 
separately, stereo projects must be divided (menu Special > Unlink). Samplitude can handle an unlimited 
number of projects on the screen.

Different Project Types

Physical projects (RAM- and HD-projects), also called data windows

In RAM-projects, samples are stored in the memory of the PC. The data files are usually located in the 
directory RAP (RAM-Projects).

Samples of HD-projects are recorded and saved direct in files on the hard disk. These files are normally 
located in the directory HDP (HD-Projects). Only some parts of the samples will be loaded into the 
computers memory. These portions are immediately needed for displaying, processing or playback.

Virtual projects (VIP)

A virtual project is a collection of sections from different samples. It does not contain any individual 
samples. If you sample with a specific sample resolution, that same resolution will be used for playback in
virtual projects. Samples can be processed on an object-oriented basis throughout a virtual object.

The actual audio data is displayed boxes (so-called objects) in their respective tracks (channels).

An object is an image of a sample or of a range marked in the sample. So, an object contains no audio 
data, but references to the physical sample.

You can read details about virtual project processing in the chapter about Object menu.

The corresponding files stored are under the directory VIP (Virtual Projects).



Clip
The clip is a buffer or temporary memory into which samples from a project can be copied, or from which 
samples can be inserted into projects. In addition, the content of the clip can be mixed with the data of a 
project.

The clip has always the same properties as the project from which the data has been taken (sample 
resolution and mono/stereo mode).

The clip is represented on the screen by a window having the word Clip on its title bar. Otherwise, a clip 
is also a project, that means, it can be played, edited and renamed. 



Range
A range a certain portion (part) of the sample marked by you. When a range has been marked, it can be 
played by pressing the space bar. A range is defined by its beginning and its end (horizontal) and by its 
upper and lower edges (vertical).

A range is used on one hand for the specification of parts on which certain operations can be performed 
(such as cutting, inserting, normalizing, fading in/out, shifting upward and deleting).

Another function of a range is the definition of loops considered when samples are played.

The third function is the determination of bounds of sections within which the data is represented 
graphical image. Mainly the upper and lower edges of a range are interpreted here, which is not true for 
all cases with the first group of functions.

Unlimited number of ranges can be specified in a project. Ten of them are activated by the function keys, 
the others by the range-manager. The vertical value of a range can be put to a maximum by selecting 
the option Fix Vertically from the Setup menu. This maximum is pre-adjusted in case of VIPs. 



Cursor
Cursor points (locator points) are used to mark certain positions in the sample. They are generated by a 
single click on the left mouse button on the sample. 

The cursor is a special type of the range, e.g. a range whose beginning is identical with its end. If a cursor
has been defined, it will not be possible, for example, to cut or copy the range. The contents of the 
clipboard, however, can be inserted there.

You can specify as many cursors as you like in a project. Ten of them can be switched to with the number 
keys of the keyboard.

If the cursor has been set and the space bar is pressed, you can hear the portion from the cursor to the 
end of the sample.

Names of cursors and locator points can be seen on the upper edge of the sample and can be shifted.



Sections
Samplitude can display up to three portions of a project at the same time. One section, for example, 
permits the representation of the complete sample, while another section merely shows a small part being
edited. Sections are similar to ranges, since they are defined by their beginning and end and their upper 
and lower edges as well. The length of a section equals the difference between the end and the 
beginning, its height the difference between the upper and lower edges.

The use of several sections allows very efficient work to find loop points.

Active section 
To increase editing speed, some functions that are used more often have been included in the Tool Bar.

Before you can apply any of the functions, you will have to select a specific section or region. This is done
by clicking on the right or lower proportional button (scrollbar) of the section. The color of the sections 
margins will change and it will be the active section from now on.



Range marking
To mark a range (also called area), move the mouse pointer to one of the sections shown and press the 
left mouse button. Keep the button pressed and move the pointer within the section. 

You will see how an inverted rectangle is represented between the start point and the current mouse 
pointer position. Now, release the left mouse button.

The horizontal limits of the chosen range appear in the text line below the title bar.

If you want to mark a different range, simply click on a position outside the inverted range but inside the 
section. The old range disappears, and you can now mark a new range.

If you only want to alter a range already existing (i.e. beginning, end, upper edge or lower edge), click with
the left mouse button inside the existing range. Keep the mouse button pressed and leave the range in 
the direction of the bound to be changed. When you have left the boundary line, this edge (and no other 
but this) will follow the movement of the mouse pointer. Release the mouse button when you have 
reached the position desired.

This is a way of maintaining appropriate bounds and to change the desired edge only.

Samplitude offers you two possibilities:

If you have another section which is not entirely overlaid by the current range, you can click outside the 
range and immediately release the button again. The former range disappears, and a cursor or a very 
small range becomes visible. Now you can define the desired range in the original section.

The other way is simply to press the numerical key 7 (Home) or 1 (End) on the numerical key pad. These
are the commands for Cursor to Start or Cursor to End. The old range disappears and you can define a
new one (The functions Cursor to Start or Cursor to End can also be found in the Range menu).

There is another possibility: 

The limits of the current range can be varied holding the Shift key with the keys 4 and 6 on the numerical 
key pad. Key 4 (as well as the cursor key left) moves to the left (beginning of the sample), key 6 (as well 
as the cursor key right) to the right (sample

Cursor to left (right)

Scrolls the actual display to the left (right).

Ctrl+ cursor left (right)

Zooms the display in (out).

Shift + Home - Range to beginning

The new range now extends from the beginning of the sample to the end of the former range or to the 
former cursor position.

Alt + left Cursor to beginning of range

The cursor is positioned at the beginning of the current range.

Shift + Ctrl + left

The range already marked is folded to the front, which means that the range is shifted left by its own 
length. This function is very useful to find drum loops:

When you have marked a bar in a rhythm sample, the use of this function allows you to mark the following
bar. Consequently, this function eases the work in generating virtual projects.

Page up



The beginning of the range is set to the next zero position, in order to gain cuts or loops with no cracks.

Shift + Page up

The beginning of the range is set to the former zero position, in order to gain cuts or loops with no cracks.

The functions specified above for shifting the range left are also available for shifting to the right direction. 
The above details of functions are similarly applied.

6 Scroll view to right
Ctrl + 6 Zoom Out
Alt + 6 Cursor to end of range
Pgdn End of range to right to next zero position
Shift + Ctrl + 6 The range already marked is folded to the end
Shift + Pgdn End of range to left to next zero position

Generally speaking, the direction of movement is specified by keys 4 and 6 on the 
numeric key pad.

Special functions are assigned to Home and End keys:

7 (Home) Cursor to beginning of sample
Shift + Home Range to beginning
1 (End) Cursor to end of sample
Shift + End Range to end

Ranges can also be shifted using the mouse:

Press and hold the Shift key and then click in the range already marked. By holding the mouse button 
you can shift the marked range either to the left or right, dependent on the movement of the mouse. This 
can be useful, for example, if a loop length already found is to be tested in other positions.

Ranges and cursors can also be saved by means of the menu or a function key. Samplitude is able to 
save an unlimited number of ranges and cursors. These and special functions for defining, varying, and 
using ranges can be found in the Range menu.

A review of all key assignments can be found in the chapter Shortcuts. 



Playing Ranges
To listen to the sample, press the space bar.

There are three playing modes which can be chosen by three buttons on the upper button bar. 

 plays sample once 
 plays sample looped 
 plays sample form the beginning, then loops the range.
If a range has been defined, it will be played from the beginning to the end over and over again. If you 
change the length of a loop or section (range) the results are immediately audible.

If you did not specify a range or cursor position, you will hear your sample from the current cursor position
to the end of the sample. If a cursor position has been defined, the section between this cursor and the 
end of the sample will be repeated. Sample playing can be interrupted by pressing the space bar again. 

You should note that all sample resolutions can be played immediately. The data is converted in real time 
mode, i.e. while playback. This means that the processor is partly occupied with the conversion of the 
data.

If the system has too much data to convert while playing, it is possible that the space bar or the play 
button will not start the playback. Should this occur use the ESC key to interrupt the playback mode.

Output Modes

The output modes can be adjusted in the Play Parameter window ( key p or menu Special..., Play 
Parameter...). You can choose another sampling rate by specifying the sampling rate check marks. 
Notice that not all sound cards support all sampling rates listed. Cards with digital inputs and outputs will 
only offer a sampling rate of 48, 44.1 and 32 kHz.

The driver of the card can be chosen in the Device Window. This is important when you have more than 
one sound card installed in computer.



This button will let you switch between different zooming factors. The length of the section 
displayed is always cut in half. However, the middle of the section is maintained. Exceptions are possible 
if the range is at the beginning or end of the sample. From a certain resolution on, the single sampling 
values are represented individually and separated from each other by vertical gaps.
The lower limits of zooming in are 2 or 3 sampling values. The whole section will be filled with these 
sampling values.

Another way is zooming out of the section. The length of the section is doubled, and its middle 
position is maintained. Exceptions are possible if the section has already covered almost the complete 
sample. The upper limit of zooming out is the complete sample.



The complete sample is displayed in the section.

The horizontal bounds of the current range are used as the beginning and end of the current 
section. The length of the current section is maintained if only one cursor has been defined. However, if 
possible the bounds are chosen in the way that the cursor is in the middle of the section.

The length of the section is chosen in a way that the number of sampling values displayed is 
equal to the number of pixels available in the section.
The middle is maintained.



The section is shifted by half of its length to the left, i.e. toward the beginning. The length of range
is maintained. The middle of the section is moved to its right edge or/and the left edge of the section to its 
middle.

The section is shifted by its full length to the right.

The section is shifted to the beginning of the sample; its left edge is equal to the beginning of the 
sample, the length is maintained.

The section is shifted by half of its length to the right. 

The section is shifted by its full length to the right.

The section is shifted to the end of the sample.



The blue buttons on the bar are used for positioning the sections along the vertical amplitude axis.

The buttons have the same functions as the ones for horizontal shifting and zooming. The difference is in 
the vertical application of their actions.



Defining Sections (lower toolbar)
Sections can be defined by the button bars located on the bottom part of the screen and by proportional 
bars located on the bottom and right edge of the window.

Section to beginning
Section one length left 
Section half of its length left
1 Sample = 1 Pixel in section
Zoom in
Zoom complete range in section
Zoom out
Show complete sample in section
Section half of its length right
Section one length right
Section to end 

Zoom in vertically
Zoom in to verical range borders
Zoom out vertically
Show complete sample vertically

Set section in a VIP to the next/previous object border
Set section to the next/previous cursor



Zoom in vertically
Zoom in to verical range borders
Zoom out vertically
Show complete sample vertically

Set section in a VIP to the next/previous object border
Set section to the next/previous cursor

 Set the zoom depth to 0.1, 1, 10 and 60 seconds



Problems and Solutions
The following are solutions to some common problems. Should your problem persist, please contact the 
distributor or us via CompuServe. Please supply the following information:

- Version of Samplitude
- Where you bought the program
- Configuration of your system (Processor, RAM, hard disk, etc.)
- Sound card configuration (Type, Driver)
- Information on whether other audio components are operating properly

I see markers with the letter E in my physical audio file and interruptions occur at those spots. 
What are they?

Samplitude creates these markers automatically if during the recording the program runs out of resources
and recording interruptions take place. This can happen if the computer is overloaded or not fast enough 
to do the processing of multiple tracks. Look at the pops and clicks section for some solutions to the 
problem or consult the Tutorial manual.

I want to back up all my project files. What needs to be included?
When backing up project files all files need to be included that are associated with the VIP project! These 
files may include any of the following: *.hdp, *.h0°, *.h1°, *.vip, *.wav, *.s0°, *.s1°.

To keep files organized we suggest that for each project or song you are working on, you create a sub-
directory before you start working with the project and save/record all files into that directory. This can be 
done from the Record Parameter dialog.

I have pops and clicks in my material when I play back any audio.
Pops and clicks can sometimes occur with certain sound cards and system configurations. If it happens, it
is most often during the recording of audio tracks.

Especially when using Samplitude in Windows 95 there are several things that can be done to remedy the
problem:

· Make sure you use the latest driver for the sound card. You might need to contact the manufacturer of
your sound card for an updated driver.

· Check to see that there are no IRQ or DMA conflicts with other devices in your system. The Device 
Manager in the Control Panel in Windows 95 might help you diagnose problems.

· The audio caching setting in Windows 95 might need to be adjusted. To do this bring up the Control 
Panel and select Multimedia from the options. Next, click the Advanced tab and select the Media 
Control Devices option. In the Media Control Devices look for Audio Control Device and call up the 
Properties. The following setting can be adjusted to solve some pops and clicks problems.

· Some problems with pops and clicks can be solved by editing the SYSTEM.INI file in the Windows 
directory. Look for a [Vcache] section and add the following lines:

maxfilecache=4096

This should effectively solve the problem. The values for the parameters are Kbytes of file cache and can 
be adjusted depending on your RAM size.

· By disabling virtual memory a problem with pops and clicks or other playback or recording problems 
can sometimes be solved. Please refer to your Windows manual for instructions on how to disable the
virtual memory.

As a rule of thumb: If the status bar in Samplitude does not indicate any errors during playback or 
recording, the problem most likely has to do with the sound card driver or settings for the sound card.

I get no audio during recording or playback.
If you hear no audio during either recording or playback, check on the following items:



· Make sure that all cable connections are made properly and that none of the cables is defective.

· If the sound card has a mixer program, make sure that none of the mute options are turned on and 
that the volume faders are sufficiently turned up.

· Check to see whether you have the proper driver installed for your sound card. You can do this in the 
Windows Control Panel.

· If you dont hear any audio in Samplitude and would like to check your sound card, use the sound 
cards own sound utilities to diagnose the card. Also, many sound cards come with their own set of 
playback software for digital audio. Follow the instructions in the sound cards manual for testing 
digital audio with the cards utilities.

· Make sure that your external mixer/amplifier is turned on and has a sufficient volume setting.

These are the most common problems you would be dealing with when having audio problems.

Note: The Digital Audio Labs CardD+ approaches monitoring the recorded signal during the recording a 
little bit different than other sound cards. It is perfectly normal to have the incoming audio signal missing 
on the outputs of the card as you are recording the audio. 

The CardD+ will not feed the audio signal on the inputs of the card to the outputs during the recording. 
You will need to monitor the recorded signal externally during the recording phase. All other tracks in 
Samplitude will play back just fine.

My VIP volume appears to be too low. How can I fix that?
Samplitude has a sophisticate way to deal with digital audio clipping which can occur when you add audio
tracks in the VIP. Depending on how strong the audio signals are in each of the tracks, by the time you 
add audio in tracks 5 or 6, you actually might encounter digital clipping.

Since digital audio volume processing deals with mathematical addition of volume values it can easily 
happen that the resulting volume for combined tracks is beyond a sound cards capabilities to deal with 
the audio volume. This is when digital clipping would be introduced.

In Samplitude you can set a master volume for each VIP. This setting can be different depending on the 
audio material in the VIP.

This setting can be found in File, Properties, Project Info. You will need to have a VIP open to get to the 
Project Info dialog. You can adjust the overall volume setting for the VIP in the Volume section of the 
dialog. By default, Samplitude will assign a setting of -12dB which can be too low for some projects. You 
can easily increase the volume setting to 0 dB for example. When you encounter digital clipping, you may 
want to reduce the volume setting at that point.

You may also change the overall volume setting in the Mixer window in the Master Volume + Image 
section.

Samplitude display some sort of MMSYSTEM error when I try to do simultaneous record and 
playback with my sound card. What could be the problem?

Unfortunately, you may be dealing with a sound card that is not capable of working in the full-duplex mode
needed for simultaneous record and playback. Some sound card are only half-duplex sound cards, 
meaning that you can either play back your audio or record audio, but not both at the same time.

You will either need to install a second sound card and record with one card while you play back audio 
tracks with the other. Or you will need to replace your sound card with a full-duplex sound card. Check 
with the manufacturer of your card to verify the capabilities.

Whenever I start playback or recording my system hangs or displays an error message.
This many times is an indication that an IRQ or DMA and possibly an address conflict is present. You will 
need to make sure that no other component in your computer system uses the same hardware settings 
as your sound card. If it does, the system may hang or even crash.

Under Windows 95 and NT 4.0 you may use the Device Manager to find free IRQ, DMA and address 
settings. Refer to your Window manual for instructions on using the Device Manager to diagnose your 
system. There are also a number of commercial diagnostics tools available that may assist you with 



finding free settings. In some cases reconfiguration of already existing components is necessary and 
sometimes even replacing components with ones that allow you more configuration choices.

When I try to do something with my mouse it doesnt respond or does something erroneous.
Make sure that the correct mouse mode is selected. You may need to set the mode back to its default 
setting by clicking the right mouse button on the VIP frame (some location outside of the tracks and not 
on any button or other component). You may also change the mouse mode in File, Preferences, VIP 
Mouse Mode.

Why cant I close a data window even though all references (objects), using the data window 
contents, in the VIP are gone?

Trying to close a data window usually only works if there are no objects in a VIP that may use ranges from
the data window (HDP or RAP). This is due to the fact that the VIP needs the data window for playback of
material in the object(s). If all VIP objects in the VIP window are deleted that make use of the data 
window, the Undo list still may have references to the data window open in case you need to undo any 
editing step associated with the VIP window. If you are really convinced that the material in the data 
window is not needed anymore, simply delete the Undo Levels with Edit, Delete Undo Levels. After this 
you will be able to close the data window since all references in the Undo list are gone.

Note: Samplitude will only allow you to delete the Undo Levels when a VIP window is active (click on the 
title bar of the VIP window).

Synchronization
There are various aspects to synchronizing Samplitude with the outside world. We will explain the two 
most common ways to synchronize Samplitude, external synchronization and internal synchronization.

External Synchronization
This type of synchronization is used when you need to synchronize Samplitude with a tape based 
recorder, video machine, external sequencer or other equipment which will send sync signals to 
Samplitude. Most of these situations will work best by setting up Samplitude as the slave and the external
sync source as the master.

Once the setup has been made for Samplitude to expect the synchronization signals at a particular 
interface port, you do not need to do anything else in Samplitude to start the playback or the recording. 
Once Samplitude detects the incoming signal, it will attempt to locate the song position pointer and jump 
to that location. Playback is started automatically.

The same holds true if you need to record in Samplitude while synching up to an external device. Simply 
open up the Record Parameter window and make all necessary adjustments. Now, press the record 
button. Once you have made the needed changes in the window, simply start the external device. 
Samplitude will lock up to the incoming signal and will start the recording process. Its that simple!

There are several things to consider when working with an external sync source:

· Make sure that the synchronization interface can convert a SMPTE signal into MTC code. A software 
utility should let you do this easily, or the cards device driver might do it for you automatically.

· When striping analog or digital tape with a SMPTE track, make sure that the signal is strong enough 
to feed a continuous, uninterrupted sync signal. Samplitude will stop the playback or recording as 
soon as a drop out occurs.

· You might need to work with the offset settings in Samplitude when working with a sync source that 
starts in the middle of a tape for example.

· Make sure you are using the proper sync protocol.



Internal Synchronization
This type of synchronization is used when you need to synchronize Samplitude with another program 
running on the same computer in multi-tasking. This most likely will be a sequencing program dealing with
your MIDI configuration. In this case you can have Samplitude both as the slave or the master. 

As with the external synchronization, once the setup has been configured properly in Samplitude, you do 
not need to do anything else in Samplitude if you have set it up as a slave. Once Samplitude detects the 
incoming sync signals, it will attempt to lock up to the correct song position and will start the playback or 
the recording process.

Most the time you will choose the MIDI Clock format for the synchronization protocol. The advantage of 
MTC versus MIDI Clock is, that the MTC sync protocol is not dependent on the speed specified in the 
BPM setting. The tempo in the sequencer can be changed and Samplitude will follow that change. This is 
not possible with MIDI Clock.

There are also a number of things to consider when trying to sync two programs:

· Make sure you have sufficient system resources to provide accurate and timely synchronization for 
both programs. On a slow computer system you might encounter drifting of tracks if the system is not 
fast enough to deal with the processing of digital audio and sequencing. You might need to reduce the
number of tracks used in Samplitude or move the whole setup to a more powerful computer.

· When using cable connections to sync two programs, make sure that you are not setting up a MIDI 
loop. This can occur when using for example MIDI Out 1 and you plug the end of the cable into MIDI 
In 1. The software driver for your MIDI interface might get confused with the signals and might create 
a MIDI loop not allowing you to successfully sync the programs.

· You might need to turn off Virtual Memory in Windows to compensate for synchronization 
inaccuracies. Most real-time functions in Windows are difficult to achieve when Virtual Memory is 
enabled. Please refer to your Windows manual on turning off Virtual Memory.

· Make sure that the BPM in Samplitude and your sequencing program match. This is important when 
dealing with time references in both programs.



A few Tricks
A few tricks that help make working with Samplitude an ease:

- Using the Return key you can arrange all windows in comfortable way.
- The a key will select the complete sample as a range.

- With the keys Home and End you can set the cursor to the beginning or end; all marked ranges will
disappear.

- A range can be selected from one exact cursor position to the next by clicking on the cursor marker
above the wave form. Next, hold the Shift key and click on the second cursor marker.

- By using the Shift + mouse click and movement a range can be shifted.

- Shift + Ctrl + Cursor keys will flip a range to the right or left. This is a good way of testing a loop at
a different position.

- Objects in virtual projects can be displayed in two different modes. By pressing the Tab key you 
alternate between the modes. Pressing Shift + Tab will open a dialog window in which you can set 
the parameters of the display modes.

- By using Ctrl + right mouse button click on an object you can easily copy it in virtual projects.

- By double-clicking with the right mouse button on an object in a virtual project you can open 
the corresponding physical project (RAM or HD).

- By double-clicking with the right mouse button on the volume curve in a virtual project you can 
create and delete volume handles. Activate the volume curves with the V-button in each track of 
the VIP!

- Change the function of the mouse buttons in VIPs with the menu Preferencesp > Mouse Mode!

- To calculate the tempo (bpm) of a marked range open the menu Range > Snap Definitions. 
Then type in the number of beats of your range in section Free Bar Snap and click on the Get 
Range button. Then read the tempo value in the BPM display!

- Use the function Lock Objects in menu Object to prevent objects from unintentional moving in 
multitrack VIPs!

Please refer to the Keyboard Shortcuts at the end of the manual for a quick and easy way of working 
with the most important functions in Samplitude.



Keyboard Shortcuts and Mousebuttons

General

a Range all
a+ctrl Redo
b Split range into 3 views
b + Shift Display gets 1 view
c or c+CtrlCopy range
c + Shift Copy As
c + Alt Copy and Clear (VIP)
e New VIP
f Fade In/Out
g Synchronization
h Close all Windows
i Project Information
i + Ctrl Import Sample
l Load RAM-project
l +Shift Load HD-project
m Open Mixer
n Normalize (virtual)
n + Shift Normalize (destructive)
o Load virtual project
p Play parameter
r Record Dialog
r + Ctrl Raster on/off
r + Shift Raster definition
q switch Raster off
s Save project
s+Shift Save project with new name
s + Shift + Ctrl Save in old format (V2.50)
t Split objects
t + Ctrl Trim objects
v or v+Ctrl Insert Clipboard 
v + Alt Overwrite with Clip (VIP)
w Load wave
x or x+CtrlCut range
y System preferences
Ctrl + z Undo

Tab Toggle object drawmode
Tab+Shft Define object drawmode
Space Playback on/off
Enter Arrange windows
Esc Abort playback, recording and physical sample manipulations
Del Delete range
Del+Ctrl Delete selected objects
Backspace Restart Playback
Insert Overwrite with Clip
+ Ctrl Copy into Clip
+ Shift Insert Clip
numeric 0 Scrubbing
numeric , 2 Views
# switch Grid on/off

Range

Cursor left or 4 on numeric block:
Scrolling left

+Ctrl Zoom In
+Alt Cursor to beginning of the range
+Shift+Ctrl Flip range left



Cursor right or 6 on numeric block:
Scrolling right

+Ctrl Zoom Outt
+Alt Cursor to end of range
+Shift+Ctrl Flip range right

Home Cursor to beginning of project
+Shift range to beginning of project
End Cursor to end of project
+Shift Range to end of project

PgUp Range start to next zero crossing
PgUp+Shift Range start to previous zero
 crossing
PgDn Range end to next zero crossing
PgDn+Shift Range end to previous zero 

crossing

Cursor up Scroll up
+ Ctrl Zoom in vertically in VIPs

Cursor down Scroll down
+ Ctrl Zoom out vertically in VIPs

/ * - + keys on numeric block: Move range
borders dependend on zoom level

Function keys

1-10 Get range 1-10
1-10+ShiftStore range 1-10
+ Shift + Ctrl Get range length
F11 Store range with new name

Keypad 0-9 (not numeric block!):
Get Cursor 1...10

+Shift Store Cursor 1 bis 10
+ Alt Store Cursor while playback
? Store Cursor with new name

Mouse

Left Mouse Button:
Mark range

+Shift Move range

Left Double-Click in range:
 Section to range borders

Left Double-Click outside range:
 Zoom out

Right Mouse Button:
Abort recording

Select, Move and Manipulate objects in VIP:
+ Shift Multiple selection
+ Ctrl Duplicate object
+Ctrl+Shift Multiple duplication of objects
+ k Move all objects behind cursor position in VIP

Right + Left mouse button: Opens object editor in VIP



Microsoft Intellimouse:
middle mouse click: Playback Start/Stop
Wheel: Scroll horizontally
+ Ctrl Zoom In/Out honizontally
+ Shift Zoom In/Out vertically
+ Ctrl + Shift Scroll vertically in VIPs






